# Table of Contents

1. **Introduction** .................................................................................................................. 1
   1.1  Executive Summary ...................................................................................................... 1
   1.2  Why Use CPM Scheduling? ...................................................................................... 1
      1.2.1  Internal to NYSDOT .......................................................................................... 1
      1.2.2  External to NYSDOT ...................................................................................... 1
      1.2.3  Specification Overview .................................................................................... 1
   1.3  Project Management Office (PMO) Role ............................................................... 1
      1.3.1  PMO Mission, Vision & Goals .......................................................................... 1
      1.3.2  PMO Organization Chart ................................................................................. 1
   1.4  Contacts & External Parties ................................................................................... 1
      1.4.1  PMO Contacts .................................................................................................. 1
      1.4.2  Communities of Practice Leads ....................................................................... 1
      1.4.3  Office of Information Technology Services (ITS) .......................................... 1
      1.4.4  Industry .......................................................................................................... 1

2. **Definitions of Terms** .................................................................................................... 2

3. **CPM Scheduling Software & Enterprise Configuration** ........................................... 7
   3.1  Administrator’s Manual ............................................................................................. 7
      3.1.1  Granting Access ................................................................................................. 7
      3.1.2  Adding and Modifying Users .......................................................................... 7
      3.1.3  Setting Up a New Construction Contract .......................................................... 10
      3.1.4  Loading Schedules ............................................................................................ 12
      3.1.5  Maintaining and Assigning a Baseline Schedule .............................................. 26
      3.1.6  Creating Global Reports ................................................................................... 28
      3.1.7  Creating New Project Codes ........................................................................... 31
      3.1.8  Adding and Editing User Defined Fields ........................................................... 32
   3.2  User Information ........................................................................................................... 33
      3.2.1  Primavera P6 Client Software .......................................................................... 33
      3.2.2  Requesting Access to NYSDOT Software and Data ......................................... 33
      3.2.3  Accessing Primavera P6 from Locations External to the NYSDOT Network .... 34
      3.2.4  Accessing Primavera P6 from Locations on the NYSDOT Network .................. 42
      3.2.5  Enterprise Project Structure (EPS) ................................................................... 45
      3.2.6  Organizational Breakdown Structure (OBS) ...................................................... 46
      3.2.7  Work Breakdown Structure (WBS) .................................................................. 46
      3.2.8  Enterprise Resource Directory ........................................................................ 47
      3.2.9  Project & Activity Codes & User Defined Fields .............................................. 48
      3.2.10 Project Filters .................................................................................................. 49
      3.2.11 Project Layouts ................................................................................................. 50
      3.2.12 Global & Project Calendars ............................................................................ 50
      3.2.13 User Preferences ............................................................................................. 50
      3.2.14 Toolbars ........................................................................................................... 52

4. **External Scheduling (Contractor Owned)** .................................................................... 53
   4.1  Section 100 Compliance ............................................................................................ 53
   4.2  Requirements for Contractor’s Progress Schedules ................................................. 53
      4.2.1  CPM Scheduling Software .............................................................................. 55
      4.2.2  Project Scheduler ............................................................................................. 56
      4.2.3  Construction Schedule Meetings ..................................................................... 56
      4.2.4  Progress Schedules ......................................................................................... 57
      4.2.5  Schedule Submission Methodology .................................................................. 68
      4.2.6  Resource Loading ............................................................................................. 69
      4.2.7  Progress Schedule Review and Analysis ............................................................ 70
      4.2.8  Changes to Progress Schedules Due To Added/Deleted/Changed Work ............ 71
Table of Contents

4.2.9 Failure to Submit Progress Schedules................................................................. 72
4.2.10 Submission of Progress Schedules with Projected Early Completion Date(s)........ 73
4.2.11 Float ................................................................................................................. 73
4.2.12 Progress Schedule Updates and Weekly Status Reports................................. 73
4.2.13 How to Represent Time Related Contract Provisions in the Schedule............... 73
4.2.14 Setting up the Project Template....................................................................... 73
5. Review and Acceptance of Contractor’s CPM Progress Schedule Submissions ...... 74
   5.1 Schedule Submission and Review Process......................................................... 74
      5.1.1 Schedule Work Flow.................................................................................... 74
      5.1.2 Schedule Review Responsibilities............................................................... 77
      5.1.3 Schedule Submission Due Dates................................................................. 78
      5.1.4 Schedule Submission Protocol.................................................................... 79
   5.2 High Level Review (HLR)................................................................................ 79
      5.2.1 High Level Review Overview....................................................................... 79
      5.2.2 Automated High Level Progress Review Report......................................... 80
      5.2.3 Schedule Report.......................................................................................... 80
      5.2.4 Immediate Rejection Criteria ..................................................................... 81
   5.3 EIC Review....................................................................................................... 81
      5.3.1 EIC Review Overview.................................................................................. 81
      5.3.2 EIC Review Report / Template................................................................... 81
   5.4 Detailed Review (Optional).............................................................................. 83
      5.4.1 Detailed Review Overview.......................................................................... 83
      5.4.2 Detailed Review Responsibilities............................................................... 84
      5.4.3 Detailed Review Report / Templates.......................................................... 87
6. Guidance for Using Tools and Features within the P6 Software Application .......... 90
   6.1 Project Layouts to View Available Projects in the Database......................... 90
      6.1.1 Opening A Project Layout.......................................................................... 90
      6.1.2 Use of Layouts to View Available Projects................................................. 91
   6.2 Project Filters................................................................................................... 96
      6.2.1 Creating a Project Filter............................................................................. 96
   6.3 Activity Layouts to View the Schedule............................................................ 99
      6.3.1 Opening an Activity Layout....................................................................... 99
      6.3.2 Saving a Layout......................................................................................... 101
   6.4 Activity Filters.................................................................................................. 103
      6.4.1 Creating Filters in the P6 Client................................................................. 104
      6.4.2 Utilizing Filters in the P6 Client................................................................. 107
   6.5 Making Global Changes.................................................................................. 108
   6.6 Scheduling a Project....................................................................................... 114
      6.6.1 Calculating a Schedule in the P6 Client..................................................... 114
   6.7 Claim Digger.................................................................................................... 117
      6.7.1 Running Claim Digger............................................................................... 117
   6.8 Assigning & Maintaining Baselines................................................................. 120
      6.8.1 Maintaining a Baseline Schedule............................................................... 120
      6.8.2 Assigning a Baseline to a Schedule........................................................... 125
   6.9 Project Calendars............................................................................................. 126
      6.9.1 Creating and Modifying Project Calendars................................................. 126
      6.9.2 State Observed Holidays.......................................................................... 129
      6.9.3 Seasonal Weather...................................................................................... 129
      6.9.4 Permit Restrictions..................................................................................... 130
   6.10 Saving a Copy of Your Progress Schedule to Your Local Computer.......... 130
      6.10.1 Saving & Printing PDFs on the Citrix System............................................ 130
      6.10.2 Exporting Schedule Files.......................................................................... 131
Table of Contents

6.11 Printing Schedules & Schedule Reports ................................................................. 134
  6.11.1 Printing Schedules & Adjusting Page Setup .................................................. 134
  6.11.2 Printing Schedule Reports ............................................................................. 137

6.12 Plotting Progress Schedules & Network Activity Diagrams .............................. 138
  6.12.1 Plotting Progress Schedules .......................................................................... 139
  6.12.2 Plotting Activity Network Diagrams .............................................................. 140

7. Contract Changes, Time Extensions & Delays ......................................................... 145
  7.1 Delays and Evaluation of Delays ......................................................................... 145
  7.2 Time Impact Analysis ......................................................................................... 145
  7.3 Change Order Review Process .......................................................................... 145

8. Evaluation of Time-Related Delay Disputes ......................................................... 146

9. Internal Scheduling (Non-Contractor Owned) ....................................................... 147
  9.1 Creating the Project Schedule .......................................................................... 147
    9.1.1 Responsibilities of the Project Manager ....................................................... 147
    9.1.2 Project Delivery Method Codes ................................................................. 147

  9.2 Views .................................................................................................................. 147
    9.2.1 Creating and Customizing Views ................................................................. 147

  9.3 Automated Feeds for P6 PPM & P6 CPM to Eliminate Manual Duplicate Data Entry ........................................................................................................ 147

  9.4 Baselines ............................................................................................................ 147
    9.4.1 Creating a Primary Baseline in P6 ............................................................... 147
    9.4.2 Creating an Initial Project Baseline in P6 .................................................... 147
    9.4.3 Saving Historical Project Baselines ............................................................ 147

  9.5 Dashboards, Portfolios, Portfolio Views ............................................................. 147
    9.5.1 Displaying and Customizing Dashboards in P6 .......................................... 147
    9.5.2 Creating and Customizing Portfolio Views ................................................. 147
    9.5.3 Creating Portfolios and Applying Portfolios to Dashboards ..................... 147

  9.6 Reports ............................................................................................................... 147
    9.6.1 Running Reports in P6 ................................................................................ 147
    9.6.2 Printing a Large Scale Gantt Chart ............................................................ 147
    9.6.3 P6 -BI Publisher Reports- Phase 2 Released (Release 1) .......................... 147
    9.6.4 P6 BI Publisher Reports - Phase 2 Released (Release 2) ............................ 147
    9.6.5 P6 Reports Data Dictionary ....................................................................... 147

9.7 Primavera P6 - Master Activity Library ............................................................... 147

9.8 Designer's and Area Construction Supervisors' Preliminary Schedule for Construction ........................................................................................................ 147
  9.8.1 Guidance for Selecting the Appropriate Project Type Based Upon Project Scope & Complexity .................................................................................. 147
  9.8.2 General Information ..................................................................................... 147
  9.8.3 Setting Up the Project Shell .......................................................................... 147
  9.8.4 Developing the WBS .................................................................................... 147
  9.8.5 Developing Project Calendars ..................................................................... 147
  9.8.6 Entering Activities ....................................................................................... 147
  9.8.7 Important Project Specific Factors ............................................................... 147
  9.8.8 Establishing and Amending Contract Completion Date & Other Milestone Dates ........................................................................................................ 148
  9.8.9 Project Specific CPM Special Notes ............................................................. 148
  9.8.10 Designers Schedule Narrative .................................................................... 148
  9.8.11 Estimating Pay Item Cost for CPM Scheduling ........................................ 148

9.9 Transition of PM Responsibilities ......................................................................... 148

10. Progress Schedule Templates .............................................................................. 149
  10.1 Design Progress Schedule Templates ................................................................ 149
  10.2 Construction Progress Schedule Templates .................................................... 149
  10.3 Contractor Procedures for Using CPM Progress Schedule Templates ............ 149

11. Using Primavera P6 WebPM application .............................................................. 150
Table of Contents

11.1 Project Portfolios ................................................................. 150
11.2 Summarizing the Project ........................................................ 150
12. The Progress Schedule as a Project Management Tool While Building the Project 151
Appendix A - CPM Schedule Quick Reference Guide ........................................ 152
Appendix B - EIC Review of Schedule Update Template ..................................... 158
Appendix C – Detailed Review Templates ......................................................... 161
   1 Group A Baseline ................................................................. 161
   2 Group A Update ................................................................. 165
   3 Group B Baseline ................................................................. 175
   4 Group C Baseline ................................................................. 190
   5 Group C Update ................................................................. 194
Appendix D - Example Narrative and Attachments ............................................ 205
Appendix E - Sample Schedule Plots ............................................................. 206
Appendix F - Frequently Asked Questions & Answers ....................................... 207
Appendix G – Construction Support Unit Contacts ........................................... 208
Appendix H – Schedule Load “Cheat Sheet” ...................................................... 210
Appendix I - Production Rate Guidance to Assist Designers .......................... 212
   1 Table A – Roadway Items (English) ........................................ 212
   2 Table A.1 – Roadway Items (Metric) ........................................ 212
   3 Table B – Bridge Items (English) ............................................ 212
   4 Table B.1 – Bridge Items (Metric) ............................................ 212
   5 Table C – Bridge Items One Span (English) ............................ 212
   6 Table C.1 – Bridge Items One Span (Metric) ............................ 212
   7 Table D – Bridge Items Two Span (English) ............................. 212
   8 Table D.1 – Bridge Items Two Span (Metric) ............................. 212
## REVISION CHART

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Description</th>
<th>Primary Contributor(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.0</td>
<td>Initial document distributed</td>
<td></td>
</tr>
</tbody>
</table>


1. INTRODUCTION

1.1 Executive Summary
1.2 Why Use CPM Scheduling?
  1.2.1 Internal to NYSDOT
    1.2.1.1 Benefits in Practice (Case Studies)
    1.2.1.2 Managing Progress and Inspection Staff
    1.2.1.3 Manage Disputes and Claims
    1.2.1.4 Benefits to Contractors
  1.2.2 External to NYSDOT
  1.2.3 Specification Overview
  1.3 Project Management Office (PMO) Role
    1.3.1 PMO Mission, Vision & Goals
    1.3.2 PMO Organization Chart
  1.4 Contacts & External Parties
    1.4.1 PMO Contacts
    1.4.2 Communities of Practice Leads
    1.4.3 Office of Information Technology Services (ITS)
    1.4.4 Industry
2. DEFINITIONS OF TERMS

**Activity** - A discrete, identifiable task or event that usually has an expected duration, has a definable Start Date and/or Finish Date, and can be used to plan, schedule, and monitor a project.

**Activity, Controlling** - The first incomplete activity on the critical path.

**Activity, Critical** - An activity on the critical path.

**Actual Start date** - At the activity level, the Actual Start date represents the point in time that meaningful work actually started on an activity.

**Actual Finish date** - At the activity level, the Actual Finish date represents the point in time that work actually ended on an activity (Note: in some applications areas, the activity is considered “finished” when work is “substantially complete.”)

**Backward Pass** – Calculation of the late start and late finish dates for each activity, based on the start or finish dates of successor activities as well as the duration of the activity itself. Also known as the second pass.

**Baseline Progress Schedule @ Award** - The Progress Schedule submitted by the Contractor and accepted by the Department that shows the plan to complete the construction contract work. The Baseline Progress Schedule @ Award represents the Contractor’s plan at the time of Contract Award for completing the project.

**Bid Date** – The date the contract is let and there is an announcement by the Department of an apparent low bidder.

**Completion Date, Contract** - The date specified in Article 1 of the Contract for completion of the project or a revised date resulting from properly executed time extensions.

**Anticipated Completion Date** - The date forecasted by the Progress Schedule for the completion of the contract work.

**Constraint** - A schedule restriction imposed on the Start or Finish date(s) of an activity that modifies or overrides an activity’s relationships.

**Contemporaneous Period Analysis Method** – A technique for evaluating schedule delays or time savings. The analysis period for the purpose of these provisions shall be the period covered in each regular progress update to the schedule, as they coincide with contract payments to the Contractor.

**Contractor’s First Day of Work** - The day of the Contractor’s first day of physical work within the highway Right-of-Way.

**Contractor’s Last Day of Work** - The Contractor’s last day of physical work in the field, and the Contractor has demobilized (no longer has any presence within the highway right-of-way).

**Contractor Work Day** - A calendar day scheduled for active prosecution of the work.

**Critical Path** – In the Progress Schedule the critical activities shall be those activities being on the longest path. In a project network diagram, it is the series of activities which determines the earliest completion of the project.

**Critical Delay** - An event, action, or other factor that delays the critical path of the Progress Schedule and extends the time needed for completion of the construction project.

**Critical Path Method (CPM)** – A network analysis technique used to predict project duration by analyzing which sequence of activities (which path) has the least amount of scheduling flexibility (the least amount of float). A scheduling technique utilizing activities, durations, and...
interrelationships/dependencies (logic), such that all activities are interrelated with logic ties from the beginning of the project to the completion of the project. Early dates are calculated by means of a forward pass using a specified start date. Late dates are calculated by means of a backward pass starting from a specified completion date (usually the forward pass’s calculated project early finish date).

**Data Date** – The date entered in the Project Details, in the Dates tab, which is used as the starting point to calculate the schedule. Everything occurring earlier than the data date is "as-built" and everything on or after the data date is "planned."

**Deliverable** – Any measurable, tangible, verifiable outcome, result, or item that must be produced to complete a project or part of a project. Often used more narrowly in reference to an external deliverable, which is a deliverable that is subject to approval by the Department.

**Draft Baseline Progress Schedule** – An optional schedule submission that reflects an outline of the schedule format and content proposed by the Contractor’s Project Scheduler to comply with the schedule provisions in the contract to solicit early comments by the Engineer, prior to the submittal of complete Baseline Progress Schedule @ Award.

**Duration, Original** - The original estimated number of working days (not including holidays or other non-working periods) in which the work task associated with the activity is expected to be performed. (The number of calendar days may be different based on the calendar assigned to the activity.) For certain activities such as concrete curing, or others approved by the Engineer, the calendar shall reflect no non-working days.

**Duration, Remaining** - The estimated time, expressed in working days (not including holidays or other non-working periods), needed to complete an activity that has started but has not finished.

**Early Completion Schedule** – A progress schedule will be considered an early completion schedule when the schedule submitted by the Contractor indicates a completion date that is earlier than the specified contract completion date, or the Finish date of any interim Milestone work activity is earlier than the date specified in the contract. This includes, but is not limited to, B-Clock activities, activities subject to Incentive/Disincentive provisions and/or specific Liquidated Damages provisions, and Lane Rental activities.

**Enterprise Project Management Database (EPMD)** – The Department’s database of construction project Progress Schedules.

**Final Baseline Progress Schedule @ Award** - The original plan against which the Contractor’s progress is measured. The Final Baseline Progress Schedule @ Award represents the original plan at the award of the contract, of what is expected to happen. Once the Final Baseline Progress Schedule @ Award is accepted by the Engineer it is saved and used as a basis to compare against Progress Schedules Updates.

**Float Suppression** - Utilization of zero free float constraints which allows an activity to start as late as possible by using all of its available free float. This technique allows activities to appear more critical than if the activity’s total float was based on early dates. Assigning zero free float prevents true sharing of total float between Department and the Contractor. Utilization of overly generous activity durations and overly restrictive calendar non-working periods are also considered to cause float suppression.

**Float, Free** - The amount an activity can slip without delaying the immediate successor activities. Free Float is the property of an activity and not the network path.

**Float, Total** - The amount of time an activity (or chain of activities) can be delayed from its early start without delaying the contract completion date. Float is a mathematical calculation and can change as the project progresses and changes are made to the project plan. Total Float is calculated and reported for
each activity in a network, however, Total Float is an attribute of a network path and not associated with any one specific activity along that path.

**Fragnet** – A subdivision of a project network diagram usually representing some portion of the project.

**Global data** – Data classified by Oracle-Primavera software as Global, including Project Codes, Global Activity Codes, Global Calendars, Resource Calendars, Global Filters, Resources, Global Reports, User Defined Fields and Unit of Measure.

**Key Plans** - Key Plans are graphic representations made by the Contractor’s Project Scheduler on paper copies of the appropriate contract plan sheets that reflect the Contractor’s planned breakdown of the project for scheduling purposes to efficiently communicate the Contractor’s activity coding scheme to State scheduling staff. The key plans prepared by the Contractor shall clearly define the boundaries of the work for each designated Area, the operations contained in various Stages of work, and work in the Work Zone Traffic Control (WZTC) Phases. The alphanumeric codes on the key plans shall match the code values for the activity code "Area", “Stage”, and “WZTC Phase” in the Progress Schedule.

**Longest Path** - The sequence of activities through the Progress Schedule network that establishes the Scheduled Completion Date

**Look-Ahead Schedule** – A three week time segment generated from the accepted Progress Schedule that shows the actual work progressed during the previous one week and forecasts the work planned for next two week period following the Data Date, and includes any major materials to be delivered and any lane closings or anticipated shifts in WZTC.

**Milestone** – An activity with zero duration that typically represents a significant event, usually the beginning and end of the project, milestones set forth in the contract proposal, construction stages, a major work package, or the contract interim time-related clauses.

**Narrative Report** - A descriptive report submitted with each Progress Schedule. The required contents of this report are set forth in this specification.

**Open End** - The condition that exists when an activity has either no predecessor or no successor, or when an activity’s only predecessor relationship is a finish-to-finish relationship or only successor relationship is a start-to-start relationship.

**Predecessor** - An activity that is defined by Schedule logic to precede another activity. A predecessor may control the Start Date or Finish Date of its successor.

**Progress Schedule** – A general Oracle-Primavera P6 Schedule as defined by this Specification.

**Progress Schedule Update** – Changes to the Progress Schedule that reflect the status of activities that have commenced or have been completed, including the following items: (a) Actual Start date and or Actual Finish date as appropriate; (b) Remaining Duration for activities commenced and not complete; and (c) Suspend or Resume dates for activities commenced and not complete.

**Progress Schedule Revision** – Revisions to the Progress Schedule ensure it accurately reflects the current means and methods of how the project is anticipated to progress, including modifications made to any of the following items: (a) changes in logic connections between activities; (b) changes in constraints; (c) changes to activity descriptions; (d) activity additions or deletions; (e) changes in activity code assignments; (f) changes in activity Productivity Rates; and (g) changes in calendar assignments.

**Project Scheduler** – The person that is responsible for developing and maintaining the Progress Schedule.

**Recovery Schedule** – A schedule depicting the plan for recovery of significant time lost on the project. This separate CPM schedule submission shall provide the resolution and include appropriate changes in network logic, calendar adjustments, or resource assignments.
Relationships - The interdependence among activities. Relationships link an activity to its predecessors and successors. Relationships are defined as:

Finish to Start - The successor activity can start only when the current activity finishes.

Finish to Finish – The finish of the successor activity depends on the finish of the current activity.

Start to Start – The start of the successor activity depends on the start of the current activity.

Start to Finish – The successor activity cannot finish until the current activity starts.

Resources, Contract Pay Item – Contract Pay Item resources shall be identified as a Material resource type. When required, Contract Pay Item resources are developed for each Pay Item in the contract, with the Resource ID matching the contract Pay Item and the Resource Name matching the description of the contract Pay Item.

Resources, Equipment – Equipment resources shall be identified as a Nonlabor resource type. A unique identifier shall be used in the Resource Name or Resource Notes to distinguish this piece of equipment from a similar make and model of equipment used on the project.

Resources, Labor – Labor resources shall be identified as a Labor resource type. Labor Resources shall identify resources that encompass direct labor at the Crew level.

Scheduling/Leveling Report – The report generated by the software application when a user “Schedules” the project. It documents the settings used when scheduling the project, along with project statistics, errors/warnings, scheduling/leveling results, exceptions, etc.

Substantial Completion - the day, determined by the Engineer, when all of the following have occurred:

1. The public (including vehicles and pedestrians) has full and unrestricted use and benefit of the facilities both from the operational and safety standpoint, and
2. All safety features are installed and fully functional, including, but not limited to, illumination, signing, striping, barrier, guard rail, impact attenuators, delineators, and all other safety appurtenances, and
3. Only minor incidental work, replacement of temporary substitute facilities or correction or repair remains for the Physical Completion of the Contract, and
4. The Contractor and Engineer mutually agree that all work remaining will be performed with short term lane closures to minimize delays, disruption, or impediment to the traveling public. No overnight lanes closures will be allowed.

Successor - An activity that is defined by Schedule logic to succeed another activity. The Start Date or Finish Date of a successor may be controlled by its predecessor.

Time Impact Analysis - A technique to demonstrate the comparison of a time impact of a Progress Schedule revision prior to a change in the Contract work, against the current accepted Progress Schedule. It is also known as a “What-If” analysis.

Weekly Status Report – The report generated weekly from the updated Progress Schedule in an electronic Adobe Acrobat PDF format that reflects a Data Date for that Progress Schedule Update period. The report shall be formatted to fit ANSI Size D paper (610 mm x 914 mm) (24 inch x 36 inch), listing all work activities from the data date to contract completion, using the NYSDOT Status Report Layout, sorted by Early Start Date, Total Float in increasing order, showing the Activity ID, Activity Description, Original Duration, Remaining Duration, Total Float, Early Start date, Early Finish date, Start date, Finish date and Calendar ID.
**Work Breakdown Structure (WBS)** - A deliverable-oriented grouping of project elements, which organizes and defines the total scope of the project. Each descending level represents an increasingly detailed definition of project components or work packages.

**Work Package** - A deliverable at the lowest level of the work breakdown structure. A work package contains activities.

**Work Days** – A calendar day (Monday through Friday) on which State offices are open to the public for business. State recognized public holidays are not work days. Days scheduled for the active prosecution of work activities by State staff or the State’s representatives. (State Business Day calendar)

<table>
<thead>
<tr>
<th>New York State Holidays</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New Years Day</td>
<td>January 1</td>
</tr>
<tr>
<td>Martin Luther King Day</td>
<td>3rd Monday in January</td>
</tr>
<tr>
<td>President’s Day</td>
<td>3rd Monday in February</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>Last Monday in May</td>
</tr>
<tr>
<td>Independence Day</td>
<td>July 4th</td>
</tr>
<tr>
<td>Labor Day</td>
<td>1st Monday in September</td>
</tr>
<tr>
<td>Columbus Day</td>
<td>2nd Monday in October</td>
</tr>
<tr>
<td>Veteran’s Day</td>
<td>November 11th</td>
</tr>
<tr>
<td>Thanksgiving Day</td>
<td>4th Thursday in November</td>
</tr>
<tr>
<td>Christmas Day</td>
<td>December 25th</td>
</tr>
</tbody>
</table>

If the holiday occurs on a Saturday, it will be observed the Friday before. If the holiday occurs on a Sunday, it will be observed the Monday after.
3. CPM SCHEDULING SOFTWARE & ENTERPRISE CONFIGURATION

3.1 Administrator’s Manual

The P6 CPM Administrator’s Manual contains descriptions of tasks that are used by NYSDOT P6 Administrators in the normal course of their daily activities. The topics include the following subjects which require administrator privileges to perform:

3.1.1 Granting Access

- For new NYSDOT staff:
  - Email the form (Figure 61) or send the link to the new user.
  - The filled out form must be signed by the Area Construction Supervisor or the Regional Construction Engineer that is requesting that they be granted access.
  - The form shall be signed by the applicant user.

- For New Project Consultants & Contractors
  - Email the Request for Access Form (Figure 61) to the Area Construction Supervisor of the new project to be distributed to the appropriate staff needing access.
  - The filled out form must be signed in the presence of a Notary Public if the user does not already have an Active Directory (AD) account with NYSDOT.
  - The form must also be signed by an officer of the applicant’s employer.
  - The form must be signed by project’s Area Construction Supervisor.
  - All signatures may be electronic.

- Review & Approval
  - The signed forms shall be emailed to the P6 Administrator at CPM Scheduling Section@dot.ny.gov.
  - This person will review the form for accuracy and reject it for any significant errors back to the applicant.
  - If found to be satisfactory, the Administrator should recommend that the user account be created.
  - He or she will review the form for completeness and sign it electronically, if approved.
  - The form is then saved as a PDF document format to: “P:\PMO\Construction Support\1 SHARED FOLDERS\Access Requests\Processed to ISO\Allusers”.
  - Add the user's information to the MS Excel Spreadsheet “P:\PMO\Construction Support\1 SHARED FOLDERS\Access Requests\P6 User Tracking Log.xlsx”.

3.1.2 Adding and Modifying Users

3.1.2.1 For a New Active Directory (AD) Account for a non-State Employees

- The P6 Administrator should open a ticket with ITS at the URL: https://nysitsm2.service-gov.com/itsm2/
- Select Request Something > User Accounts and Access > User Account Access
- In the Field Short Description enter: Request for new AD Account for External User (First & Last Name).
- In the Description Field enter:

  The Project Management Office requests that a ticket be opened in Service Now and assigned to Account Management to create a new Active Directory (AD) account for First Name Last Name as an external user to NYSDOT systems.

  In Service Now please assign the customer and requester as Name of Admin so I can track the ticket number and receive notification of closure of the ticket.

  When the ticket is closed I then need to assign Primavera licenses to the AD account, along with access to the appropriate projects in Primavera P6.

  The PMO will notify the user of their new UserID and password.

  The AD account needs to be added to the OISCitrixPrimavera-External group, and the OISCitrixExternalOnly group.
This should allow the new AD account user to access the Citrix servers, and have access to icons for the following icons:
- Primavera P6 application
- Network T:\ drive application.

We have attached the completed Request For Access form with approval signatures.
This new user account is for a non DOT person (external user).

Please notify me when this ticket has been completed at CPMSchedulingSection@dot.ny.gov, so the other steps to assign Primavera licenses to this user can be completed by the Project Management Office.

- Select the current appropriate approver for the Engineering Division
- Check off AD Account and Security Group from the Appropriate NYS Entitlements:

![Select appropriate NYS Entitlements](image)

Figure 1: Appropriate NYS Entitlements

- For Employee Type select State Contractor
- The signed request for Access should be attached via the “paperclip” (Figure 2) at the top of the webpage.
- Click on Order Now to submit the request:

![Paperclip and Order Now Button](image)

Figure 2: Paperclip and Order Now Button

- The ticket will be confirmed in an email. The ticket number, in the format RITMxxxxxxxx should be entered on the MS Excel spreadsheet, with the date the request was made.
- When an email is received from ITS confirming that the account has been established, add the user to P6 by taking the following steps
  - Click on Administer> User Access> Users. Click on the “+” sign.
Enter the New User’s UserID in the dialog box and click on Search.

When the UserID is found click on Import.

Select the appropriate Global Security Profile e.g., “Project Scheduler Contractor” and check P6 Professional under the Module Access Tab then click Save and continue to the next steps below.

### 3.1.2.2 For An Existing P6 User

- Ensure that the current Global Security Profile is appropriate and that the P6 Professional Module is checked.
- Set the Project Access in P6 with the Responsible Manager and Project Security Profile as approved in the Request for Access and click Save all changes are made.
3.1.3 Setting Up a New Construction Contract

3.1.3.1 Creating the OBS

- Open Internet Explorer and navigate to the following URL:
- Administrator logs into Primavera P6 Web Application and types in Username and Password
- Go to the Administer pulldown and select User Access.
- Click on the OBS function on the left.
Find the existing Template project node: “D269997 – Unassigned OBS Node”. Select the "Search" Icon. Enter D269997 in the search box and click on "Find"

Highlight the Template "D269977 - Unassigned OBS Node" then right mouse click Copy. Navigate to the proper Region/ACS node, right mouse click Paste. Finally, click Save.

Go to the Status Book Database and log in using your AD UserId and password. Click on “Capital Construction”, then click on the Project/Contract Details tab. Enter the contract D Number or PIN and click on Go.

Open Copied "D269997 - Unassigned OBS Node". Change the D Number and Project Name in Parent Node, then change the D Number for all the child nodes:
- D####-Project Name
- D####-Designers Work Area {if applicable, otherwise Delete}
- D#####-Contractors Project Scheduler
- D#####-NYSDOT Archive (Read-Only)
- D#####-NYSDOT Reviewers, What-If (Read-Write)

Click SAVE

An example of a project set up in the OBS can be seen in Figure 12.
Advisory: It is very important to SAVE when in the P6 Web Application. Failure to do so can result in changes being lost. If the SAVE Icon shows up …SAVE.

3.1.4 Loading Schedules
The process of Schedule Loading is summarized for administrators in a step-by-step guide which can be found in Appendix H – Schedule Load “Cheat Sheet”
This guide should be printed out and used when loading files until the administrator becomes very familiar with the process. The following sections detail this process.

3.1.4.1 CPM Scheduling Section Email Management
Consultants, contractors are directed to email the CPM Scheduling Section when schedule submissions are made to NYSDOT. Based upon current work assignments and workload, emails are assigned an Outlook category which relates the email to the assigned Section staff. In addition, a follow-up flag priority is assigned.

3.1.4.2 Moving the Email Attachments from Outlook to P: Drive
• Open the folder: \\PMO\Construction Support\Project Schedules. It is highly suggested that you set up a shortcut on your desktop to this folder.
• Drill down in the specified region’s folder then continue to drill down into the D Number Contract folder.
• Create a new folder named xSUyy, e.g. P:\PMO\Construction Support\CPM Scheduling\Project Schedules\Region 9\D260985\1SU51

Copy all attachments from the email and place them in this new folder. Remove the attachments from the email is necessary because the files sent by the schedulers are often large. Once they are saved the P: drive it is a waste of email storage space to leave them attached to the email.
• Reply All to the email received. Copy the email template information that is used for either a Type 1 or Type 2 schedule into the email. Ensure that the email is being sent from the CPM Scheduling Section and that the CPM Scheduling Section is copied. This will serve as the draft response to which you will add your comments as problems are found with the schedule. Click Save to ensure that a draft is saved. Move around the recipients to ensure that the EIC and the Detailed Reviewer are in the TO: line while the remainder of the individuals are in the Cc: line.

3.1.4.3 Loading the Schedule to the State Work Area
• Open P6 Professional client. Ensure that the “P6_Construction_Prod_Primary” database is selected from the pulldown menu. (See Figure 16)
Login Click on the Open Global Data button.

Click on Enterprise>Projects or click on the Projects Icon.

Drill down to the correct project node or click on Edit>Find and enter the contractID Number.

Expand the project node. Drill down to the project CPS (Current Project Schedule) node.
• Change the report indicator to NULL. Remove the Green Circle check to blank option by left mouse clicking on the Green Circle

[Figure 20: Change the Report Indicator]

• Right click the schedule and select Cut. The schedule in the CPS node is the current progress schedule. There should only be one schedule located here.

[Figure 21: Select the Schedule in CPS]

• Click on the PSU node beneath and select Paste. The PSU node is where previous schedule updates are stored until the project is closed out. This allows them to be accessed during the rest of the project.

[Figure 22: Paste the Schedule in the PSU Node]

• Expand the CWA (Contractor’s Work Area) node. This is where they create the schedules to be loaded into the NYSDOT work area. Find the latest ProjectID, e.g. D261910–1SU7 as noted in the email.
• Highlight the Schedule as noted in the email, right mouse click and open it. Scroll over to the right and click on the Loaded Date and change it to today’s date and the nearest hour.

• In the field "Project Name", check the end of the name to verify that “Monthly Progress Schedule Update #” is present.

• Scroll left and right, scanning the date fields. All of the fields should be filled appropriately. Using the Status Book database compare Dates and Names:
  - EIC
  - Area Construction Supervisor
  - Schedule Reviewer
  - Contractor
  - Contractor’s Project Scheduler
  - Letting Date
  - Award Date
  - Original Contact Completion Date
  - The Must Finish By Date

• The time indicated in the "Must Finish By Date" shall be set to 5pm that day.

• In the Project Details area, Click on the Settings tab.

• Check the following fields:
- Fiscal Year; make sure that it is set to April.
- Summarize WBS; it should be set to 4.
- Define Critical Activities; ensure that it is set to Longest Path.

- Right click the ProjectID and select Summarize Project.
- Check that you are on the same schedule from the CWA area

- Click the Copy icon in the right panel
- Expand CPS Node. Right mouse click in the node area to highlight the CPS node, select Paste to insert the new schedule here.
- On the Schedule just copied into the CPS area, right click & select Open Project. It may default to Activities when opened; if so, select the Project tab.
- Change the Review Status field to “Submitted for Review“ as shown in Figure 26.

![Figure 26: Update the Review Status Field](image)

- Change the field "Project Status" to Inactive; change the Schedule Owner to State Archive; change the Report Indicator to the Green Circle. For submissions prior to the approval of a Final Baseline, the Yellow Triangle is used.

![Figure 27: Update the Report Indicator](image)

- In the Lower Pane (Project Details), Click on the <General>Tab. Look for the Field named Responsible Manager. Click […] the ellipsis button.

![Figure 28: Click on the Ellipsis Button](image)

- This will open a window and defaults to ENTERPRISE (top of all nodes).
Enter the project D# in the search box. DO NOT HIT ENTER. Select “NYSDOT Archive (Read ONLY)” for the D number which was entered. In the right panel: Click Select.

Make a copy of the previous update from the PSU node to the CPS node; change the Project Name to “Dxxxxxx_ySUzz_ - LAST UPDATE BASELINE”.

Maintain and Assign the Last Update Baseline into Current Submission as Project Baseline. This procedure is described in Sections 3.1.5.1 and 3.1.5.2.

Select the Activities Tab; go to Layout; click [Open]; Answer [No]; Under Global Layouts select 00_Schedule Load.

Go to Filters and verify that "All Activities" are checked in the upper left corner Click [OK]

Click on the [Group and Sort By] button in the command bar. Uncheck the box for Indent field under the GroupBy section of the popup window. Remove all items in the
Group By table of the popup window. Only "Show Group Totals" should be checked. Click the [Apply] button. Click the [Ok] button. The popup window will now close.

- Click on the [Schedule] icon.
- Check that the Log to File field is set to save to a consistent location on one of your drives that you have access to.

![Figure 31: Group & Sort Settings](image)

- Click on the [Options] Button
- Open the Schedule Log text file as sent by the scheduler. Check to see that the options in the text file and those presented in the {Schedule Options} Dialog box are the same.
- Note the settings in Figure 33. They should be used as a guide for reviewing the settings in the Schedule Options.
Make sure the option is set for the Longest Path. Note in the email if any of these are inconsistent.

Click the [Close] button. Click the [Schedule] button. The Schedule Log text file should be generated in the in a common location for you such as a temporary directory or a working folder. The default name should be _NYSDOT_SCHEDLOG.txt. Copy the Schedule Log text file into the current update project folder in the proper Region/DNumber/xSUyy. Rename the file DNumber-xSUyy_NYSDOT_SCHEDLOG.txt. Compare the Contractor’s schedule log with this log and report any differences. Open the Schedule Log and check for Out Of Sequence Activities and make note in the email previously created.

Click on the [Filter] button. Click on "Customize" Click on the option called "All Activities". Set the radio button to “All Selected Filters”. Click on the [Apply] button.

Check on the option for “Longest Path”; click the [Apply] button; click the [Ok] button.
• Start with the last activity and follow the path up the activities making sure that all activities are connected with a “Logic Line”, through the Data Date (Blue Line). (Figure 36)

• In order to check project calendars, click on the Enterprise pull down Tab, select Calendar, then Select the radio button for Project. Project Calendars should all have the D Number in front of them. Project Calendars should not contain the words Concrete Curing, Milestone, and 365 Days. Report any inappropriate calendar names in the email. When performing a review of a baseline submission, carefully check each calendar for workdays on State holidays, reasonable periods for paving and landscaping, that time periods are correct, non workdays are appropriate, etc. [Close] the Calendar Dialog Box.
Click on the [Filter] icon. Click on "Customize". Set checkbox to “All Activities” (clears existing filters) Set the radio button for “Any selected Filter”

Apply each of the 20 or more global filters some of which are shown in Figure 38

The Schedule Report

The Schedule Report is a regular attachment to each High Level Review performed by the NYSDOT CPM Scheduling Section. Included in this Schedule Report are a variety of schedule layouts to assist the EIC’s review of the Contractor’s schedule submission. Each layout is uniquely filtered and organized to present important information and to aid schedule analysis. The Schedule Report is a single .pdf file that combines multiple schedule layouts specifically run for each P6 progress schedule update. On the left hand side of the report underneath “Bookmarks”, the names of the various layouts can be found. Clicking on each Bookmark link brings the viewer to the first page of each layout.
Each of the layouts is a different report that filters and organizes the Contractor's schedule submission in various ways. On the top of the first page of each layout, there is a header with the layout name, “Layout Description” and “What To Look For” that will help the EIC review each layout.

3.1.4.5 Creating the Schedule Report

- Copy an already created set of PDF Schedule Layout Files from an associate in the Section to a permanent location accessible by you on the P:\ drive. This will save you from having to type out the file name when saving each generated PDF file and allow for naming consistency.
• Change the User Preferences to not show time. {Edit>User Preferences>Dates>Do not show time}. This will avoid unnecessary clutter in the layout generated printouts.

![Figure 42: Turning off the Time Display](image)

• Ensure that the schedule under review is still open and that you are in the Activities, not the Projects view. Go to View/Layout>Open Layout. Answer “No” to the dialog box asking if you wish to save this layout. A list of Global Layout will appear. We will be using the Layouts from 01 to 19 for normal monthly updates as shown in Table 1.
• Starting with Layout “01_Milestones Constraint & LevelOfEffort” click Open.

![Image](image.png)

**Figure 43: Select a Layout and Open**

- Choose File>Print. Select Adobe PDF as the output printer. Save the file in the Directory where you copied all the Schedule Layout PDFs. Click on the “01_Milestones Constraint & LevelOfEffort” file and overwrite the file. Repeat this procedure for each of the layouts listed in Table 1.
- Open Adobe Acrobat Standard or Professional but not Reader. Create a file combining all of the files just created and introduced by the 00_Schedule Report Intro.pdf file in that directory. Save that file in
the project update folder where the Schedule Log was also saved. While still in Adobe Acrobat click on File>Properties>Initial View. Select the Options shown in Figure 44, save the file and close it.

![Figure 44: Initial View Options for the Schedule Report](image)

- Reopen the file and check that each bookmark has the correct layout number and the correct project.
- Drag and drop the Schedule Report into the review email previously created.

3.1.4.6 Finalizing the Schedule Review

- Review each of the Layouts individually and where appropriate make comments and include snapshots in the review email of items worthy of the attention of the EIC.
- Send the email. Remove the attachments from the copy of the email in the CPM Scheduling Section Inbox.
- Drag and drop a copy of the email to the project update folder.
- Clear the Outlook email Category from the original incoming email and clear the Follow Up flag.

3.1.5 Maintaining and Assigning a Baseline Schedule

3.1.5.1 Maintaining a Baseline Schedule

- Make a copy of the schedule you wish to use as a baseline to the same node where the project under review resides. Rename the baseline to Dxxxxxx-ySUzz Previous Month Baseline.

![Figure 45: Renaming a Copy of the Previous Month's Schedule](image)

- Open the latest update to which you want to maintain and assign a baseline to, e.g., D261344-1SU8-2. Switch back to the Projects view. Ensure that the baseline schedule is highlighted.
• Go to <PROJECT> pull down tab. Select “Maintain Baselines”. Click on Add.

• Select “Convert another project to a new baseline of the current project”. Click OK

• Ensure that the baseline is highlighted. Click the green plus icon to maintain the baseline.

• Highlight the baseline and choose the proper Baseline Type with the pull down list: It is normally “Monthly Progress Schedule Submission”. (Figure 49)
3.1.5.2 Assigning a Baseline Schedule

- Go to the <PROJECT> pull down tab. Select “Assign Baselines”.

- Click on the down arrow in the Project Baseline Box, your baseline schedule should appear. Repeat this step for the Primary User Baseline Box.

- Click OK.

3.1.6 Creating Global Reports

- Open the desired project schedule.

- Click on the Reports icon on the left of the screen.

- Click on the Plus icon on the right of the screen to add a Report.

- The New Report radio button should be active.
• Click the Next button.
• Highlight your Subject area.

Figure 52: Select Subject Area

• Click the Next button.
• Select Additional Subject Areas as desired by clicking on the right arrow.
• Click the Next button.
• Configure your Report by selecting the appropriate Columns, Grouping & Sorting, and Filters.

Figure 53: Select Additional Subject Areas

• Click the Next button
• Add the Report Title

Figure 54: Configuring the Report
• Run Report Button; Click Next Button.
• If the desired results are achieved, Save & Finish Report.
• If not, return to the Report Wizard (Figure 51), select Modify Wizard Report and make the necessary changes. Continue this process until the desired result is achieved.

3.1.7 Creating New Project Codes

• Log into the CPM Web version of Oracle Primavera.
• From the Administer pull down menu, select Enterprise Data.

• Click on Project Codes.

---

1 P6Creating New Project Codes can only be performed by an Administrator with Superuser or Global Data Administrator privileges.
3.1.8 Adding and Editing User Defined Fields

- Log into the CPM Web version of Oracle Primavera P6.
- From the Administer pull down menu, select Enterprise Data. (Figure 56)
- Click on Project UDF

---

2. Adding and Editing User Defined Fields can only be performed by an Administrator with Superuser Administrator privileges.
3.2 User Information

3.2.1 Primavera P6 Client Software

Primavera P6 is available in both client (Primavera P6 Professional) and web (Primavera P6 EPPM) versions. For external users of the system we will primarily focus on the client version. NYSDOT staff can access the client version in two ways: 1. from the program loaded on their desktop or laptop or 2. via the NYSDOT Virtual Desktop Infrastructure (VDI). External users such as contractors and consultants can only access the client version via VDI.

3.2.2 Requesting Access to NYSDOT Software and Data

The Request for Access form (Figure 61) is located on the NYSDOT Primavera applications webpage (https://www.dot.ny.gov/main/business-center/contractors/construction-division/primavera). The applicant should complete the registration form relevant to the system to be accessed. If the non-DOT employee does not have an existing NYSDOT user (account) ID assigned, the form must be...
signed and dated in the presence of a notary. This is the only instance requiring notarization. In the case of Contractor’s staff, the form must also be signed by the Prime Contractor’s Project Manager and forwarded to the NYSDOT Area Construction Supervisor for signature. For CI Consultant staff, or project Field Office staff, the form should be forwarded to the Area Construction Supervisor for signature. This form can be filled and saved using Adobe Acrobat Reader. Prime Contractor’s Project Managers and NYSDOT Construction Supervisors are responsible for notifying the Project Management Office by email (MO-PPMSoftware@dot.ny.gov) if an employee is no longer assigned to their project so the Department can remove that user’s access to the software application and project data. The Area Construction Supervisor should review it for correctness and appropriateness, sign it scan it to a PDF file and email it to MO-PPMSoftware@dot.ny.gov.

3.2.3 Accessing Primavera P6 from Locations External to the NYSDOT Network
Once an external user has been assigned an Active Directory (AD) account, there is another step for security that is required for external users. Previously users accessed NYSDOT systems using Citrix.

3.2.3.1 Obtaining an RSA Token
As part of an ongoing infrastructure modernization initiative, the CITRIX remote access to DOT applications has been replaced with a VDI\(^3\) (VMWare) client. Accessing the VDI Client from outside the NYSDOT network requires multi-factor authentication, commonly known as an ‘RSA token’. External users need to obtain RSA tokens to ensure uninterrupted access. Please follow these steps to request a token.

- Login with the user ID and password. User ID will be the AD Account User ID\(^4\) followed by @nysdot.private. The password will be the AD account password.
- The system will guide the user through the token request.

We recommend that users request a software token if the user has a smart phone available since the turnaround time is shorter to receive the token. Please contact the ITS Service Desk at (844) 891-1786 for assistance in adding or managing user access.

3.2.3.2 **Accessing or Installing the VDI Horizon Application on a Non-NYSDOT Computer.**
These instructions are based on Windows 7.
- Open MS Internet Explorer
- Go to [https://desktop.ny.gov/](https://desktop.ny.gov/)
- Click on the link to “See the Full List of VMware Horizon Clients” shown in Figure 63

---

\(^3\) Virtual desktop infrastructure (VDI) is virtualization technology that hosts a desktop operating system on a centralized server in a data center. VDI is a variation on the client-server computing model, sometimes referred to as server-based computing. The term was coined by VMware. (techtarget.com)

\(^4\) Usually the first initial of the first name followed by the last name, e.g., Jane Doe would be jdoe. There are exceptions when this combination is not unique.
Select the appropriate Client for the operating system on your computer, either VMware Horizon Client for Windows or VMware Horizon Client for Windows 10 UWP for x86-based devices.

<table>
<thead>
<tr>
<th>Product</th>
<th>Release Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware Horizon Client for Windows</td>
<td>2016-12-08</td>
</tr>
<tr>
<td>VMware Horizon Client for Windows</td>
<td>2016-12-08</td>
</tr>
<tr>
<td>VMware Horizon Client for Windows 10 UWP</td>
<td>2016-12-08</td>
</tr>
<tr>
<td>VMware Horizon Client for Windows 10 UWP for x86-based devices</td>
<td>2016-12-08</td>
</tr>
</tbody>
</table>

Follow the prompts for installing the client.

If you are prompted for information on your type of Internet address and it asks you to select IPV4 or IPV6, select IPV4.

If you are prompted for a server name, enter “desktop.ny.gov”, without the quotes.

3.2.3.3 Starting the VDI Horizon Client from a non-NYSDOT Computer

Use these instructions to access the VDI Horizon Client on your device away from the NYSDOT network.

Open the VDI Horizon Client Desktop Icon shown.
• Double click on the Add Server Icon and you will be prompted for the connection server name. Enter desktop.ny.gov.

![Add Server](Figure 66: Desktop Server Icon)

• You will see the “Connecting…” graphic.

![Connecting...](Figure 67: Connecting Graphic)

• Input the RSA Token
  
  o You will be prompted for your RSA token before you log in. If you are using a soft token from your smart phone app be certain that you enter the correct 4 digit PIN to obtain the token. Even if the incorrect PIN is entered the app will return an RSA Token, however, it will be invalid.

![Login](Figure 68: VMWare Horizon Login)

  o The RSA username is your email address as the system understands it. For NYSDOT employees it is their actual NYSDOT email address. For external consultants and contractors it is in the format userid@nysdot.private, where userid is your Active Directory (AD) Account Userid; do not enter your work or personal email address.
  
  o The RSA Passcode is the token number. For those with a software token obtained with your smart phone it is the eight digit number that you obtained. For those with a hardware token similar to the one in Figure 69, enter the PIN that you identified when you applied for your token and the six digit token that appears on the hardware key.
Log into the Client

- Enter the first two lines as shown above in Figure 70. The DOT Username is the Active Directory (AD) username assigned to the user when they first were granted access to NYSDOT systems and the DOT password is the current password assigned to the AD account. Select “NYSDOT” in the dropdown box for Domain and click on Login. If you use `userid@nysdot.private` as your Username as you did earlier and enter your password, you can skip choosing the Domain.

- Access your Remote Desktop
  - A desktop selection screen will display
Select the “DOT Virtual Desktop” Icon

Your virtual computer will display

Click OK
Double click on the applications folder.

The list of applications available to you will be listed in the window as shown in Figure 74.

Select P6 Professional R8.2 and double-click to open it.

3.2.3.4 Using a USB Drive with VDI

Unlike in the past where a virtual T: drive was assigned to external users, files can only be exported, uploaded, saved or printed to a USB drive connected to the VDI desktop. If you wish to perform one of these activities, insert the flash drive into a USB port. The VDI should...
recognize the USB drive and upload the driver if necessary. From the pull down menu example shown in Figure 75 the USB device “SanDisk Cruzer” can be selected for use.

The user is able to select the manner in which the drive is connected. We suggest that the choice of “Automatically Connect when Inserted” be used.

![USB Device Pulldown Menu](image)

Detailed instructions for the implementation of USB devices with the Horizon VDI client can be found at the following URL: [https://pubs.vmware.com/horizon-client-windows-desktop/topic/com.vmware.horizon.windows-client-43-help.doc/GUID-A845BCB2-CCAD-4B5F-B2E7-C36BCA6941E2.html](https://pubs.vmware.com/horizon-client-windows-desktop/topic/com.vmware.horizon.windows-client-43-help.doc/GUID-A845BCB2-CCAD-4B5F-B2E7-C36BCA6941E2.html)

### 3.2.3.5 Changing an AD (Active Directory) Password Using VDI

Every 90 days users are required to change their AD password. From the VDI desktop the Send Ctrl-Alt-Delete menu choice should be clicked.

![Virtual Desktop Menu Choices](image)

The user will then be presented with the following four choices:

![Ctrl-Alt-Delete Menu Choices](image)

Click on “Change a password”. The user will be presented with an additional screen shown in Figure 78.
Choose the NYSDOT domain with your UserID as shown above. The user will then be asked to enter the current password and the new password twice. After doing so click on the right pointing arrow and if the password meets the established security criteria it will be changed.

### 3.2.4 Accessing Primavera P6 from Locations on the NYSDOT Network

#### 3.2.4.1 Installing the VDI Horizon Client Application through Software Center for NYSDOT Systems

Use these instructions to install the VDI Horizon Client on your NYSDOT desktop or laptop. The VMware Horizon HTML portal is not available from inside the NYSDOT firewall and therefore the Client application must be used:

- Click on the start button in the bottom left corner.
Navigate through Start->All Programs-> Microsoft System Center -> Configuration Manager -> Software Center. Click on Software Center.

Opens the Software Center browser which displays all the available software.

Click the checkbox for "DOT-VDI Horizon Client' on the “Available Software” tab and Click on the button ‘Install Selected’.

The installation will take some time to download the application from the server and install on the machine.

3.2.4.2 Starting the VDI Horizon Client from your DOT Desktop or Laptop

Connecting to Your Virtual Desktop.

Open the VDI Horizon Client Desktop Icon shown
• Double-click on the desktop.ny.gov server icon.

• You will see the “Connecting…” graphic.

• Enter your Active Directory (AD) User Name and Password. Select NYSDOT from the Domain pull down list and click login.

• You will see a new icon for DOT Virtual Desktop. Double-click on this icon.
• You should now see the **Windows** PC logon screen. Select the **OK** button to accept the Security disclaimer.

• When the Virtual Desktop appears, double click on the Applications folder, then double click on the P6 Professional R8.2 program listing.

### 3.2.5 Enterprise Project Structure (EPS)

The EPS is a hierarchical data structure within Primavera P6 that organizes projects based on their key characteristics such as region in which they are located or project phase (i.e. capital program or reflection.) This structure is used for organizational security and reporting purposes. Figure 88 below contains a high level screen view of the Enterprise Project Structure at NYSDOT for external Contractor’s schedules with one node from Region One exploded.

<table>
<thead>
<tr>
<th>EPS/Project ID</th>
<th>EPS/Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPS: Statewide</td>
<td>Office Of Regional Affairs (Vacant)</td>
</tr>
<tr>
<td>EPS: East Tm</td>
<td>Eastern Zone</td>
</tr>
<tr>
<td>EPS: EPS: Region 1</td>
<td>NYSDOT Region 1 Office - Albany (Sam Zhou)</td>
</tr>
<tr>
<td>EPS: R1 Construction</td>
<td>Region 1 Construction (Bob Remmers)</td>
</tr>
<tr>
<td>EPS: R1, AC51</td>
<td>Area Construction Supervisor 1 (Michael Grey)</td>
</tr>
<tr>
<td>EPS: R1, AC52</td>
<td>Area Construction Supervisor 2 (Kevin Wilder)</td>
</tr>
<tr>
<td>EPS: D261353</td>
<td>D061852 - Route 97 Bridge Replacement (Chuck Pulford)</td>
</tr>
<tr>
<td>EPS: D261353-CWA</td>
<td>Contractors Work Area</td>
</tr>
<tr>
<td>EPS: D261353-APS</td>
<td>As Planned At Award Baseline Progress Schedule</td>
</tr>
<tr>
<td>EPS: D261353-FBS</td>
<td>Final As Planned Beyond Baseline Progress Schedule</td>
</tr>
<tr>
<td>EPS: D261353-CPS</td>
<td>Current Progress Schedule</td>
</tr>
<tr>
<td>EPS: D261353-PSU</td>
<td>Past Progress Schedule Status</td>
</tr>
<tr>
<td>EPS: D261353-FABPS</td>
<td>Final As-Built Schedule</td>
</tr>
<tr>
<td>EPS: D261353-WT</td>
<td>What If Progress Schedule</td>
</tr>
<tr>
<td>EPS: D261822</td>
<td>D261822 - Rehabilitation - DeWitt Clinton Memorial Bridge (Mike...</td>
</tr>
<tr>
<td>EPS: D262026</td>
<td>D262026 - Replacement - Herrington Bridge (Dennis...</td>
</tr>
<tr>
<td>EPS: D262078</td>
<td>D262078 - Replacement - Falls Ave. Bridge (Steve...</td>
</tr>
<tr>
<td>EPS: D262569</td>
<td>D262569 - Replacement - Whiskey Run Road Bridge (Rick...</td>
</tr>
<tr>
<td>EPS: D262998</td>
<td>D262998 - Bridge (Bob...</td>
</tr>
<tr>
<td>EPS: D262921</td>
<td>D262921 - NYSDOT Office</td>
</tr>
<tr>
<td>EPS: D263014</td>
<td>D263014 - Recovery</td>
</tr>
<tr>
<td>EPS: R1, AC43</td>
<td>Area Construction</td>
</tr>
<tr>
<td>EPS: R1, AC45</td>
<td>Area Construction</td>
</tr>
<tr>
<td>EPS: R1, AC46</td>
<td>Area Construction</td>
</tr>
<tr>
<td>EPS: R1, Unassigned</td>
<td>Region 1 Unassigned</td>
</tr>
<tr>
<td>EPS: R1, Sandbox</td>
<td>Region 1 Sandbox Area</td>
</tr>
<tr>
<td>EPS: Region 2</td>
<td>NYSDOT Region 2 Office - Utica (Nick Choube)</td>
</tr>
<tr>
<td>EPS: Region 7</td>
<td>NYSDOT Region 7 Office - Watertown (Steve Kukkonen)</td>
</tr>
<tr>
<td>EPS: Region 9</td>
<td>NYSDOT Region 9 Office - Binghamton (Jack Williams)</td>
</tr>
<tr>
<td>EPS: Western</td>
<td>Western Zone</td>
</tr>
<tr>
<td>EPS: Downstate</td>
<td>Downstate Zone</td>
</tr>
<tr>
<td>EPS: Major Projects</td>
<td>Major Projects Office</td>
</tr>
<tr>
<td>EPS: PMO Sandbox</td>
<td>PMO Sandbox</td>
</tr>
<tr>
<td>EPS: Schedule Templates</td>
<td>Schedule Templates</td>
</tr>
<tr>
<td>EPS: EPS Template</td>
<td>EPS Construction Contract Template</td>
</tr>
</tbody>
</table>

**Note:** An example of a project level EPS. Contractors have access to the Contractor’s Work Area and the Read Only Project nodes. NYSDOT staff have access to the Read Only nodes.
3.2.6 Organizational Breakdown Structure (OBS)

Users are provided access to data within Primavera P6 based on their function within the organization using the OBS. Note that the structure is consistent for each of the regions. The OBS is graphically displayed in a hierarchical manner (Figure 89), but security in the OBS is not hierarchical. For example, an Area Construction Supervisor cannot see any of the Contractor’s Work Areas. He/she can only see the Figure 5 below shows the P6 OBS partially exploded for Contractor access. Note that all external contract access is included within the ‘Reflections’ node, while the planning and design access is included within the ‘Capital Program’ node.

![OBS Diagram]

An example of a project level OBS. Access is granted to all users only on a project sub-node basis.

3.2.7 Work Breakdown Structure (WBS)

The Work Breakdown Structure (WBS) is a hierarchical arrangement of the products and services produced during and by the project. It allows activities to be organized into logical groups.
The project is the highest level while an individual activity to create a product or service is at the lowest level. It enables you to divide a project into meaningful and logical pieces for the purpose of planning and control. Figure 90 is an example of a WBS for a Bridge Reconstruction. Note that the WBS Path elements with a “+” to the left have been collapsed to that level.

3.2.8 **Enterprise Resource Directory**
Resources including employees and equipment are stored within the P6 Resource Dictionary, which groups users and resources based on type (e.g. Equipment, Crew Labor & Individual Labor).
Please see Figure 91 for an example of a contractor resource listing highlighting. Similarly, NYSDOT Pay Items are also available as a resource table. If a contractor is either required to or desires to utilize resources, the CPM Scheduling Section should be contacted to set up the appropriate resource hierarchy for the specific contractor.

### 3.2.9 Project & Activity Codes & User Defined Fields

#### 3.2.9.1 Activity Codes

Activity codes are assigned to activities to allow for filtering, sorting, or grouping activities by categories according to the needs of NYSDOT and the Contractor. The following are commonly used activity code categories:

Activity codes can be global; these codes are developed and maintained by NYSDOT. Several global activity codes are required to be used by the Contractor for Type 2 schedules. Activity Codes shall include, but not be limited to: Responsible Party (Global); Stage (Global); Area of Work (Global); and additionally as required by the Engineer to meet the needs of the specific contract work to facilitate the use and analysis of the schedule. Global activity codes apply across the entire enterprise while Project activity codes are project specific and should be designated with the project D number as a prefix to the code, e.g., D999999 – Area. Contractors can add data items to the Project Activity Codes that they develop. Each activity code (global and project) may contain an unlimited number of activity code values. Activity codes, both project and global, can be organized in a hierarchy.

#### 3.2.9.2 Project Codes

Project codes are assigned to a schedule when it is first developed as a template for the use of the contractor. New project code values are entered by the Administrators with the addition of new projects, staff, contractors, etc. A typical assignment of the project codes for a schedule is shown in Figure 92.
3.2.9.3 User Defined Fields

In order to track data not already accounted for in the project management database, you can use the user defined fields feature and maintain data specific to your organization.

User defined fields are custom fields you create to track information specific to certain subject areas, such as projects, activities, resources, issues, or risks. For example, you can track additional activity data, such as delivery dates and purchase order numbers. You can also track additional resource data or project cost-related data, such as profit, variances, and revised budgets. User defined fields are global, so they can be used across all projects in your organization.

Administrators can create project user defined fields from the Administration Home page in P6 Web Access. Project user defined fields are fields that track information specific to projects; for example, your organization may require a custom field to track project profit. Project user defined fields are unique in that you can define a formula or statement to automatically calculate field values, and identify graphical indicators to display for a field, based on its value.

All other user defined fields, such as activity, resource, or issue user defined fields, must be created in the Project Management module.

3.2.10 Project Filters

A Project filter is a set of instructions that determines which Projects should display on screen when in the Project view. Filters enable you to create customized layouts by limiting the number of projects displayed – helping you to focus. A set of pre-defined filters is provided, as is the ability to create user defined filters of your own.

Filters are divided into the following groupings:

Default: Available to all users; 15 pre-defined; cannot be deleted or modified.
Global: Available to all users; established by the administrators at NYSDOT
User Defined: Available to current users for all projects to which they have access

---

Figure 92: Project Code Entries for a Typical Project

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NYS Agency</td>
<td>1</td>
<td>NYS Dept of Transportation</td>
</tr>
<tr>
<td>Division</td>
<td>D</td>
<td>Delivery Division</td>
</tr>
<tr>
<td>Zone</td>
<td>EZ</td>
<td>Eastern Zone</td>
</tr>
<tr>
<td>Schedule Owner</td>
<td>State Archive</td>
<td>State Archive</td>
</tr>
<tr>
<td>Region</td>
<td>R1</td>
<td>1 (Albany)</td>
</tr>
<tr>
<td>PES UnNumber</td>
<td>0261423</td>
<td>Batchelorville Bridge</td>
</tr>
<tr>
<td>PIN Number</td>
<td>175303.321</td>
<td>Batchelorville Bridge over Sacandaga Lake</td>
</tr>
<tr>
<td>Review Status</td>
<td>Submitted For Rev</td>
<td>(New Code Value)</td>
</tr>
<tr>
<td>Area Construction</td>
<td>Gray</td>
<td>Michael Gray (R 1)</td>
</tr>
<tr>
<td>EL</td>
<td>Porter</td>
<td>John Porter</td>
</tr>
<tr>
<td>Schedule Reviewer</td>
<td>NYSDOT</td>
<td>NYSDOT</td>
</tr>
<tr>
<td>LAS Contractor</td>
<td>Harrison &amp; Burrowes Bridge CNS</td>
<td>Harrison &amp; Burrowes Bridge CNS</td>
</tr>
<tr>
<td>Contractor's Project</td>
<td>Jonathon McNatty</td>
<td>D.R. McNatty</td>
</tr>
<tr>
<td>Project Type</td>
<td>STRS</td>
<td>Structures - Bridge Constr &amp; Rehab</td>
</tr>
<tr>
<td>Schedule Type</td>
<td>T2A</td>
<td>Type 2A</td>
</tr>
<tr>
<td>County/Municipality</td>
<td>21</td>
<td>Hamilton County</td>
</tr>
</tbody>
</table>
Multiple criteria for selection may be used within a single filter. Filter specifications can be saved and reapplied. Filters can be saved as part of a layout. One or more filters may be applied to a layout at a time.

3.2.11 Project Layouts 6

A layout is a customizable view of project information. To customize a layout to meet specific needs, you can choose from a wide range of project information, columns, colors, fonts, and activity groupings, and you can display these data in the top and/or bottom layouts. For example, show a Gantt Chart in the top layout and an Activity Table in the bottom layout. Each time you change the way data are presented in the top and bottom layouts, you create a unique layout. The module automatically prompts you to save a layout when you close it, allowing you to define a unique name for it so you can use the layout again with the current project or a different project.

3.2.12 Global & Project Calendars

Calendars are established to designate the days and times of day that an activity can occur or a resource is available. There are three calendar pools:

Global Calendar pool
- Contains two calendars authorized by NYSDOT that can be used by all projects.
- Available for all activities and resources.
- Developed & managed by NYSDOT administrative users

Resource calendar pool
- Contains separate calendars for each resource
- Available for resources

Project calendar pool
- Contains a separate pool of calendars for each project.
- Available for the current project only.
- Developed by the Contractor
- Must be reviewed by NYSDOT.

3.2.13 User Preferences

User preferences are set by selecting Edit > User Preferences. The user has the option of resetting these values. We will briefly discuss two of these dialog boxes and the desired settings related to them.

3.2.13.1 Time Units

The unit of time and duration recommended is the Day with a one decimal designated. (Figure 93) We recommend showing one decimal since occasionally a duration of less than ½ day can occur and cause issues which are not obvious unless a decimal duration is shown.

---

6 This section is excerpted from the Primavera® P6™ Project Management Reference Manual
3.2.13.2 Date Format & Time

The Dates dialog box allows the user to customize the format of the date and time. While to avoid clutter in printing a schedule a user can select “Do not show time” it is recommended that time should be shown at all other times.

It is particularly important to show time when statusing activities, i.e., placing the actual date and time that an activity occurred. If time is not turned on, an activity that begins and ends on the same day will be statused at the same time resulting in a completed activity of zero duration.
3.2.14 Toolbars

The toolbars at the top and sides of the screen can be customized by the user. Select View > Toolbar and then click on the toolbar that you would like to add or remove. It is also possible in that same dropdown to select customize and create a toolbar that you might use to perform certain specific functions in P6.

Figure 95: Typical Toolbar Selection (Upper & Left Side)
4. EXTERNAL SCHEDULING (CONTRACTOR OWNED)

4.1 Section 100 Compliance

The contractor shall prepare and submit progress schedules showing the order in which the Contractor proposes to carry on the work and the dates on which they plan to start and complete major items of work. The purpose of the progress schedule is to ensure adequate planning and execution of the work and to evaluate the progress of the work. The Contractor’s progress schedule, updates, revisions and reports will be an integral part of the Department’s management of the capital program. The Contractor's schedules will be used by the Department to monitor progress, plan the level of effort by its own work forces and consultants, and as a critical decision making tool. Accordingly, the Contractor shall ensure that its progress schedule submissions are both accurate and timely.

Approval of the progress schedule shall not be construed to imply approval of any particular method or sequence of construction or to relieve the Contractor of providing sufficient materials, equipment and labor to guarantee completion of the contract in accordance with the contract documents. Approval shall not be construed to modify or amend the contract agreement or the completion date therein.

All costs to create and update the progress schedule shall be solely the Contractor’s obligation and will be at no additional cost to the State unless specifically provided for in other contract provisions.

If the work falls behind the progress schedule, the Contractor shall take such actions as necessary to improve its progress. If the Contractor is behind schedule any month, the Contractor shall indicate what measures it will take in the next thirty (30) days to put the work back on schedule so as to meet the contract completion date specified in the contract. In preparing the revised schedule, the Contractor shall consider increasing its work force, construction plant and equipment, the number of work shifts, etc.

4.2 Requirements for Contractor's Progress Schedules

In addition to the attributes of the Progress Schedule provisions as set forth in §108-01, the Contractor shall prepare, furnish, and maintain a computer-generated Progress Schedule using the Critical Path Method (CPM) utilizing Oracle-Primavera scheduling software on the Department’s network servers. The CPM Progress Schedule shall be prepared based on the principles defined by the latest issue of the Construction Planning & Scheduling Manual published by the Associated General Contractors of America, except where superseded by the contract documents such as the CPM Special Notes and this specification.

The Contractor and the Department shall use the Progress Schedule to manage the work, including but not limited to the activities of subcontractors, fabricators, the Department, other involved State agencies and authorities, other entities such as utilities and municipalities, and all other relevant parties involved with the project.

No work other than installation of the Engineer’s Field Office, mobilization, procurement and administrative activities, installation of construction signs, installation of erosion and pollution protection, clearing and grubbing, field measurements, and survey and stakeout will be permitted to start until the Baseline Progress Schedule @ Award has been submitted to the Engineer, and the Engineer determines there are no deficiencies consistent with those identified in paragraph I.1 Immediate Rejection of Progress Schedule Submissions.

The purpose of the Progress Schedule, and scheduling provisions in the contract, shall be to:
• Ensure that the Contractor and the Department have a detailed plan and resources to complete the project in accordance with contract time requirements;
• Provide a means of monitoring the progress of work;
• Aid in communication and coordination of activities among all affected parties;
• Analyze the effect of changed conditions on any milestone dates or on the contract completion date;
• Analyze the effect of change orders for extra work or deductions, and unanticipated delays, on the contract completion date;
• Establish a standard methodology for time adjustment analysis based on the principles of the Critical Path Method of scheduling, to analyze delays and resolve construction disputes concerning time;
• Determine appropriate extensions or reductions of Contract Time.

In scheduling and executing the work, the Contractor shall:
• Sequence the work commensurate with the Contractor’s abilities, resources and the contract documents. The scheduling of activities is the responsibility of the Contractor.
• Ensure that Progress Schedules prepared by the Project Scheduler for submission to the Department are in compliance with the Contract. The intent should be that Schedule submissions and accompanying Narratives are timely, complete, accurate, and in compliance with the Contract.
• Communicate all Contract changes, and decisions or actions taken by the Contractor and all subcontractors, fabricators, etc, that effect the Progress Schedule to the Project Scheduler in a timely manner to allow appropriate development, maintenance, and update of the Progress Schedule.
• Include all work contained in the Contract and all work directed in writing by the Engineer. Work activities directed by the Engineer to be added to the Contract shall be included in the next Monthly Progress Schedule submission.
• Assess that Progress Schedule Updates reflect the actual dates that work activities started and completed in the field.
• Break a schedule activity into multiple activities to reflect a discontinuity in the work if a work activity is suspended in the field and restarted at a later date, and the break between when the work was suspended to when it was resumed is significant compared to the original activity duration.
• Ensure the Progress Schedule contains all work constraints and Milestones defined in the Contract.
• Schedule the work using such procedures and staging or phasing as required by the Contract. Work designated as part of separate stages may be performed concurrently with other stages where allowed by the Contract or where approved by the Department.

Failure by the Contractor to include any element of work required by the Contract in the accepted progress schedule does not relieve the Contractor from its responsibility to perform such work.

Should the Contractor choose to show activities in the schedule that reflects their plan of work prior to the contract award, the Department does not incur any liability and such work being performed between the letting date and the contract award date shall be considered at risk work. Errors or omissions on schedules shall not relieve the Contractor from finishing all work within the time limit specified for completion of the contract.

The Contractor’s progress schedule will be used to establish a standard methodology for time adjustment analysis, based on the principles of the Critical Path Method of scheduling, to identify work items and paths that are critical to the timely completion of the work, to identify upcoming activities on the critical path(s), to evaluate the best course of action for recovering schedule delays, to facilitate efforts to complete the work in a timely manner, and to evaluate resource requirements of the Contractor and the Department.

The Contractors progress schedule will be used as the basis for analyzing the time impact of changes in the work and unanticipated delays on any contract milestone dates; to resolve contract disputes concerning time; and as the basis for recommendations for changes to the contract completion date.
Events, actions, and progress that cause delays or gains to the progress schedule will be analyzed solely by the Contemporaneous Period Analysis method.

4.2.1 CPM Scheduling Software

The State will provide Primavera P6 software, or newer release, and computer system for use by the Engineer to review the schedules submitted by the Contractor. The Department has installed Primavera P6 software, or newer release, on internet accessible servers for use by the Department’s construction inspection staff. Appropriate Department personnel, Consultants, and Contractors will also have access to these schedules on the Department’s Enterprise Project Management Database (EPMD). The Department will determine the location to store the project schedule files on the EPMD, and will provide the Contractor the naming convention for all progress schedule submissions.

Upon announcement by the Department that they are the apparent low bidder, the Contractor may submit Request for Access forms to the Regional Construction Engineer for each user to obtain the User ID’s and Passwords for access to software and data on the network servers. The Department will process these requests and should generally provide the User ID’s and Passwords within two weeks of receipt by the Regional Construction Engineer. Upon approval and authorization by the Regional Construction Engineer, required User ID’s and passwords will be provided to the Contractor (for the Project Scheduler plus one other person) to obtain secure Internet access to the Primavera software and project schedule data. If the Contract is not awarded to this Contractor, the Contractor’s access to this project will be removed.

The Department provided User Id’s and Passwords are assigned to specific individuals and shall not be shared with any other users. The Department will provide the Contractor either a Preliminary Construction Schedule or a project schedule template for the Contractor’s use in developing their Progress Schedule. The Contractor shall develop, update, and revise the Progress Schedules using Primavera P6 software that has been loaded on the Department’s network servers and the Contractor shall store all Progress Schedule files on the Department’s network servers.

Primavera software and schedule data on the Department’s EPMD will generally be available for the Contractor’s use at all times unless system maintenance (i.e., backups, upgrades, etc) is being performed.

System maintenance will generally be conducted over short time periods between the hours of 10 PM to 6 AM, Monday through Friday and on weekends. The Department does perform regular backup of data contained in the EPMD, and will make every effort to restore the latest historical copy of schedule submissions in the event of any data failure of the EPMD. The Contractor shall also be responsible for exporting copies of project progress schedules, recovery schedules, TIA schedules, after data modifications have been made as their backup of these submissions. In the event a

<table>
<thead>
<tr>
<th>TABLE 1 – Schedule Filename convention</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Progress Schedules</strong></td>
</tr>
<tr>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Baseline Progress Schedule @ Award</td>
</tr>
<tr>
<td>Final Baseline Progress Schedule @ Award</td>
</tr>
<tr>
<td>Month #1 Progress Schedule Submission</td>
</tr>
<tr>
<td>Month #2 Progress Schedule Submission</td>
</tr>
<tr>
<td>As-Built Progress Schedule (Last Progress Schedule)</td>
</tr>
<tr>
<td>Recovery Schedule</td>
</tr>
</tbody>
</table>
Contractor’s authorized user cannot access the software from 6AM to 10PM Monday through Friday, the Contractor shall provide written notification to the Engineer.

Project schedules are developed from the Contractor’s knowledge of the project, and the means and methods represented in those schedules are based on the Contractor’s understanding of the contract documents, and the Contractor’s past experience, which are unique to the Contractor. Schedule activity data and logic are therefore the intellectual property of the Contractor and will not be made available to other Contractors. All other schedule data, and all Enterprise data residing on the network servers, are the sole property of the Department.

4.2.2 Project Scheduler

The Contractor shall designate an individual, entitled the Project Scheduler, who will develop and maintain the construction progress schedule. The Project Scheduler shall be present at the Preconstruction Schedule Meeting, prepared to discuss, in detail, the proposed sequence of work and methods of operation, and how that information will be communicated through the Progress Schedule. The Project Scheduler shall attend all meetings, or receive meeting minutes that outline schedule related issues of those meetings, which may affect the CPM schedule, including but not limited to those between the Contractor and their Subcontractors and between the Contractor and the Department. The Project Scheduler shall be knowledgeable of the status of all aspects of the work throughout the length of the Contract, including but not limited to: original contract work, additional work, new work, and changed conditions of work.

4.2.3 Construction Schedule Meetings

4.2.3.1 Preconstruction Schedule Meeting

The Contractor shall contact the Regional Construction Engineer after notification they are the apparent low bidder, but no later than two (2) State Business Days following the notice of contract award to schedule a Preconstruction Meeting. One topic of this meeting will be to discuss all essential matters pertaining to the satisfactory scheduling of project activities, and to resolve any known questions regarding interpretation of the contract requirements for this work.

The Project Scheduler shall be prepared to discuss the following:

- The proposed hierarchical Work Breakdown Structure (WBS) for the Progress Schedules. The Project Scheduler shall provide a paper copy at the meeting.
- The proposed project calendars.
- The proposed project activity codes and various code values for each activity code. The Project Scheduler shall provide a paper copy at the meeting.
- The specifics of any contract Time-Related Clauses (A+B Bidding, Incentive/Disincentive, Liquidated Damages, Lane Rental, etc.);
- The Contractor’s schedule methodology to be employed, proposed work sequence and any proposed deviations from the contract plans with respect to Staging or Work Zone Traffic Control phasing.
- The Key Plans shall be provided at the meeting.
- The factors that the Contractor determines to control the completion of the project and any milestone activity completion dates contained therein.
- The Project Scheduler shall provide an outline for the content of the Narrative report for future Progress Schedule submissions.
- Schedule submission protocol for Progress Schedule submissions.

The Contractor shall submit to the Engineer for review, a minimum of five Work Days prior to the Preconstruction Schedule Meeting, the following: a copy of the Key Plans, a print out of the proposed Work Breakdown Structure, a print out of each of the proposed project Calendars showing the Contractor Work Days versus non-work days and work hours per day, and a list of the Code Values for each Project Activity Code proposed to be used in the schedule.
The Engineer will be available to answer questions regarding scheduling, including: the availability of Department supplied electronic file(s) containing sample project schedule information, sample progress schedule narratives, Special Notes for CPM Scheduling, and required standard format for CPM Progress Schedules for contract work.

4.2.3.2 Progress Schedule Meetings

The Contractor shall schedule meetings as necessary with the Engineer to discuss schedule development and resolve schedule issues, until the Final Baseline Progress Schedule @ Award is accepted by the Engineer.

One topic of the regular progress meetings held by the Engineer and attended by the Contractor shall be a review of the Weekly Status Report generated from the Progress Schedule. The Contractor shall be represented by the Field Superintendent and Project Scheduler. The Project Scheduler shall bring a copy of the printed plot of the current Weekly Status Report to the progress meeting, the report shall show the current anticipated schedule for all remaining work with the critical path activities highlighted.

- The review of the Status Report serves as the forum to discuss project progress and delays, suggested remedies, necessary Progress Schedule revisions, coordination requirements, change orders, potential Contractor time extension requests, and other relevant issues. If contract work is falling behind the Progress Schedule, the responsible party (i.e.- Contractor or Department) shall be ready to discuss what measures it will take in the next thirty (30) days to put the work back on schedule so as to meet the contract Completion Date specified in the contract.

- Items of discussion will include, but are not limited to: project progress; schedule progress; near term and long-term schedule issues, including RFIs, Shop Drawing submittals, permit work, utility relocations, mitigation work; project issues and risks; proposed solutions; and any relevant technical issues that are schedule related.

- At the meeting the Project Scheduler shall compile an action item list that describes who is responsible for existing or pending issues and the date by which the issue needs to be resolved to avoid delays. The Contractor shall forward a copy of the action item list to the Engineer within 2 business days following the meeting.

4.2.4 Progress Schedules

The Contractor shall prepare and submit complete baseline progress schedules to the Engineer for approval, showing all of the on-site construction activities with durations and seasonal or other limitations, including activities of the Contractor, subcontractors, fabricators, and suppliers to ensure adequate planning and communication. The number and details of the activities will be dependent upon the nature, size, and complexity of the work.

Baseline Progress Schedule Requirements. As a minimum, the Contractor shall address the following:

- Defining Project Details and Defaults – Within the Dates tab, the “Planned Start” shall be the Letting Date, the “Data Date” shall be the date of Contract Award, the “Must Finish By” date shall be the contract Completion Date. Within the Settings tab, define the Critical Activities as the “Longest Path”. The Project Scheduler role does not have security privileges to change this data in the project Details tab, so requests for changes to this data need to be forwarded by email to CPMschedulingSection@dot.ny.gov; include in your request the contract Dnumber and the ProjectID.

- Sufficient activities shall be included to ensure that there is adequate planning for the entire project. The appropriate number of activities will be largely dependent upon the nature, size, and complexity of the project. In addition to all site construction activities, network activities shall include: activities necessary to depict the procurement/submittal process including shop drawings and sample submittals; the fabrication and delivery of key and long-lead procurement elements; testing of materials, plants, and equipment; settlement or surcharge periods activities; sampling and testing period activities; cure periods; activities...
related to temporary structures or systems; activities assigned to subcontractors, fabricators, or suppliers; erection and removal of falsework and shoring; major traffic stage switches; activities assigned to the Department and other involved State agencies and authorities, including final inspection; activities to perform punch list work; and activities assigned to other entities such as utilities, municipalities, County government/agencies, and other adjacent contractors. The schedule shall indicate intended submittal dates, and depict the review and approval periods as defined in the Contract Documents for Department review.

- The following Activity ID’s and Activity Descriptions exactly as shown in Table 3 shall be incorporated into all Progress Schedules:
### TABLE 2: Required Activities

<table>
<thead>
<tr>
<th>Activity ID</th>
<th>Activity Description</th>
<th>Duration (Min)</th>
<th>Follows Logic Tie</th>
<th>Responsible Party</th>
</tr>
</thead>
<tbody>
<tr>
<td>M0001</td>
<td>Contract Letting Date</td>
<td>0 - Start Milestone</td>
<td>----</td>
<td>---- NYSDOT</td>
</tr>
<tr>
<td>00005</td>
<td>Preconstruction Schedule Meeting</td>
<td>1 State Business Day</td>
<td>M0001</td>
<td>SS NYSDOT</td>
</tr>
<tr>
<td>00011</td>
<td>Prepare &amp; Submit DMWBE Goals</td>
<td>Minimum 1 Work Day</td>
<td>M0001</td>
<td>SS Contractor</td>
</tr>
<tr>
<td>00015</td>
<td>DMWBE Utilization Approved</td>
<td>15 State Business Days</td>
<td>000011</td>
<td>FS NYSDOT</td>
</tr>
<tr>
<td>00030</td>
<td>Submit Proof of Insurance</td>
<td>1 Work Day</td>
<td>M0001</td>
<td>SS Contractor</td>
</tr>
<tr>
<td>00020</td>
<td>Contract Award Process</td>
<td>45 Calendar Days</td>
<td>M0001</td>
<td>SS NYSDOT</td>
</tr>
<tr>
<td>M0025</td>
<td>Contract Award Date</td>
<td>0 - Finish Milestone</td>
<td>00020</td>
<td>FF NYSDOT</td>
</tr>
<tr>
<td>00010</td>
<td>Preconstruction Meeting</td>
<td>1 State Business Day</td>
<td>M0001</td>
<td>SS NYSDOT</td>
</tr>
<tr>
<td>00035</td>
<td>Notification to Proceed</td>
<td>5 State Business Days</td>
<td>M0025, 00030</td>
<td>FS NYSDOT</td>
</tr>
<tr>
<td>00040</td>
<td>Prepare/Submit Safety &amp; Health Plan</td>
<td>Minimum 1 Work Day</td>
<td>M0001</td>
<td>SS Contractor</td>
</tr>
<tr>
<td>00045</td>
<td>Approve Safety &amp; Health Plan</td>
<td>20 State Business Days</td>
<td>00040</td>
<td>FS NYSDOT</td>
</tr>
<tr>
<td>M0050</td>
<td>Contractor’s First Day of Work</td>
<td>0 - Start Milestone</td>
<td>00035, 00045</td>
<td>FS Contractor</td>
</tr>
<tr>
<td>00055</td>
<td>Set Up Engineer’s Field Office</td>
<td>20 Work Days</td>
<td>00035</td>
<td>FS Contractor</td>
</tr>
<tr>
<td>00060</td>
<td>Prepare &amp; Submit Baseline Progress Schedule @ Award</td>
<td>10 State Business Days from Notice of Award</td>
<td>00005</td>
<td>FS Contractor</td>
</tr>
<tr>
<td>00065</td>
<td>Review Baseline Progress Schedule @ Award</td>
<td>10 State Business Days</td>
<td>00060, M0025</td>
<td>FS NYSDOT</td>
</tr>
<tr>
<td>00070</td>
<td>Accept Baseline Progress Schedule @ Award</td>
<td>1 State Business Days</td>
<td>00065</td>
<td>FS NYSDOT</td>
</tr>
<tr>
<td>00075</td>
<td>Mobilization</td>
<td>20 Work Days</td>
<td>M0050</td>
<td>SS Contractor</td>
</tr>
<tr>
<td>M0100</td>
<td>Field Work Begins</td>
<td>0 - Start Milestone</td>
<td>M0050, 00055, 00060</td>
<td>Contractor</td>
</tr>
<tr>
<td>M00900</td>
<td>Substantial Completion</td>
<td>0 - Finish Milestone</td>
<td>See definition</td>
<td>FF Contractor</td>
</tr>
<tr>
<td>09010</td>
<td>Other Agency Inspection</td>
<td>20 State Business Days</td>
<td>M0900</td>
<td>FS Others</td>
</tr>
<tr>
<td>09020</td>
<td>NYSDOT Final Inspection</td>
<td>20 State Business Days</td>
<td>M0900</td>
<td>FS NYSDOT</td>
</tr>
<tr>
<td>09030</td>
<td>Punchlist Work</td>
<td>20 Work Days</td>
<td>09020</td>
<td>FS Contractor</td>
</tr>
<tr>
<td>M00950</td>
<td>Contractor’s Last Day of Work</td>
<td>0 - Finish Milestone</td>
<td>09030</td>
<td>FF Contractor</td>
</tr>
<tr>
<td>M00960</td>
<td>Contract Completion Date</td>
<td>0 - Finish Milestone</td>
<td>09026, 09030</td>
<td>FF Contractor</td>
</tr>
<tr>
<td>09040</td>
<td>Demobilization</td>
<td>10 Work Days</td>
<td>09028</td>
<td>FS Contractor</td>
</tr>
<tr>
<td>M00925</td>
<td>Regional Recommendation for Final Acceptance</td>
<td>0 - Finish Milestone</td>
<td>09040</td>
<td>FF NYSDOT</td>
</tr>
<tr>
<td>M99999</td>
<td>Final Acceptance by the DCEC</td>
<td>0 - Finish Milestone</td>
<td>M00925</td>
<td>FF NYSDOT</td>
</tr>
<tr>
<td>M99999</td>
<td>Final Agreement</td>
<td>0 - Finish Milestone</td>
<td>M99999</td>
<td>FF NYSDOT</td>
</tr>
<tr>
<td>M99998</td>
<td>Final Payment</td>
<td>0 - Finish Milestone</td>
<td>M99999</td>
<td>FF NYSDOT</td>
</tr>
</tbody>
</table>

---

7 The Logic Tie shown shall be used as a relationship to the predecessor activities contained in the column named Follows.

8 Acceptance Date shall not exceed 40 State Business Days from Notice of Award.
• **Activity ID** - Include a unique identification number for each activity. Activity ID numbers shall not be changed, or reassigned for the duration of the contract.

• **Activity Name** - Clearly and uniquely define each activity name with a description of the work that is readily identifiable to inspection staff and the progress of each activity can be measured. Each Activity shall have a narrative description consisting at a minimum of a verb or work function (i.e. form, pour, excavate, etc), an object (i.e. slab, footing, wall, etc), and a location (i.e. STA, bridge or retaining wall number, street, etc). The work related to each Activity shall be limited to one Area of the contract, one Stage of the contract, one WZTC Phase of the contract, and one Responsible Party of the contract.

• **Milestone Activities** - Include activities for all contract milestones that define significant contractual events such as Contract Award, Notice to Proceed, Contractor Start Work, Substantial Completion, Physical Completion, Contract Completion, and coordination points with outside entities such as utilities, State agencies, Authorities, municipalities, Time-Related Contract Provisions, etc.
  - The Contract Award milestone shall have a primary constraint of “Finish On” and the date of Contract signature by the State Comptroller.
  - The Contract Completion milestone shall have a primary constraint of “Finish on or before” and the contract Completion Date.
  - The Contractor Start Work” Start milestone activity, that will eventually reflect the actual date the Contractor started work authorized under the contract.

• **Activity Durations** – Define the Original Duration of each activity in units of whole work days, except for activities of less than one day duration which should be shown in units of tenths of a day. Except submittal/procurement activities, durations shall not exceed 15 work days unless approved by the Engineer. Durations for Department submittal reviews shall meet the requirements set forth in the contract documents. If requested by the Engineer, the Contractor shall justify the reasonableness of planned activity time durations. Task Dependent activities shall not have a zero duration.

• **Activity Relationships** - Clearly assign predecessors and successors relationships to each activity, and assign appropriate logic ties between activities (Finish to Start, Start to Start, Finish to Finish, etc). Do not have any open ended activities, with the exception of the first activity and last activity in the schedule. An activity may only appear once as a predecessor or successor to another specific activity, but may be assigned as a predecessor or successor to many different activities. Do not include inappropriate logic ties with Milestone activities (For a finish milestone activity: a predecessor shall only be assigned a Finish to Finish logic tie, a successor shall only be assigned a Finish to Start or Finish to Finish logic tie. For a start milestone: a predecessor shall only be assigned a Finish to Start or Start to Start logic tie, a successor shall only be assigned with a Start to Start logic tie). Lag time may not exceed 10 days. The Contractor shall not use negative Lag times.

  - The Contractor shall assign the “Contract Award Date” activity as a predecessor to all Review and Approval type activities to be performed by Department staff.

• **Activity Constraint Dates** – The Contractor shall not have any constrained activities, with the exception of contractual dates, unless the Engineer accepts such constraints in writing. Milestone activities shall be included for the Contract Award which shall have a primary constraint of “Finish On” and the date of contract signature by the State Comptroller, and for the Contract Completion which shall have a primary constraint of “Finish on or before” and the contract completion date indicated in the contract documents. Only contractual/owner-designated constraints are allowed unless specifically authorized by this specification or the Engineer.

• **Activity Dates** – With the exception of contract Milestone dates, “Actual Start” and “Actual Finish” dates and “Planned Start” and “Planned Finish” dates, activity dates shall be calculated by the project scheduler tool within the Oracle-Primavera software. No Actual Start or Actual Finish dates shall be entered in the Baseline Progress Schedule @ Award, with the exception of activities that were completed prior to the Contract Award.

• **Calendars** - Use clearly defined calendars that account for expected seasonal weather conditions (including winter shutdown periods) and environmental permit requirements, for the planning and scheduling of activities. Do not incorporate an activity with a description of “Winter Shutdown” that requires constraints. Provide the working days per week, holidays, the number of shifts per day, and the
number of hours per shift by using the Calendar modifier in the P6 software. Incorporate any seasonal restrictions to the work within calendars assigned to activities.

- Global calendars used in the progress schedule shall be those established by the Department. There are only two Global Calendars developed and maintained by the Department for use by Contractor’s, they are the following:
  - NYSDOT Milestone/Curing 365 Day / 8 hour
  - State Business Days, 5 Day Work Week w/State Holidays, Field

All milestone activities in the schedule shall be assigned the standard Global calendar named ‘NYSDOT Milestone/Curing 365 Day / 8 hour”, this calendar should also be assigned to any activities for concrete curing. Activities for shop drawing reviews and other approvals by Department personnel shall be assigned the Department’s standard Global – “State Business Day, 5 Day Work Week w/State Holidays, Field” Calendar that reflects all holidays observed by the State.

Changes desired for these calendars shall be forwarded by email to CPMSchedulingSection@dot.ny.gov, and if appropriate these changes will be performed by the Office of Construction system admin staff. This will be accomplished by making a copy of the existing Global calendar, and then the new calendar will be renamed and modified as necessary.

- Calendars related to specific resources (i.e., a specific piece of equipment) shall be established as Resource Calendars, with the Calendar name clearly identifying the resource.

- All other calendars developed by a Contractor shall be established as Project Calendars, with the calendar name including the contract D# and describing the function (i.e., D260000 - Asphalt Calendar, D260000 - Concrete Calendar, D260000 - Landscape Calendar, D260000 - Painting Calendar, D260000 – Contractor’s 5 Day/8 Hour Workweek). All work activities of the Contractor shall be assigned to Project Calendars.

- The Baseline Progress Schedule can not include a calendar that reflects any workers working more than 8 hours in any one calendar day or more than 5 days in any one week. (§102-10 LABOR AND EMPLOYMENT) Following the contract award the Contractor can add additional calendars in their next Monthly Progress Schedule submission based on an approved overtime dispensation.

- Clearly define significant interaction points between the Contractor, the Department, and other entities including but not limited to Federal, State and local agencies/authorities; and utilities. All activities of the Department, utility companies, adjacent contracts, and other entities that affect progress and influence any contract required dates including durations shall be shown in the schedule. This includes dates related to all Permits or Agreements. The schedule shall give special consideration to sensitive areas such as road closures and parklands and shall indicate any time frames when work is restricted in these sensitive areas as outlined in the permits issued by the regulatory agencies, and provided in the contract documents.

### 4.2.4.1 Draft Baseline Progress Schedule

The Contractor is encouraged, but not required, to submit a Draft Baseline Progress Schedule. The schedule should demonstrate how the Project Scheduler’s proposed alphanumeric coding structure and the activity identification system for labeling work activities in the CPM progress schedule will conform to the detailed requirements of the specifications.

This submittal may be made anytime following notice to the Contractor that they are the apparent low bidder on the contract. Critical items for this review should include but are not limited to: the proposed WBS for subsequent progress schedules; the proposed project Calendars; major milestone activities (e.g. Notice to Proceed, Contractor’s First Day of Work, Contractor’s Last day of Work, Anticipated Completion Date); and between fifty to one hundred summary activities for the major work deliverables of the contract (e.g. - pave EB from STA x to STA y, construct roundabout 1, construct bridge xyz, etc) that have assigned Activity Ids, Activity Descriptions, Activity Durations, Predecessors, Successors, and Activity Relationships.
These summary activities will be broken down into, or supplemented with, individual work activities for the baseline submission.

If any Crew resources are included, the composition of the staffing (the number and titles of the various staff) shall be listed in the Notes tab of the Crew resource, and the composition of the crews shall be included in the narrative. To the extent practicable, the Draft Baseline Progress Schedule should include administrative and procurement activities to be accomplished during the contract; planned submittal, review, and approval dates for shop drawings, working drawings, fabrication drawings, and contractor supplied plans, procedures, and specifications.

Any submission of a Draft Baseline Progress Schedule should be accompanied by a written Narrative that provides details of the Calendar assignments of Working Days versus non-work days, outlines the sequence of planned operations to complete the project work, and provides the proposed Activity Codes and Code values to be assigned to activities in future submissions of project progress schedules.

The review and comment by the Engineer of the sample schedule should assist the Project Scheduler in assuring the first submittal of the Baseline Progress Schedule @ Award will be in general conformance with the requirements of the specification and other contract requirements, and that major rework of the Baseline Progress Schedule @ Award will not be required. The Engineer will review the logic diagram, coding structure, activity identification system, and Narrative; and provide comments for required changes by the Project Scheduler for implementation in the submission of the Baseline Progress Schedule @ Award. The Engineer will provide written comments on major deficiencies within five (5) State Business Days of receipt. The Department reviews Draft Baseline Progress Schedules solely for format, and will not consider any submission of a Draft Baseline Progress Schedule for approval as an Early Completion Schedule.

4.2.4.2 Baseline Progress Schedule @ Award

Within ten State business days of receipt of the contract award the Contractor shall prepare and submit a Baseline Progress Schedule that meets the following requirements:

- **The Contractor shall ensure the schedule accurately reflects the proposed approach to accomplish the work outlined in the Contract documents and conforms to all requirements of this specification.**
- **The schedule shall define a complete logical plan that can realistically be accomplished, to execute the work defined in the Contract.**
- **The schedule shall comply with the work constraints and milestones defined in the Contract as well as all other contractual terms and conditions. The schedule shall be consistent in all respects with the specific interim Time-Related Contract Provisions, and any order of work requirements of the contract documents. The schedule shall meet all interim milestone dates and shall not extend beyond the contract completion date. This submission shall reflect the Contractor’s plan at the time of contract award, and prior to the start of any work.**
- **Float.** No negative float is allowed in the Baseline Progress Schedule @ Award submission.
- **Data Date.** The Contractor shall enter the contract Award Date as the Data Date. If the Contractor submits a Baseline Progress Schedule @ Bid submission, the Data date shall be the date of the schedule submission to the Engineer and not prior to the bid date.
- **Activity Codes.** The Contractor shall develop the Progress Schedule using, to the maximum extent practicable, the Global Activity Codes (DOT GLOBAL) identified in the Department’s Primavera enterprise solution.
- **Project Level Layouts & Filters.** Any “Layouts”, “Filters” and “Report” formats that the Contractor develops for the various Progress Schedules submissions to the Engineer shall be saved and made available to all other users of the project schedule with a name that includes the contract
D#. The Contractor shall assign appropriate Activity Codes and provide custom Layouts, Filters, and/or report formats necessary to allow the Engineer to generate a report from the each Progress Schedule submission of all submittals required under the contract (i.e., shop drawings, required permits, erection/demolition plans, etc). The list shall show scheduled submission date, review date, and acceptance date for each submittal and identify the earliest activity affected by each of these submittals. This list shall be generated from each Progress Schedule submission until all such activities are completed.

- **Schedule Submission**
  - Within the timeframe indicated in Table 4 Column 1, the Contractor shall submit one electronic copy of the Baseline Progress Schedule @ Award in a Critical Path Method (CPM) format for the Engineer’s review and acceptance.

Table 4: Timeframes for the Review and Approval of the Baseline Progress Schedule @ Award

<table>
<thead>
<tr>
<th>Timeframe from Receipt of Notice of Award to Submission of Complete Baseline Schedule. (Column 1)</th>
<th>Timeframe for Engineer’s Review (Column 2)</th>
<th>Timeframe from Notice of Award to Acceptance by the Engineer Not To Exceed (Column 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 State Business Days</td>
<td>10 State Business Days</td>
<td>40 State Business Days</td>
</tr>
</tbody>
</table>

- The Engineer will review the schedule and return it, accept it with comments, or reject it within the timeframes indicated in Table 1 column 2, following the date of receipt of the Contractor’s submission.
- If the schedule is returned with comments, the Contractor shall address all comments and revise the schedule as necessary. The Contractor shall complete the Final Baseline Progress Schedule @ Award and obtain the acceptance of the Engineer within the timeframe required in Table 1 column 3.
- If the schedule is accepted without any comments by the Engineer, the Contractor shall copy the schedule and rename it for submission as the Final Baseline Progress Schedule @ Award.
- In no way does the Baseline Progress Schedule modify the contract documents.

- **Developing the Work Break Down Structure (WBS)**
  A multi level hierarchal WBS shall be incorporated that provides a deliverable-oriented grouping of activities and defines the total scope of the project.

The Contractor shall develop a detailed project specific WBS for the Engineer’s review and approval. The Engineer shall make the final determination on the number of levels of the WBS, and how the activities shall be grouped to represent the deliverables of the project.

For all projects the first two levels (nodes) of the WBS shall be labeled as follows:

- Level 1 - is the project level; and shall have the project name.
- Level 2 - shall have three nodes; “PRECONSTRUCTION”, “CONSTRUCTION”, and “POST CONSTRUCTION”.

For all projects under “PRECONSTRUCTION” a third level of the WBS shall consist of at least the following three sub nodes: “GENERAL SUBMITTALS”, “SHOP DRAWINGS”, and “PROCUREMENT/FABRICATION/DELIVERY”.

Under the “CONSTRUCTION” node, the grouping of activities may vary depending on the scope and nature of the project work. The Contractor shall coordinate with the Engineer to determine the best way to represent (group activities) the project deliverables (i.e. Bridge, Roundabout, Highway segment, Interchange, Intersection, etc) and the various Stages or Phases of work.

Generally Level 4 would be by geographic area within the project limits, Level 5 would be by highway feature (bridge, highway segment, intersection), Level 6 the highway features should be broken into their components (a bridge into components such as Piles, Substructure, Superstructure), and a highway segment into components such as pavement, drainage, earthwork, lighting, traffic signals, etc.

An example Work Breakdown Structure is shown below in Figure 96
Detailed Narrative Requirements for the Baseline Progress Schedule.

Include a narrative in Microsoft Word and/or Adobe Acrobat format that describes:

- The contract D number, project name, project location, and name of Prime Contractor.
- Actual contract Award Date, current contract Completion Date, and scheduled completion of all project work.
- Any contact Interim Milestone dates (I/D, B-Clock, LD, etc), and scheduled Start and Finish dates for those Milestone activities.
- The Contractor’s general approach to construct the Work outlined in the baseline schedule. Address the reasons for the sequencing of work and describe any resource limitations, potential conflicts, and other salient items that may affect the schedule and how they may be resolved.
- If not provided in the contract plans, or if modified by the Contractor, provide copies of the appropriate contract plan sheets marked up as Key Plans, to correlate values on the contract plans (for Area of Work, Stage of Work, and WZTC Phase) to the Contractor’s planned breakdown of the project (i.e. Activity Codes, Activity Descriptions) for scheduling purposes.
- The justification(s) for each activity with a duration exceeding 15 working days.
- The reason for any lags assigned to any activities.
- The justification(s) for Contractor imposed activity constraints proposed in the schedule.
- A list of calendars which have been used in the schedule, along with the general reason for their use.
- The project critical path and challenges that may arise associated with the critical path.
- Anticipated coordination issues related to work activities by other entities that require additional information from or action by the Engineer.
- Appendix 1 shall be printed in Adobe Acrobat PDF file format to fit standard ANSI A (letter) size paper (8.5” x 11”) (216 mm x 279 mm) with portrait orientation, included with the narrative as a separate file. Appendix 1 is a complete Scheduling/Leveling Report generated by the Department’s Oracle-Primavera P6 scheduling software application which includes the Schedule Settings, Statistics, Errors, Warnings, Scheduling/Leveling Results, Exceptions, Activities with...
unsatisfied constraints, Activities with unsatisfied relationships, and Activities with external dates.
The statistics shall include, # of Activities, # of Activities Not Started, # of Activities In Progress, # of Activities Completed, # of Activity Relationships, # of Activities with Constraints, total number of activities on the critical path, percent complete, activities without predecessors, activities without successors, and activities out of sequence.

- Appendix 2 shall be printed in Adobe Acrobat PDF file format to fit standard ANSI B (ledger) size paper (11” x 17”) (279 mm x 432 mm) with landscape orientation, included with the narrative as a separate file. Appendix 2 to the narrative shall be an electronic schedule plot using the Global Layout named “Baseline Schedule submission”, with activities sorted by Start Date in ascending order, Grouping of activities by WBS, and only the “Longest Path” filter applied. This plot shall provide a clear critical path from the Data Date to the last activity in the schedule. Graphical representations shall be shown at a suitable scale to be legible and readable.

4.2.4.3 Baseline Progress Schedule @ Bid.

For projects with late award the contractor may submit a Baseline Progress Schedule @ Bid. The schedule shall meet the Baseline Progress Schedule @ Award requirements with work accurately reflecting the proposed approach to accomplish the work outlined in the Contract documents with a 45 calendar day award period.

4.2.4.4 Final Baseline Progress Schedule @ Award

- If the Baseline Progress Schedule @ Award is returned to the Contractor with comments, the Contractor shall make a copy of the schedule and rename it as the Final Baseline Progress Schedule @ Award with comments addressed and revisions made as necessary. The Contractor shall complete the Final Baseline Progress Schedule @ Award and obtain acceptance of the Engineer within the timeframe required in column 3 of Table1, or within one week of the Contractor’s receipt of the final comments by the Engineer, whichever is sooner.
- The Engineer shall review the schedule and return it, accepted or with comments, within 5 State Business days following the date of receipt of the Contractor’s submission.
- The Final Baseline Progress Schedule @ Award must be “accepted” or “accepted as noted” by the Engineer prior to the Department evaluating any Contractor disputes associated with time impacts. This does not preclude the Contractor from submitting a dispute while the schedule is being reviewed for acceptance.

4.2.4.5 Progress Schedule Updates and Weekly Status Reports

- The Contractor shall perform a Progress Schedule Update, on a minimum, at the end of each week.
- The Contractor shall generate a Weekly Status Report at the end each work week after performing the Progress Schedule Update and Scheduling the project with a Data Date of day the schedule was updated, and submit it to the Engineer by the beginning of business each Monday. The Weekly Status Report shall be generated using the activity Layout named Weekly Status Report, with activities grouped by the WBS, sorted by Finish Date. The Gantt chart shall clearly indicate the project critical (longest) path. Graphical representations shall be shown at a suitable scale to be legible and readable.
- During any time periods within the contract that special time-related contract provisions are in effect, including B-Clock periods or Incentive/Disincentive Periods, the Engineer may require more frequent Progress Schedule Updates and/or Progress Schedule Status Reports.

4.2.4.6 Monthly, Bi-Weekly, or Weekly Progress Schedule Submissions

- First Progress Schedule Submission – Within three State Business Days following acceptance of the Final Baseline Progress Schedule @ Award the Contractor shall perform a Progress Schedule Update to reflect the status of all activities where work was performed in the time period between the start of work and acceptance of the Final Baseline Progress Schedule @ Award. This shall include actual dates entered in the Actual Start and Actual Finish columns, and percentage of work complete for uncompleted activities, in addition the Contractor shall incorporate any Progress Schedule Revisions that reflect any changes in how future work activities are to be completed.
• **Subsequent Progress Schedule Submissions**: The Contractor shall prepare and submit subsequent Progress Schedule submissions on a regular basis based on the schedule type determined in the pay item in the contract.

  Type 2A: Monthly Progress Schedules
  Type 2B: Bi-Weekly Progress Schedules
  Type 2C: Weekly Progress Schedules

  The Contractor shall submit a copy of the current Progress Schedule that includes all Progress Schedule Revisions and Progress Schedule Updates to reflect the actual and planned prosecution and progress of the contract work. Progress Schedule Updates shall reflect the status of activities that have commenced or have been completed, including the following items: (a) actual dates in activity Actual Start and Actual Finish columns as appropriate; (b) actual Remaining Duration for activities commenced and not complete; and (c) actual activity Suspend or Resume dates for activities commenced and not complete. Progress Schedule Revisions reflect modifications made to activities in the current project baseline schedule in any of the following items: (a) activity Original Duration; (b) changes in logic connections between activities; (c) changes in Constraints; (d) changes to Activity Descriptions; (e) activity additions or deletions; (f) changes in Activity Code assignments; (g) changes in Calendar assignments, and Work Days; (h) Productivity Rates; (i) a list of Notebook Topic additions and changes. All "Out of Sequence" activities noted in the scheduling log shall be corrected to reflect the current construction operations.

• For any contract time extension requests the Contractor shall include: a Time Impact Analysis (TIA) for any changes to the schedule for future work for such issues as Added Work, VECP, or Changed Conditions; and a Delay Analysis that documents all delays from the Contract Award to the current date that is based on critical path delays that occurred when comparing subsequent Monthly/Bi-Weekly or Weekly Progress Schedule submissions and the supporting delay documentation in the Progress Schedule Narratives.

• **Narratives for the Weekly/Bi-Weekly/Monthly Progress Schedule.** For each Progress Schedule submission, the Contractor shall submit a narrative in Microsoft Word, or Adobe Acrobat format that includes, but is not limited to the following additional items: (The narrative may be an annotated copy of the Claim Digger Report that includes the information below.)

  - Recap of progress and days gained or lost versus the previous progress schedule submission. For each activity on the critical path (include Activity ID’s and Activity Descriptions) where work was delayed during the reporting period, provide the following detailed information including the:
    - extent in days (negative float) of the delay, and events that caused the delay.
    - party(s) responsible for the delay event(s).
    - other activities in the construction schedule affected by the events.
    - reasonable steps needed to minimize the impact of the delay, and which party needs to take the action(s).
  - List any other problems experienced during this Progress Schedule submission period, the party responsible for the problems, and the Contractor’s intentions to resolve the problems.
  - List all activities for procurement of long lead time materials that are behind schedule and the reason(s) why.
  - For major work items describe the differences between the actual work performed and the work planned for the period as represented in the preceding Progress Schedule submission, including explanations for the deviations.
  - For all suspended work activities that could otherwise logically be progressed, identify the responsible party prohibiting the progression of the work, as well as the detailed reasons why.
  - Description of any changes to the critical path since the last Progress Schedule submission and the impacts of such changes.
  - List of all added or deleted activities included in this Progress Schedule submission, and the reason(s) for and the impact(s) of such changes.
  - List all changes in activity Original Durations, the justification for such change(s), and the impact(s) of such changes.
  - List all changes in relationships between activities included in this Progress Schedule submission, and the reason(s) for and the impact(s) of such changes.
List any addition or deletion of activity or project constraints, and the reason(s) for and the impact(s) of such changes.

List all changes to the project calendars, and the reason(s) for and the impact(s) of such changes.

The major work elements, as defined in the WBS, to be accomplished during the next monthly work period.

Any potential problems that are anticipated for the next monthly work period and the proposed solutions to such problems. Identify potential problems or risks that either the Department or Contractor may be potentially responsible for. Explain what action the responsible party (i.e. - Department or Contractor) needs to take and the date by which time the action needs to taken to avoid the problem.

Any planned acceleration of activities that the Contractor anticipates to undertake within the next monthly work period that either the Department directed, or that the Contractor believes is necessary.

A signed certification that the Contractor has not been delayed, as of the closing date of the reporting period, by any act, error or omission of the Department, except as otherwise specifically stated in the narrative or identified in a dispute submitted in accordance with the general conditions of the Contract. Any determination by the Department will be binding on the Contractor if the Contractor fails to do so.

Appendices 3 and 4 shall be printed in Adobe Acrobat PDF file format to fit standard ANSI E size paper (34” x 44”) (863 mm x 1117 mm) with landscape orientation, included with the narrative as separate files.

- Appendix 3 is a listing of all work activities as of the data date, using the NYSDOT Appendix 1 activity layout, sorted by Finish date, Total Float in increasing order, showing the Activity ID, Activity Name, Original Duration, Remaining Duration, Actual Duration, Total Float, Early Start date, Start date, Finish date, Late Finish date, and Calendar ID. The grouping of activities shall be by WBS. The Gantt Chart shall clearly indicate all activities in the schedule. Graphical representations shall be shown at a suitable scale to be legible and readable.

- Appendix 4 is a listing of work activities filtered by Notebook Topics assigned as of the data date, sorted by Finish date and Total Float in increasing order, showing the Activity ID, Activity Name, and Notebook Topic. The grouping of activities shall be by WBS.

4.2.4.7 As-Built Progress Schedule.

The Contractor shall submit the As-Built Progress Schedule with Actual Start and Actual Finish dates for all activities, within ten (10) State Business Days following final acceptance of work by the Regional Director.

4.2.4.8 Recovery Schedule

- If the latest completion time for any work on the current Progress Schedule results in an activity being delayed ten percent or more of the time beyond the required Contract duration or any specified Milestone duration, as adjusted if appropriate, the Engineer may require the Contractor to submit a Recovery Schedule and written description of the plan to recover all lost time and maintain the required Completion Date or specified Interim Milestone Date(s).

- With the Recovery Schedule the Contractor shall submit a narrative that identifies where additional labor and/or equipment resources will be allocated. Alternately, the Contractor may elect to provide the makeup of their Crew resources in the narrative, and assign those Crew resources to the appropriate activities in the Progress Schedule. The makeup of the Crew shall include the various Labor classes and equipment that comprise the Crew along with the quantity of each labor class and type of equipment. Equipment resources shall be shown for major or specialty equipment such as tower cranes, pile drivers, barges, asphalt pavers, concrete pavers, dozers, front end loaders, backhoes, rollers, excavators, graders, long line striping truck or other equipment that cannot be rented easily. Either of these alternatives may be supplemented with a request for a Contract Time Extension. The Contractor shall provide a reasonable plan for accomplishing the work of the contract within the
current completion date, or to the requested contract extension date. The Engineer will use the Recovery Schedule to evaluate time extensions, with or without charges.

4.2.4.9 **Look-Ahead Schedule**

Except during winter shutdown periods the Contractor shall prepare a Look-ahead Schedule as either a plotted report from the current progress schedule, or as a narrative report, and provide it to the EIC on a weekly basis, or if approved by the Engineer on a mutually agreed upon interval. The Look-ahead schedule shall include work activities planned for the next one or two week period, as determined by the Engineer, and shall include, but is not limited to: anticipated lane closures, road closures and detours, environmental issues, and utility issues. The Engineer will provide the Project Scheduler with guidelines for determining the begin dates and end dates for the one or two week reporting periods, along with the bow the plotted schedule report or narrative report shall be formatted.

The Department generally uses this Look-ahead schedule to facilitate communication with other Federal or State agencies, local municipalities, utility companies, railroads, emergency service providers, public news media and other affected parties.

4.2.5 **Schedule Submission Methodology**

Progress Schedule submissions will only be considered complete when all documents and data have been provided to the Engineer.

- When preparing a formal submission of the progress schedule, the Contractor shall make a copy of the current Progress Schedule and name it according to the file naming convention provided by the Department in Table 5.

Table 5: Schedule Filename Convention

<table>
<thead>
<tr>
<th>Progress Schedules</th>
<th>1st Version</th>
<th>2nd Version</th>
<th>3rd Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft Baseline Progress Schedule</td>
<td>D26#####-1DB</td>
<td>D26#####-2DB</td>
<td>D26#####-3DB</td>
</tr>
<tr>
<td>Baseline Progress Schedule @ Award</td>
<td>D26#####-1BPS</td>
<td>D26#####-2BPS</td>
<td>D26#####-3BPS</td>
</tr>
<tr>
<td>Final Baseline Progress Schedule @ Award</td>
<td>D26#####-1FB</td>
<td>D26#####-2FB</td>
<td>D26#####-3FB</td>
</tr>
<tr>
<td>Month 1Bi-Weekly Progress Schedule Submission #1A</td>
<td>D26#####-1SU1A</td>
<td>D26#####-2SU1A</td>
<td>D26#####-3SU1A</td>
</tr>
<tr>
<td>Month 1Bi-Weekly Progress Schedule Submission #1B</td>
<td>D26#####-1SU1B</td>
<td>D26#####-2SU1B</td>
<td>D26#####-3SU1B</td>
</tr>
<tr>
<td>Month 2Bi-Weekly Progress Schedule Submission #2A</td>
<td>D26#####-1SU2A</td>
<td>D26#####-2SU2A</td>
<td>D26#####-3SU2A</td>
</tr>
<tr>
<td>Month 2Bi-Weekly Progress Schedule Submission #2B</td>
<td>D26#####-1SU2B</td>
<td>D26#####-2SU2B</td>
<td>D26#####-3SU2B</td>
</tr>
<tr>
<td>As-Built Progress Schedule (Last Progress Schedule)</td>
<td>D26#####-1AB</td>
<td>D26#####-2AB</td>
<td>D26#####-3AB</td>
</tr>
<tr>
<td>1st Time Impact Analysis</td>
<td>D26#####-1TIA1</td>
<td>D26#####-2TIA1</td>
<td>D26#####-3TIA1</td>
</tr>
<tr>
<td>1st Recovery Schedule</td>
<td>D26#####-1RS1</td>
<td>D26#####-2RS1</td>
<td>D26#####-3RS1</td>
</tr>
</tbody>
</table>

4.2.5.1 **File Naming Convention.**

The schedule filename shall conform to the requirements of Table 5. The Project Scheduler can change the Project ID and Name through the WBS at the top node, as they do not have privileges to edit data through the Project Details tab.

4.2.5.2 **Schedule the Project.**

Immediately prior to submitting the schedule the Project Scheduler shall “Schedule” the project, when scheduling the project the Scheduling Options shown in Figure 3 shall be used unless approval to vary from these settings is given by the Engineer. The Project Scheduler shall use the same Scheduling Options for all Progress Schedule submittals for the duration of the contract, unless directed otherwise by the Engineer.

4.2.5.3 **Schedule Submission Delivery.**

The Contractor shall submit the schedule to the Engineer electronically for review and acceptance. The Contractor’s submission shall be documented by an E-mail to the Engineer, with a copy to CPMSchedulingSection@dot.ny.gov and all appropriate project participants, that
the project schedule on the network is ready for review. The Contractor’s E-mail to the Engineer shall also consist of the following:

- The subject of the E-mail shall include the Region #, contract D number, the Project Name, the Progress Schedule’s ProjectID, and construction company name. (i.e. – Region 8, D260000, Rehabilitation of Main Street viaduct, D260000-1UD2, ABC Contractors)

- The E-mail message shall include the name of the EIC, the current anticipated Finish date of the last activity in the project schedule, a statement as to how that date compares to the current Contract Completion Date, and the name of the Area Construction Supervisor.

- Electronic files of all Narrative Reports and required attachments associated with the schedule shall be submitted by the Contractor in Adobe Acrobat format.

4.2.6 Resource Loading

4.2.6.1 Activity Resources

It shall be the Contractor’s responsibility to assure the activity logic in the schedule properly reflects their resource limitations. For each non-administrative activity in the schedule the Contractor shall under the Notebooks Tab assign the “Production Rate” and under the “Description” field enter the quantity of work (with Unit of Measure) to be performed and the production rate of the equipment and labor resources used to determine the Duration of the work activity. An activity shall not involve multiple crews comprised of the Contractor and a subcontractor, or multiple subcontractors.

The level of resource loading of the schedule shall be dependant upon the schedule Type.

- **Type 2A. Monthly Progress Schedules:** The Contractor will generally not be required to develop Labor resources, Equipment resources or Contract Pay Item resources in the Resource Dictionary, or assign them to schedule activities.

- **Type 2B. Bi-Weekly Progress Schedules:** The Contractor shall develop crew level Labor resources, along with Equipment resources in the Resource Dictionary, and assign them to schedule activities. Equipment resources for major or specialty equipment such as tower cranes, pile drivers, barges, asphalt pavers, concrete pavers, dozers, front end loaders, backhoes, rollers, excavators, graders, long line striping truck or other equipment that cannot be rented easily shall be assigned to schedule activities.

- **Type 2C. Weekly Progress Schedules:** The Contractor shall develop Labor resources, Equipment resources and contract Pay Item resources in the Resource Dictionary. The Contractor shall define labor resources for the project that comprise the various labor classifications (e.g., Tower Crane Operator, Operator, Labor Foreman, Laborer, Carpenter, Teamster, Dock Builder, Iron Worker, Painter…), and these resources shall be assigned to schedule activities. Equipment resources for major or specialty equipment such as tower cranes, pile drivers, barges, asphalt pavers, concrete pavers, dozers, front end loaders, backhoes, rollers, excavators, graders, long line striping truck or other equipment that cannot be rented easily shall be assigned to schedule activities. The Department shall provide a resource library of Global Pay Item resources for all standard pay items contained in the Standard Specifications, and the Contractor shall develop pay item resources for any pay items for Special Specifications in the contract. For each activity in the Progress Schedule the Contractor shall assign the appropriate pay item resources, and within the resource details enter the appropriate quantity for each pay item. The Baseline Progress Schedule at Award shall include resource loading for the first ninety (90) days of anticipated contract field (non administrative) work. The remaining activities will require pay item resource assignments as required under paragraph F.2.c. The resource allocations shall be shown to a level of detail that facilitates report generation based on labor classifications and equipment classes for the Contractor and subcontractors. The Contractor shall optimize and level labor to reflect a reasonable plan for accomplishing the work of the contract and to assure that resources are not duplicated in concurrent activities. The time-scaled resource histograms shall show labor classifications and equipment classes to be utilized on the contract.
4.2.7 Progress Schedule Review and Analysis

4.2.7.1 Immediate Rejection of Progress Schedule Submissions

The following deficiencies in a Contractor’s progress schedule submission shall be grounds for the immediate rejection by the EIC, without further review, analysis and/or comments.

- Failure of the Project Scheduler to “schedule” the project, as of the data date.
- Failure to attach a copy of the complete Scheduling/Leveling Report (SCHEDLOG.TXT file generated by the Department’s Oracle-Primavera P6 software application).
- Any activities without predecessors or activities without successors, appearing in the Scheduling/Leveling Report with the exception of the first and last activity in the schedule.
- Any activity constraints appearing in the Scheduling/Leveling Report that have not been approved in writing by the EIC, or that are not specifically allowed by this specification.
- Any Activities with Actual Dates > Data Date appearing in the Scheduling/Leveling Report.
- Any Milestone Activities with invalid relationships appearing in the Scheduling/Leveling Report.
- Failure to have a clearly defined Critical Path from the Data Date to the last activity in the schedule, using the Longest Path method. This would reflect logic errors in the project schedule.
- Failure to attach the schedule Narrative and required appendices.
- Failure to correct any “Out-Of-Sequence” activities.

4.2.7.2 Schedule Analysis Method

Events, actions, and progress that cause delays or gains to the Progress Schedule will be analyzed solely by the "Contemporaneous Period Analysis" method.

4.2.7.3 NYSDOT Review and Acceptance of Progress Schedules

The Engineer will review the Monthly Progress Schedule submissions and will prepare a written response (Progress Schedule Review Report) to the Contractor’s submission within five (5) State Business Days following receipt of the Contractor’s complete schedule submission. The Engineer will either “accept” the schedule, “accept as noted”, or “reject” the schedule for re-submittal by the Contractor.

If the Progress Schedule submission is not in compliance with contract requirements, the Engineer may reject the submittal and shall forward any comments and requests for schedule revisions to the Project Scheduler by email, with a copy to the Contractor and to CPMschedulingSection@dot.ny.gov. The Project Scheduler shall address all comments in writing and/or make the requested revisions, and resubmit the revised schedule within three (3) State Business days of the Engineer’s reply. If the Engineer determines the revised submission still does not meet the contract requirements, any further revisions required thereafter shall also be submitted for acceptance within (3) business days of the request for revisions by the Engineer.

For schedules that are “accepted as noted” the Engineer shall forward any comments, or requests for revisions, to the Contractor by email, with a copy to the CPMschedulingSection@dot.ny.gov. The Project Scheduler shall address all comments in writing and/or make the requested revisions as part of the next scheduled Progress Schedule submission.

The Project Scheduler shall make adjustments to the Progress Schedule in accordance with the Engineer’s comments and resubmit copies for review consistent with the requirements of this section.

The Engineer, by accepting the progress Schedule, does not agree that the Progress Schedule is reasonable or that by following the Progress Schedule the Contractor can complete the work in a timely manner. If, after a Progress Schedule has been accepted by the Engineer, either the Contractor or the Engineer discover that any aspect of the Schedule is on error, or something
significant has been omitted, the Contractor shall correct the Progress Schedule in the next Progress Schedule submission and describe this revision in the Narrative report.

Acceptance of progress schedules by the Engineer shall not be construed to imply approval of any particular construction methods or sequence of construction or to relieve the Contractor from its responsibility to provide sufficient materials, equipment and labor to guarantee the completion of the contract in accordance with the contract documents.

Acceptance of the progress schedule by the Engineer does not attest to the validity of assumptions, activities, relationships, sequences, resource allocations, or any other aspect of the progress schedule. Within the contractual constraints, the Contractor is solely responsible for the planning and execution of the work.

Acceptance of the progress schedule by the Engineer shall not be construed to modify or amend the contract agreement or the date of completion therein. Completion dates can only be modified or amended by standard contractual means, through an official HC-250b Request For Extension of Completion Date.

If any resources are included in the Progress Schedule, it is not intended that the Engineer, by accepting the schedule should use the Contractor’s resource data for anything other than determining the reasonableness of achieving the Contractor’s production rates. Resources included with the accepted CPM schedule shall not be misconstrued as a cost benchmark for the performance of planned or actual work.

Once the progress schedule has been accepted, the Contractor shall not deviate from it without first notifying the Engineer in writing.

Upon receipt from the Contractor of the corrected schedule, a new review period by the Engineer of five (5) State Business days will begin.

4.2.8 Changes to Progress Schedules Due To Added/Deleted/Changed Work

4.2.8.1 Changes to the Contract

In the event a notice of a change to the contract is received, the appropriate changes to the progress schedule shall be made, as necessary, to incorporate the anticipated added/deleted/changed work and the Contractor shall notify the Engineer in writing within 10 (ten) calendar days if there is any effect of such change to the schedule. Change to the contract includes, but is not limited to, extra work, Agreed Prices, Orders on Contracts, Suspensions of Work Directed by the Engineer, Changed Condition, and Value Engineering Change Proposals. Added, deleted and/or extra work associated with Orders On Contract shall be reflected in the next Monthly Progress Schedule Submission in anticipation of and prior to the date in which the work physically takes place without regard to the dates when the actual Order On Contract was approved. The effect of the change to the contract on the projects Critical Path shall be stated. Extra work or additional work that does not affect the controlling operation on the critical path will not be considered as the basis for a time extension. All schedule activities effected by added, deleted or changed work that is included in a signed Order-On-Contract, Field Change Order, or Authorization of Extra Work (with the exception of minor quantity changes that do not impact contract milestones), or work activities performed by the Contractor at risk in anticipation of such Department approval, shall be assigned the appropriate Activity Code (Added/Changed Work) and Code Value (sequentially numbered) to denote which “Changed Contract Work” order number correlates to those activities of work.

4.2.8.2 Time Impact Analysis Requirements
For each request of an adjustment of contract time due to an anticipated change to future work in the Progress Schedule, when the Contractor or Engineer consider that an anticipated or approved change to the contract may impact the critical path and contract progress by more than a calendar month, the Contractor shall submit a Time Impact Analysis (TIA). The TIA shall be submitted as part of any Order on Contract (Change Order) and/or VECP if the critical path changes by more than a calendar month. The TIA shall be based on a revised Progress Schedule and shall be submitted as an electronic file (using Microsoft Word for the narrative) containing:

- The TIA shall illustrate the impacts of each change or delay on the current scheduled completion date or internal milestone, as appropriate.
- The analysis shall use the accepted Monthly Progress Schedule that has a data date closest to and prior to the event as the “Current Baseline”, this shall then be compared against the “What-if Project Plan Baseline” for the purpose of the TIA.
- If the Engineer determines that the accepted schedule used does not appropriately represent the conditions prior to the event, the accepted schedule shall be updated to the day before the event being analyzed.
- The TIA shall include an impacted schedule (“What-if Project Plan Baseline”) developed from incorporating the actual or anticipated event into the accepted schedule by adding or deleting activities, or by changing durations or logic of existing activities.
- If the impact schedule shows that incorporating the event negatively modifies the critical path and scheduled completion date of the accepted schedule, and the Engineer accepts the impacted schedule, the difference between scheduled completion dates of the two schedules shall be equal to the proposed adjustment of contract time.
- The Engineer may construct and utilize an appropriate project schedule or use another recognized method to determine adjustments in contract time until the Contractor provides the TIA.
- The Contractor shall submit a TIA within fifteen (15) State Business Days of receiving a written request for a TIA from the Engineer.
- The Contractor shall allow the Engineer ten (10) State Business Days after receipt to accept or reject the submitted TIA. All accepted TIA schedule changes shall be included in the next Monthly Progress Schedule submission.
- If a TIA submitted by the Contractor is rejected by the Engineer, the Contractor shall meet with the Engineer to discuss and resolve issues related to the TIA. If agreement is not reached, the Contractor will give notice in conformance with §104-06 Notice & Recordkeeping, and submit in accordance within the provisions in §105-14.E "Required Content of Dispute Submissions”.
- The Contractor shall only show actual as-built work, not unapproved changes related to the TIA, in subsequent Monthly Progress Schedule submissions. If agreement is reached at a later date, approved TIA schedule changes shall be included in the next Monthly Progress Schedule submission.
- Request for a contract time extension will not be processed until the receipt and approval of a Time Impact Analysis.

**4.2.9 Failure to Submit Progress Schedules**

- No progress payment for this item of work shall be made until the progress schedule is “accepted” or “accepted as noted” by the Engineer.
- If the Contractor’s Progress Schedule submission is rejected due to any deficiency noted in paragraph H.1(a) through (i), it shall be considered an incomplete submission and therefore substantially deficient.
- If the Contractor’s revised Progress Schedule submission does not address the written comments provided by the Engineer, and does not include a written explanation with a reasonable rationale for not addressing those comments, the submission shall be considered deficient.
4.2.10 Submission of Progress Schedules with Projected Early Completion Date(s)

The Contractor may show a projected early completion date on any progress schedule submission provided that he/she submits a formal request to change the Completion Date through a VECP following the requirements of §104-10 of the Standard Specifications, which must be reviewed and approved by the State.

If the VECP is approved, and the contract completion date is revised to the earlier completion date shown in the progress Schedule, all other §100 General provisions of the Standard Specifications shall apply except that §108-03 will be modified as follows:

If the Contractor fails to complete all contract work by the new completion date the Contractor may be assessed Engineering Charges but not Liquidated Damages for each calendar day that work that remains uncompleted between the period of time from the early Completion Date to the original Completion Date; and may be assessed both Engineering Charges and Liquidated Damages for any work that remains uncompleted after the original completion date in accordance with §108 of the Standard Specifications.

The Contractor shall not be entitled to any additional Extended Field Overhead and/or supervision costs for any delays caused by the State that resulted in work remaining uncompleted beyond the early completion date, until the original contract completion date is exceeded, if the Contractor fails to obtain approval of a change in the contract Completion Date following the VECP requirements in §104-10.

4.2.11 Float

During the course of contract execution, Total Float generated due to the efficiencies of either party (State or Contractor) will be considered project Float that is not for the sole use of the party generating the float; rather it is a shared commodity to be reasonably used by either party. Any party assigned activity responsibility within the schedule has the full use of the project Float until it is depleted. Project Float shall not be negligently be used by either party or relieve either party from their responsibility to complete activities on time based on the contract documents and standard specifications.

4.2.12 Progress Schedule Updates and Weekly Status Reports

4.2.13 How to Represent Time Related Contract Provisions in the Schedule

4.2.13.1 Incentive/Disincentive Clauses

4.2.13.2 Liquidated Damages

4.2.13.3 A+B Bidding

4.2.13.4 Lane Rental

4.2.14 Setting up the Project Template

4.2.14.1 Standard Naming Convention for Progress Schedules

4.2.14.2 Project Details

4.2.14.3 Default Calendar
5. REVIEW AND ACCEPTANCE OF CONTRACTOR’S CPM PROGRESS SCHEDULE SUBMISSIONS

This chapter of the Schedule Manual identifies the steps required for NYSDOT or those designated by the NYSDOT, to review and analyze schedule submissions. The procedures set forth in this chapter should be followed to review submitted schedule submissions, required by the schedule specification. All schedule reviews should be coordinated with the project EIC and the results should be reported to the project EIC in the time frames set forth in the applicable progress schedule specifications. This chapter details the schedule submission and review process, followed by details on the schedule review responsibilities and expectations of the CPM Scheduling Section’s High Level Review, the EIC’s review, and the optional Detailed Review.

5.1 Schedule Submission and Review Process
It is the Contractor’s responsibility to submit, update, and revise schedule submissions within the specified time frames noted in the applicable schedule specification. The Contractor is also responsible to develop its schedule submissions in accordance with the guidance set forth in the contract documents and Chapter xx of this Schedule Manual. This section details the schedule submission and review process.

5.1.1 Schedule Work Flow
The Schedule Work Flow separates the steps of the Item 639 CPM scheduling process in sequential order. The work flow diagrams the process for the Contractor, NYSDOT (CPM Scheduling Section), EIC, ACS and the optional Detailed Reviewers, from Letting Date through Contract Completion and the As-Built Schedule. The phases include:

Project Setup ➔ Baseline Schedule Development ➔ Progress Updates ➔ As-Built Schedule
Figure 97: Project Setup & Baseline Schedule Development Workflow
The flow chart in Figure 98 illustrates the repetitive process where the Contractor submits a schedule and the schedule is then reviewed concurrently by 1) the NYSDOT CPM Scheduling Section, 2) the EIC, and 3) optionally by the Detailed Reviewer. Succeeding sections in this chapter describe the High Level Review, EIC Review, and Detailed Review.

Figure 99: Reviews Following Schedule Submission
### 5.1.2 Schedule Review Responsibilities

Table 6 and Table 7 below outline the responsibilities of the CPM schedule process as delegated among the NYSDOT CPM Scheduling Section, EIC, and optional Detailed Reviewers.

#### Table 6: Schedule Administration

<table>
<thead>
<tr>
<th>Task</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NYSDOT CPM Scheduling Section</strong></td>
<td><strong>EIC</strong></td>
</tr>
<tr>
<td>Post-Letting - Submit P6 Project Setup Request Form</td>
<td>Primary</td>
</tr>
<tr>
<td>Submit EIC / Contractor / Detailed Reviewer Access Request Forms</td>
<td>Primary</td>
</tr>
<tr>
<td>Grant EIC / Contractor / Detailed Reviewer P6 Access</td>
<td>Primary</td>
</tr>
<tr>
<td>Create Initial P6 File and Basic WBS Structure</td>
<td>Primary</td>
</tr>
<tr>
<td>Organize Pre-Con Schedule Meeting</td>
<td>Primary</td>
</tr>
<tr>
<td>Host Pre-Con Schedule Meeting</td>
<td>Assist EIC</td>
</tr>
<tr>
<td>Encourage Timely Contractor Schedule Submissions</td>
<td>Assist EIC</td>
</tr>
<tr>
<td>Contractor Technical Support</td>
<td>Primary</td>
</tr>
<tr>
<td><strong>(Optional) NYSDOT / CI</strong></td>
<td></td>
</tr>
</tbody>
</table>

#### Table 7: Schedule Review & Comment

<table>
<thead>
<tr>
<th>Task</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NYSDOT CPM Scheduling Section</strong></td>
<td><strong>EIC</strong></td>
</tr>
<tr>
<td><strong>High Level Review</strong></td>
<td></td>
</tr>
<tr>
<td><strong>EIC Review</strong></td>
<td></td>
</tr>
<tr>
<td><strong>(Optional) NYSDOT / CI Detailed Review</strong></td>
<td></td>
</tr>
<tr>
<td>Archive Contractor's P6 Submission and Schedule Correspondence</td>
<td>Primary</td>
</tr>
<tr>
<td>Upload P6 Submission to State's Work Area</td>
<td>Primary</td>
</tr>
<tr>
<td>Assign Last Update as a Comparison</td>
<td>Primary</td>
</tr>
<tr>
<td>Technical Review - Global Filters</td>
<td>Primary</td>
</tr>
<tr>
<td>Review Calendars</td>
<td>Primary</td>
</tr>
<tr>
<td>Create and Issue 'Schedule Report'</td>
<td>Primary</td>
</tr>
<tr>
<td>Understand Project Plan and Scope</td>
<td>Primary</td>
</tr>
<tr>
<td>Baseline Schedule Review</td>
<td>Secondary</td>
</tr>
<tr>
<td>Multiple Layouts</td>
<td>Primary</td>
</tr>
<tr>
<td>Attend Progress Meetings</td>
<td>Primary</td>
</tr>
<tr>
<td>Response to Contractor's Narrative / Comment Resolution</td>
<td>Secondary</td>
</tr>
<tr>
<td>Issues / Delays in Schedule</td>
<td>Secondary</td>
</tr>
<tr>
<td>Issues / Delays in Contractor's Narrative</td>
<td>Secondary</td>
</tr>
<tr>
<td>Issues / Delays missing from Schedule / Contractor's Narrative</td>
<td>Secondary</td>
</tr>
<tr>
<td>Confirm Contract Milestones and Durations</td>
<td>Secondary</td>
</tr>
<tr>
<td>Layout 01. Milestones, Constraints &amp; Level of Effort</td>
<td>Primary</td>
</tr>
<tr>
<td>Confirm Actual Dates</td>
<td>Primary</td>
</tr>
<tr>
<td>Layout 07. Actuals in Last 5 Weeks</td>
<td>Primary</td>
</tr>
<tr>
<td>Review 30-Day Look-Ahead</td>
<td>Primary</td>
</tr>
<tr>
<td>Layout 08. 30d Look-Ahead Near-Critical</td>
<td>Primary</td>
</tr>
<tr>
<td>Review NYSDOT-Responsible Activities</td>
<td>Layout 12_NYSDOT Resp Party</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Review Critical Path</td>
<td>Layout 02_Longest (Critical) Path</td>
</tr>
<tr>
<td></td>
<td>Layout 03_Longest (Critical) Path by WBS</td>
</tr>
<tr>
<td>Review Negative Float Activities</td>
<td>Layout 10_Negative Float</td>
</tr>
<tr>
<td>Review Near-Critical Paths</td>
<td>Layout 22_Multiple Float Paths</td>
</tr>
<tr>
<td>Improvement / Slippage from Previous Update</td>
<td>Layout 05_All Slipping Activities</td>
</tr>
<tr>
<td>Schedule Plan vs. Actual Planned Work</td>
<td>Layout 08_30d Look-Ahead</td>
</tr>
<tr>
<td>Available Work that has Not Started</td>
<td>Layout 08_30d Look-Ahead</td>
</tr>
<tr>
<td>Schedule Revisions from Previous Update</td>
<td>Layout 19_Added Activities</td>
</tr>
<tr>
<td>Multiple Float Path Review</td>
<td></td>
</tr>
<tr>
<td>What-If Schedule Scenarios (if necessary)</td>
<td></td>
</tr>
<tr>
<td>Time Impact Analysis (if necessary)</td>
<td></td>
</tr>
<tr>
<td>Recommend Schedule Update Acceptance / Rejection</td>
<td></td>
</tr>
<tr>
<td>Notify Contractor of Schedule Update Acceptance / Rejection</td>
<td></td>
</tr>
</tbody>
</table>

### 5.1.3 Schedule Submission Due Dates

Schedule submission due dates are in each schedule specification. Below is a table summarizing the required timeframes for each different type of schedule submission, common for most contracts. Always refer to the specifications for official policy.

#### Table 8: Schedule Submission Due Dates

<table>
<thead>
<tr>
<th>Schedule Submission Type</th>
<th>Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft Baseline Progress Schedule (optional)</td>
<td>Optional submission is strongly encouraged. May be made anytime following notice to the Contractor that they are the apparent low bidder on the contract.</td>
</tr>
<tr>
<td>Baseline Progress Schedule @ Award</td>
<td>Due within 10 Work Days of receipt of the Contract Award. No work other than installation of the Engineer’s Field Office, mobilization, procurement and administrative activities, installation of construction signs, installation of erosion and pollution protection, clearing and grubbing, field measurements, and survey and stakeout will be permitted to start until the Baseline Progress Schedule @ Award has been submitted to the Engineer</td>
</tr>
<tr>
<td>Final Baseline Progress Schedule @ Award</td>
<td>Acceptance by Engineer shall not exceed 40 Work Days from receipt of the Contract Award.</td>
</tr>
<tr>
<td>First Progress Schedule Submission</td>
<td>Due within 3 Work Days following acceptance of the Final Baseline Progress Schedule @ Award.</td>
</tr>
<tr>
<td>Look-Ahead Schedule</td>
<td>Due on a weekly basis.</td>
</tr>
<tr>
<td>Subsequent Progress Schedule Submissions</td>
<td>Due within 3 Work Days of the last day of the month (or any other repeating Data Date agreed upon by the Engineer).</td>
</tr>
<tr>
<td>As-Built Progress Schedule</td>
<td>Due within 10 Work Days following Contractor’s Last Day of Work.</td>
</tr>
</tbody>
</table>
5.1.4 Schedule Submission Protocol

Each schedule submission should be sent to the Engineer-in-Charge via email. Below is a list of others who should be included on the submission.

- **To:** Engineer-in-Charge
- **Cc:**
  - CPM Scheduling Section ([CPMSchedulingSection@dot.ny.gov](mailto:CPMSchedulingSection@dot.ny.gov))
  - Area Construction Supervisor
  - Regional CPM Coordinator
  - Detailed Reviewer (if applicable)
  - Contractor (if schedule is being submitted by a schedule consultant)
  - Any other NYSDOT staff included on previous emails

Including the D# in all email correspondence is important, because it is used to quickly locate emails when providing Contractors and NYSDOT Regional staff schedule assistance. Email subject requirements in the specification can be reduced to only include the following.

- D#, Update #, Region #, and “Schedule”
- For example, “D269997-1SU06 – Region 1 – Schedule”

Email message should include:

- Intentions of the email, such as “Please upload to the State’s work area for review.”
- EIC
- ACS
- Current anticipated completion date of the schedule, and how it compares to the current contract completion date.

Email attachments should include:

- Contractor’s Narrative
- Schedule Log
- Progress Schedule Plot with Longest Path
- Full Schedule Plot
- Claim Digger report (optional, but encouraged)

5.2 High Level Review (HLR)

5.2.1 High Level Review Overview

NYSDOT performs High Level Reviews (HLR) on all schedule submissions – Baseline schedules, progress updates, as-built schedules, time impact analyses, and recovery schedules. The HLR checks the schedule for:

- Integrity of the schedule so it can be used as a project management and communication tool.
- Compliance with the schedule specification.
- Compliance with good scheduling practices and requirements.

As previously shown in the Schedule Work Flow, the High Level Review process starts following the Contractor submitting a schedule to NYSDOT. Below is an outline of the steps performed by the NYSDOT CPM Scheduling Section during a High Level Review:

- NYSDOT archives the Contractor’s submission, including email, attachments, and P6 schedule file.
- NYSDOT makes a copy of the Contractor’s P6 file from the Contractor’s secure work area to the State’s read-only work area.
- NYSDOT reviews Contractor’s submission and compiles reports, including the Automated High Level Progress Review Report and the Schedule Report (described below).
NYSDOT sends High Level Review as an email with attachments to the EIC and copies the Contractor, ACS, Regional CPM schedule coordinator, and (optional) Detailed Reviewer.

The structure of a High Level Review email includes:

- Technical comments regarding compliance with the schedule specification and good schedule practices and requirements. These comments may be automated using the Automated High Level Progress Review Report (see below).
- Schedule-specific comments generated from layouts in the attached Schedule Report (see below). Each comment in the High Level Review that relates to a Schedule Report layout will reference the specific layout and often includes screen shots of relevant content.

5.2.2 Automated High Level Progress Review Report

The High Level Progress Schedule Review Report is an attachment to the High Level Review. The report is generated once a request has been made by the Contractor to upload a schedule. This report automatically conducts technical checks on the schedule utilizing each of the Global Filters in P6. This report contains an overview section pertaining to General Progress Schedule Information as well as two main sections: Section 1 identifies any deficiency that could possibly warrant Immediate Rejection per the CPM schedule specification; while Section 2 identifies technical issues / errors in the schedule that should be corrected in subsequent updates if deemed necessary. An example of the High Level Progress Schedule Review Report is attached in Appendix xx.

5.2.3 Schedule Report

The Schedule Report is an attachment to the High Level Review. Included in the Schedule Report are a variety of schedule layouts to assist the review of the Contractor’s schedule submission. Each layout is uniquely filtered and organized to present important information and to quickly aid schedule analysis.

The Schedule Report is a single PDF file that combines multiple schedule layouts specifically run for the schedule submission. On the left hand side of the report underneath “Bookmarks” are the names of the various layouts. Clicking on each Bookmark link will bring you to the first page of each layout.

![Layout Links](image)

Figure 100: Schedule Report Layout Links

Each of the layouts is a different report that filters and organizes the Contractor’s schedule submission in various ways. On the top of the first page of each layout, there is a header with the layout name, “Layout Description” and “What To Look For” that will help review each layout.

![Layout Header Information](image)

Figure 101: Layout Header Information
Each and every layout listed in the report is available in P6 as a Global Layout, where any schedule file in the system can be opened, and you can view the details of these reports in the live schedule file. To open the layouts in P6, click View > Layout > Open Layout, and then each layout is listed under the Global heading.

Layouts should be used to stimulate comments in the schedule review to be sent back to the Contractor. Mark up the PDF, take screen shots, or print/extract specific pages that the reviewer feels is important and may need to be addressed by the Contractor. It is not recommended to immediately print the complete report to paper, since the layouts can contain a significant number of pages. Printing hard copies of specific page ranges are formatted and best viewed on 11”x17” paper. An example of the Schedule Report is attached in Appendix xx.

5.2.4 Immediate Rejection Criteria
The schedule specification outlines deficiencies in a Contractor’s Progress Schedule submission that shall be grounds for the immediate rejection by NYSDOT without further review, analysis and/or comments. Generally, if a Contractor has made an immediate rejection criteria error in the schedule submission, the CPM Scheduling Section will reach out to the Scheduler to correct the error prior to the High Level Review, EIC Review, and/or Detailed Review.

5.3 EIC Review

5.3.1 EIC Review Overview
While a High Level Review covers the technical aspects of the schedule for compliance with the schedule specification and standard scheduling practices, the EIC is much more familiar with project specific plans, details, events, progress, and potential delays. The EIC knows the details and current status of the project and this should be their focus in the review of the schedule. If not familiar with the scheduling software, the EIC should utilize the Schedule Report included in each High Level Review to assist in their review of the schedule.

5.3.2 EIC Review Report / Template
The EIC Review Report may be as short as a single page, and a template is included in . The list below is recommended topics for the EIC Review Report, each of which is broken down into further detail below. The EIC Review Report can be completed by reviewing the Contractor’s Narrative and the High Level Review’s Schedule Report. The applicable respective Schedule Report layouts for the topics below are referenced to aid the schedule review process.

- Acceptance / Rejection
- Response to the Contractor’s Narrative / Comment Resolution / Issues & Delays
- Critical (Longest) Path
- Actual Dates
- 30-Day Look-Ahead
- NYSDOT-Responsible Activities
- Any Additional Review Comments / Recommendations
5.3.2.1 Acceptance / Rejection

Notify the Contractor if the schedule submission has been accepted or rejected, as well as specific comments that need to be addressed in the next submission.

The above section Schedule Submission and Review Process shows that the EIC will accept or reject the schedule as part of the workflow for all schedule submissions, including Baseline schedules, progress updates, as-built schedules, and the optional time impact analysis schedules and recovery schedules.

The NYSDOT CPM Scheduling Section can provide the EIC a recommendation for accepting or rejecting a schedule submission. If the EIC is unsure if a schedule submission should be accepted or rejected based on comments made in the High Level Review, and/or based on their own review of the schedule, then the EIC should contact the CPM Scheduling Section for a recommendation.

As noted above, the Detailed Reviewer will make a recommendation to accept or reject a schedule submission based on their review. Again, if a Detailed Reviewer has made a recommendation and the EIC is unsure, the EIC, Detailed Reviewer and CPM Scheduling Section should discuss whether the schedule submission should be accepted or rejected.

5.3.2.2 Response to Contractor’s Narrative / Comment Resolution / Issues & Delays

Reference: Contractor’s Narrative

Schedule Report layout: Milestones, Constraints & Levels of Effort

Comment on the Milestones, Constraints & Level of Efforts, including but not limited to:

- Are all contract completion dates / intermediate contract dates / durations correct?
- Have any contract completion dates / intermediate contract dates / durations slipped / improved and the Narrative does not properly communicate the reasons why?

Enter responses to any comments made in the Contractor’s Narrative, including but not limited to:

- Does the Narrative acknowledge any agreements on reasons for improvement / slippage between Contractor and NYSDOT?
- Does the Narrative acknowledge any agreements on mitigation efforts for slipping work?

Issues / Delays:

- Verify that the dates of issues / delays are accurate in both the Narrative and schedule.
- Where necessary, respond to each current issue / delay in the Contractor’s Narrative.
- Has the Contractor identified how each issue / delay impacts or may potentially impact the schedule, noting important dates to resolve issue / delay?
- Are there other issues / delays not included in the schedule and/or Contractor’s Narrative that should be included?
- Does schedule include all issues / delays discussed at progress meetings?

5.3.2.3 Critical (Longest) Path

Reference: Contractor’s Narrative

Schedule Report layout: Critical (Longest) Path

Schedule Report layout: Critical (Longest) Path by WBS

Describe elements of the Critical (Longest) Path, including but limited to:

- Has the Contractor communicated any changes to the Critical Path from last update?
- Are upcoming activities on the Critical Path scheduled realistically?
- Are there any upcoming dates on the Critical Path that the Contractor is in danger of missing and impacting the completion date?
• Are the scheduled durations accurate based on past performance?
• Do links among different locations / stages / phases on the Critical Path make sense?
• If the schedule is behind, are there opportunities on the Critical Path to gain time?

5.3.2.4 Actual Dates
Reference: Schedule Report layout: Actuals in Last 5 Weeks
Comment on the Actual Start and Actual Finish dates input into the schedule, including but not limited to:
• Identify any incorrect Actual Start and/or Actual Finish dates.
• Did any work start/finish that does not show up as started/finished?
• Is there additional work / changed conditions / issues / etc. that occurred that are not represented in the schedule?

5.3.2.5 30-Day Look-Ahead
Reference: Contractor’s Narrative
Schedule Report layout: 30d Look-Ahead
Schedule Report layout: 30d Look-Ahead Near Critical
Comment on the 30-day look-ahead layout, including but not limited to:
• Does the schedule plan properly represent the actual planned work?
• Is there work that should be in the 30-day look-ahead that is not showing up?
• Is there work showing up in the 30-day look-ahead that will not take place and should be scheduled out further?
• Is there work available to the Contractor that can currently start, but has not started?

5.3.2.6 NYSDOT-Responsible Activities
Comment on the NYSDOT-responsible party layout, including but not limited to:
• Are all NYSDOT-responsible activities represented in the schedule?
• Are NYSDOT-responsible activity Original Durations sufficient?
• Are Actual Start / Actual Finish dates for NYSDOT-responsible activities input correctly?

5.3.2.7 Any Additional Review Comments / Recommendations
Use this section to add in additional comments on the schedule that are not covered in the above sections.

5.4 Detailed Review (Optional)
A Detailed Review may be performed by the NYSDOT, CI agreement, EIC, or other NYSDOT Regional staff. Detailed Reviewers can be assigned to more complex projects where risks are higher and NYSDOT benefits by having a more thorough review of the schedule beyond the High Level Review.

5.4.1 Detailed Review Overview
The Detailed Review is a project specific schedule review for compliance with contract requirements and is an in-depth review of the schedule, including but not limited to:
• 100% of project scope in the schedule
• Construction sequencing
• Reasonable durations
• Time restricted clauses
• Seasonal restrictions

Detailed Reviewers should be having direct conversations with the EIC and Contractor’s Scheduler on a weekly basis. These conversations will facilitate status updates, as well as help the Reviewer, Scheduler and EIC communicate upcoming risk and better assess any necessary changes.

All Detailed Reviewers are reviewing, analyzing and scrutinizing the Contractor’s schedule submissions to ensure that the construction is in compliance with the contract documents and employing good scheduling practices. This means that the schedule submissions have been prepared for the entire project and includes the work of all parties to the project. It means that the Contractor has portrayed the work to an adequate level of detail, using a reasonable plan. It means that the durations used are reasonable given the means and methods employed by the Contractor and the resources to be mobilized. It also means that the Contractor has refrained from the use of tricks or ploys aimed at suppressing float, masking its delays, or shifting the critical path inappropriately to NYSDOT. In addition to these general objectives, the Schedule Reviewers should focus on the following specific requirements as part of its review.

5.4.2 Detailed Review Responsibilities

5.4.2.1 Detailed Review of Baseline Schedules

The following steps should be taken when reviewing Baseline Schedules. The procedure below shall serve as a guide to perform a thorough review of the Baseline Schedules. This procedure is intended to be used in conjunction with the Detailed Review Templates in Appendix C of this Manual. *A more thorough, detailed process of reviewing Baseline Schedules is available in the manual for the NYSDOT Intermediate Schedule Review Course: “Reviewing Schedule Submissions.”*

• The Detailed Reviewer should identify the schedule specification that governs the schedules on the project. The EIC will be able to provide this information to the Detailed Reviewer. If necessary, the EIC should provide a copy of the most current specification to the Detailed Reviewer. The Detailed Reviewer shall ensure that the schedule submission is in accordance with the schedule specifications.

• The Detailed Reviewer should perform a review of the Contract Documents. The Detailed Reviewer should review the Contract Documents to identify any specific phasing, sequencing, or staging requirements for the project. The Detailed Reviewer should thoroughly review the WZTC Plan and Contract Key Plans to verify project staging and to verify all required traffic patterns, switches, and lane closures.

• The Detailed Reviewer should verify the contractor has adhered to all Liquidated Damage or Time-Related Contract Provision Dates and Durations noted in the Progress schedule specifications or Contract Documents.

• The Detailed Reviewer should review the Progress Schedule’s WBS and ensure the WBS is in accordance with the recommended structure listed in Section 4.2.4.2 of this Manual.

• The Detailed Reviewer should review the Contractor’s Progress Schedule Submittal Information:
  o Verify the Data Date of the Baseline Progress Schedule. The Detailed Reviewer should ensure that the Data Date of the Baseline Schedule is consistent with the timing set forth in the applicable schedule specification;
  o Identify the Narrative Information received, as listed in Section D.1.d.xiii of the Progress schedule specifications; and
  o The Contractor may provide additional information to the Detailed Reviewer or the EIC that it feels would aid in the review of the Progress Schedule. The Detailed Reviewer should review any other submitted information that may be important to the review of the Baseline Schedule, which is above and beyond the requirements of Section E.1. of the Progress schedule specifications, and take note of any information that will be helpful to the EIC.

• The Detailed Reviewer should review the Contract Durations and Contract Milestone Dates:
  o Verify the Contract Completion Dates. If the Contractor submits a Baseline Progress Schedule that indicates an anticipated early completion date(s) that is less than 90% from the
Data Date of the specified Contract Completion Date, the Contractor shall supplement the Progress Schedule submission by indicating the Labor and Equipment resources assigned to every task activity in the schedule. For an Early Completion Progress Schedule, the Detailed Reviewer shall refer to Section I of the Progress schedule specifications for all types of Projects for the Contractor’s additional submittal requirements. If the Contract submits a Baseline Progress Schedule that indicates anticipated late completion date(s), the EIC should be notified immediately by the Detailed Reviewer, and the Contractor shall be requested to re-submit a Baseline Progress Schedule showing completion of the project by the Contract Completion Dates;

- The Detailed Reviewer should note any Milestone Dates as listed in the Contract Documents. Examples of these would include: Interim Milestone Dates with Liquidated Damages and Special Time-Related Contract Provisions (i.e. A+B Bidding, Incentive/Disincentive provisions, Lane Rental);
- The Detailed Reviewer should verify the phasing and staging dates and required phasing and staging durations for the Project; and
- The Detailed Reviewer should verify the NYSDOT-required Constraints as noted in the Contract Documents, the Progress schedule specifications, or the NYSDOT CPM Scheduling Procedures Manual.

- The Detailed Reviewer should verify all of the Baseline Schedule calendar information and verify that the Calendars are in conformance with the Calendars listed in Section 4.2.4 of this Manual.
- The Detailed Reviewer should verify that activity durations in the Baseline Schedule are in conformance with the Contract Documents, the schedule specifications, and Chapter xx of this Manual.
- The Detailed Reviewer should verify that activity relationships in the Baseline Schedule are in conformance with the Contract Documents, the schedule specifications, and this Schedule Manual.  
  - Ensure that all activities have a successor and predecessor, with the exception of first and last activities in the schedule.
  - Ensure the Baseline adheres to any lag requirements listed in Chapter xx of this Manual.
- The Detailed Reviewer should verify that the only activity constraints in the Baseline Schedule are on the Contact Contract Date or other intermediate Contract milestone dates. As listed in the schedule specification, the Contractor shall not use constraints on activities, with the exception of contractual dates, unless otherwise approved by the EIC. The Detailed Reviewer should list all additional activity constraints in the review document and recommend the Contractor remove them or request the EIC approve their use.
- The Detailed Reviewer should review the Baseline Schedule resource loading if required by the schedule specifications or Contract Documents. Typically, this will be required for Type 2B and 2C schedules, but may be requested by the EIC for Type 2 schedules for special resources, as well as any Early Completion Schedules. The Detailed Reviewer should review the resources for reasonableness and review the resources with the EIC.
- The Detailed Reviewer should ensure all NYSDOT-required activities listed in the Contract Documents and in Table 3 of this Manual are included in the Baseline Schedule.
- The Detailed Reviewer should review the Contractor submittals and NYSDOT submittal review and approval activities in the Baseline Schedule. Ensure all submittal, review, and approval activities are appropriately coded, have the correct original durations, and are assigned the correct calendars in accordance with the Contract Documents.
- The Detailed Reviewer should verify any NYSDOT deliverables, such as NYSDOT signage or other materials that may be supplied by NYSDOT.
- The Detailed Reviewer should verify all non-workdays in Baseline Schedule calendars that are above and beyond the non-working days listed in the Contract Documents, as well as, any planned
suspensions. (An example of this would be for the Detailed Reviewer to verify any projected Contractor winter shutdown periods established in the Progress Schedule.) The Detailed Reviewer should ensure that all NYSDOT submittal review/approval activities have the proper calendar assignments.

- The Detailed Reviewer should verify the Baseline Schedule Critical Path is reasonable and is the same as the Critical Path listed in the Contractor’s Narrative.
- The Detailed Reviewer should verify the Baseline Schedule’s near-critical paths and ensure they are reasonable.
- The Detailed Reviewer should review Activity Codes and ensure the codes are in conformance with the Codes listed in Chapter xx of this Manual.

5.4.2.2 Detailed Review of Schedule Updates

This section of the Manual identifies the additional steps above and beyond the steps listed in the above section, “Detailed Review of Baseline Schedules,” that are required for the review of Schedule Updates, Recovery Schedules, As-Built Schedules, and Early Completion Schedules. Should an update be rejected, the EIC will require that the Contractor re-submit the schedule update. This procedure is intended to be used in conjunction with the Detailed Review Templates in Appendix C of this Manual. A more thorough, detailed process of reviewing Schedule Updates is available in the manual for the “NYSDOT Intermediate Schedule Review Course: Reviewing Schedule Submissions.”

- The Detailed Reviewer should request the schedule Meeting Minutes and previous schedule review comments from the EIC to ensure the Contractor has addressed all comments and required revisions to the previous schedule update noted in the last schedule review.
- The Detailed Reviewer should verify any changes to the Stage/Phase durations and Contract milestone dates from the previous schedule update. The Detailed Reviewer should verify any improvements or delays between schedule updates in the Detailed Review Report.
- The Detailed Reviewer should perform a schedule update comparison using the schedule comparison tool in P6 (Claim Digger) or any other applicable, comparable software. It is recommended that the Detailed Reviewer compare the schedule update comparison with the changes noted in the Narrative or a Claim Digger report provided by the Contractor.

At a minimum, the Detailed Reviewer should review the schedule comparison report and verify any of the following changes in the Detailed Review Report that Detailed Reviewers are to provide to the EIC:

- Deleted and added activities: the Detailed Reviewer should ensure that these activities have been identified in the Contractor’s Narrative.
- Calendar changes: the Detailed Reviewer should ensure that all activities have the correct calendars.
- Constraint changes: the Detailed Reviewer should ensure that no constraints have changed unless requested by the EIC.
- Resource changes: typically, this will be required for Type 2B and 2C schedules, but may be requested by the EIC for Type 2 Progress Schedules for special resources.
- Deleted and added logic relationships: the Detailed Reviewer should ensure that these relationship changes have been identified in the Contractor’s Narrative.
- Original Durations: the Detailed Reviewer should ensure that no Original Durations, other than for Level of Effort of Summary Activities have not been changed.
- The Detailed Reviewer should review the Schedule Narrative to ensure that it is accurate and verify any discrepancies.
The Detailed Reviewer shall identify and measure the delays to the Critical Path using Contemporaneous Period Analysis between the most recent schedule submission and the previous schedule submission using the procedures noted in Chapter xx of this Manual. Report any delays to the EIC in the Detailed Review Report.

- Provide a discussion of the CPM Progress Schedule’s Critical Path:
  - Report any changes to the Critical Path of the project.
  - It is common for the Critical Path of the Project to shift several times during the construction process. All Critical Path shifts should be reported and described in the Detailed Review Report.

- For a Project that is behind schedule, as specified in Section xx of the schedule specification, a Recovery Schedule must be submitted showing what actions or activities are required to complete the project by the Contract Completion Date.

- If the Contractor submits a Time Impact Analysis (TIA), the Detailed Reviewer should perform a review of the Contractor’s TIA and fragnets using the procedures listed in Chapter 7 of this Manual.

In addition to the review requirements listed above, at the completion of the project, as specified in schedule specifications, an As-Built Schedule must be submitted showing all Actual Start and Actual Finish Dates for the final schedule submission. The Detailed Reviewer should review the As-Built Schedule for completeness and note irregularities in the Progress Schedules.

5.4.2.3 Detailed Review of Early Completion Schedules

The Contractor may show a projected early completion date on any progress schedule submission provided that all of the requirements of the Contract Documents are met. Some of the ways that a Contractor can accelerate a Progress Schedule or recover lost time could be by:

- Incorporating a longer work week (6 Day/8 Hr Workweek instead of 5 Day/8 Hr Workweek);
- Adding shifts, increasing the number of crews, reallocating resources to be more efficient; or
- Adopting aggressive construction methods, such as stacking crews, or
- By implementing developing innovative construction processes.

The schedule specifications note that if a Contractor submits an anticipated early completion date that is less than 90% of the specified Contract Completion Date, the Contractor shall supplement the Progress Schedule submission by indicating the Labor and Equipment resources assigned to every activity in the schedule. For Early Completion Progress Schedules, it is important for the Detailed Reviewer to ensure that the Contractor uses resource leveling when scheduling the project to support an Early Completion Date, and include time-scaled resource histograms with the Progress Schedule submission. The resource allocations must be shown to a level of detail that facilitates report generation based on labor crafts and equipment classes for the Contractor’s and subcontractors’ work. The Detailed Reviewer must review the Early Completion Progress Schedule to ensure that the logic is correct and that the durations are reasonable for the resources that the Contractor is presenting. The Department should require the Contractor to explain the resources loaded into the Early Completion Progress Schedule, and perform productivity calculations to check the plan. If an Early Completion Progress Schedule is accepted by the Department, the work on the Project must be closely monitored and any deviations from the Contractor’s plan should be noted as they occur.

5.4.3 Detailed Review Report / Templates

The Detailed Reviewer should prepare a Detailed Review Report that reports the results of his or her schedule submission review. At the conclusion of the Detailed Review Report, the Detailed Reviewer should recommend that Progress Schedule be “Accepted,” “Accepted as Noted,” or “Rejected” to the project EIC. It is recommended that the Detailed Reviewers contact Contractors
directly to discuss the schedule submissions prior to the review and to discuss the Detailed Review Report after the review is complete.

A Detailed Review report shall present schedule information in a readable format to allow NYSDOT to communicate with the Contractor. The audience for the Detailed Review report is the EIC, with the intention to use this report as a communication tool with the Contractor in progress meetings. Use best judgment to make the report as useful as possible to the EIC or Project Manager.

The Detailed Review report will provide a recommendation to accept or reject the schedule. The Detailed Reviewer should consult with the EIC prior to issuing the final report so that the EIC and Detailed Reviewer are in agreement if / why the schedule should be accepted or rejected.

The Detailed Review templates (Appendix C) represent a guide for the most relevant content to be presented in a detailed schedule review. Sections, tables and figures can be customized where necessary for each project to best report on the project progress and schedule.

It is always helpful to show screen shots of activities that show how referenced project work / events / impacts / issues / delays are modeling in the schedule.

Table 9 below outlines the sections in the groups of templates (each group has one Baseline and one Update template), and how the sections vary among different types of contracts – those without intermediate contract milestones or durations, and those with intermediate contract milestones or durations.
### Table 9 Detailed Review Template Sections

<table>
<thead>
<tr>
<th>Report Section</th>
<th>Group A</th>
<th>Group B</th>
<th>Group C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Baseline - No I/D or LD Milestones or Durations</td>
<td>Update - No I/D or LD Milestones or Durations</td>
<td>Baseline - I/D or LD Milestone Dates</td>
</tr>
<tr>
<td>Progress Schedule Details</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Update Summary and Recommendation</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Status of Major Milestones</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Issues / Delays</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Critical (Longest) Path</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Near-Critical Paths</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Summary of Contract Completion Movement</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Status of Other Major Milestones</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Status of Individual Bridges / I/D / LD Periods</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Schedule Revisions</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Comment Resolution</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Additional Review Comments and Recommendations</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Activity Status</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Exhibits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Additional Sections – Add as necessary to report on custom ongoing situations on each project**

<table>
<thead>
<tr>
<th>Mitigation Options</th>
<th>As Necessary</th>
<th>As Necessary</th>
<th>As Necessary</th>
<th>As Necessary</th>
<th>As Necessary</th>
<th>As Necessary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Changes</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
</tr>
<tr>
<td>Change Orders / Adjustments</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
</tr>
<tr>
<td>Major Delay Impacts</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
</tr>
<tr>
<td>Major Comments that need to be Addressed</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
</tr>
<tr>
<td>What-If Scenarios or Comments</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
<td>As Necessary</td>
</tr>
</tbody>
</table>
6. GUIDANCE FOR USING TOOLS AND FEATURES WITHIN THE P6 SOFTWARE APPLICATION

6.1 Project Layouts to View Available Projects in the Database

This section contains instructions on how to open layouts at the Projects level, with the primary goal of presenting all available projects in a clear, logical manner. There are two types of layouts available for users in P6; Global and User. Global Layouts are available for anyone on the NYSDOT system to use, while User Layouts are available only to the specific user who created the Layout.

6.1.1 Opening A Project Layout

When logged in to P6 and are in the Projects tab, navigate to the Layout dropdown menu and go to Layout → Open.

If you have edit rights to the layout that you are currently working with, you will be asked if you would like to save the changes that layout.

If you do not want to save the changes, click the No button.

The menu of layouts will open. Click once to highlight the layout you wish to open and click the Open button.

⚠ Advisory: Global Layouts are available to all users in P6. These cannot be modified unless the user has certain administrative rights.
Note that the layout you’ve chosen is now open and is reflected on the layout bar at the top of the project ribbon.

6.1.2 Use of Layouts to View Available Projects

⚠ Advisory: As contractors, reviewers and admin become involved in multiple projects, the need to organize and present these multiple projects in a comprehensible way becomes essential. While there are Global Layouts in both the CPM and EPPM environments that will easily group and sort available projects, sometimes it is necessary to create individual, user layouts to configure the information appropriately.

To create a layout which will show all projects currently available to the user, ensure that the Projects view is selected by going to Enterprise → Projects.

Click on the Group and Sort by dropdown icon and select Customize.
The **Group and Sort** menu will open.

In the **Group By** section, select the first box and scroll to **EPS** and select.

In the **To Level** section, select the option to group by **All** levels.

There are also options to adjust **Group Interval**, **Page Breaks** and **Font & Color**, which will adjust the font, color and size of the EPS bands in the Project View.

⚠️ **Advisory:** When making changes, clicking the **Apply** icon will apply the current changes to the layout currently opened, allowing for the user to see the changes made in real time without having to close and re-open the Group and Sort menu.

Under the **Group By Options**, check the box for **Hide if empty**. This will hide any EPS node that has no information associated with it, reducing the amount of irrelevant information produced on the layout.
Once these basic options and configurations are made, click **OK** to apply changes and close the window.

The layout is now grouped and sorted by EPS node and is configured to show only the projects assigned to the current user based on their account’s access rights in the system.

Next, click on the **Columns** icon at the top and select **Customize**.

This will allow the user to modify which columns will be visible in the layout, ensuring that only the pertinent, relevant information is portrayed.

The left side (**Available Options**) of the Columns menu contains all columns that are available to add to the layout.
The right side (Selected Options) contains a list of columns currently enabled that are visible on the layout.

⚠ **Advisory:** The Available Options are grouped by category. For example, any column pertaining to dates will appear under the **Dates** drop down.

If a column cannot be located, the user can toggle to a list view by clicking on **Available Options → Group and Sort By → List**. Doing so will present the columns in a list format that is arranged alphabetically.

The user can then add or remove columns that will appear in the layout by either adding or removing them from the **Selected Options** column.
Columns can be moved back and forth between the Available and Selected Options sides by double clicking on the line item, or by highlighting a field and clicking on the single directional arrow in the center of the menu.

⚠ Advisory: Clicking on the icons with double arrows will move all columns from one side or the other, clearing the respective section of all selections.

Once the desired columns have been moved to the Selected Options, click OK to apply and close the window.

The current view will now only show projects available to the current user and contains columns identified by the user as being relevant / important.

To save the current layout, click on the Layout bar at the top of the screen and go to Layout → Save As.
6.2 Project Filters

The intent of this section is to instruct P6 users on how to create, modify and utilize filters in the P6 client in order to divide and categorize content in the Projects Tab of P6. When users have access to a significant amount of projects in P6, it can become necessary to filter on specific content. Creating and utilizing filters at the Project level is a means to remove from view any content that is not needed for immediate viewing.

6.2.1 Creating a Project Filter

Open the Projects Tab by clicking on Enterprise at the top of the menu bar, followed by Projects.

Click on the Filter icon along the top ribbon and click Customize to open the Filter menu to create a new filter or modify an existing filter.

The Filters menu will open. Click on New to create a new project level filter.
This opens the Filter creation window. Here there are several modifications the user can make to custom tailor a filter to suit their needs. In the following example, a filter will be created to show only the projects in Region 3 (Syracuse) and will filter out all other projects in the system.

- **Filter Name**: Title the filter in a way that is clear and understandable as to what is being filtered.
- **Parameter**: Multiple parameters can be adjusted in the filter. If the filter is going to have multiple criteria, the user can set whether projects must fulfill “All of the following” or “Any of the following” criteria.
Additionally, the user may select the exact parameter to be filtered on, using the dropdown menu. Select the desired parameter(s). In this instance, Region will be selected, as we intend to filter on a specific Region’s projects.

<table>
<thead>
<tr>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>is</td>
</tr>
<tr>
<td>is under</td>
</tr>
<tr>
<td>equals</td>
</tr>
<tr>
<td>is not equal to</td>
</tr>
<tr>
<td>is under</td>
</tr>
</tbody>
</table>

Figure 124: Select a Condition

Is: This option allows for the user to distinguish what the desired result will be. For example, we are interested in only seeing the projects in Region 3, so we need to create a filter where Region equals R3.

- **Value**: Selecting value will open a window where the user must select what code value is to be the basis of the filter. As previously stated, the example filter is intended to filter on Region 3 projects, so the R3 code will need to be selected.

- **High Value**: This is relevant when creating a filter where the parameters span a specific range, i.e. creating a filter that would show only projects that have Contract Completion dates in 2017. In that instance, the Value would equal the low value, or 1/1/17, while the High Value would be 12/31/17, the highest denomination in the range to be considered in the filter.
Advisory: When creating a range-based filter using specific dates, users can select the option for **Custom Dates** (Figure 126). If no custom date is desired, there are several pre-determined dates that can be selected based on project-specific information, e.g., a project’s **DD – Earliest Data Date**.

With the criteria of the filter established, click **OK** to create and save the filter.

![Figure 127: Click OK to Save the Filter](image)

The newly created filter appears in the User Defined section of the Filters menu and by default is checked and applied to the current layout.

![Figure 128: Newly Defined Filter Listing](image)

Click **OK** to exit the Filters menu. The current view is now reflective of the newly created filter. In this case, only Region 3 projects will appear.

![Figure 129: Example Result of a Project Filter Setting](image)

### 6.3 Activity Layouts to View the Schedule

This job instruction provides instructions on how to open, edit, save and share activity layouts in Primavera P6. Note that project layouts are accessed from the Projects View, but otherwise the steps for opening, editing, saving and sharing project layouts are the same.

There are two types of layouts available for users in P6; Global and User. Global Layouts are available for anyone on the State system to utilize, whereas as User Layouts are available only to the specific user who created the Layout.

#### 6.3.1 Opening an Activity Layout

Open a project in the Activity View and click on the Layout Bar
Navigate to Layout → Open

If you have edit rights to the layout that you are currently working with, you will be asked if you would like to save the changes that layout. If you do not want to save the changes, click the No button.

The menu of layouts will open.
Click once to highlight the layout you wish to open and click the Open button. Note that the layout you’ve chosen is now reflected on the layout bar.

6.3.2 Saving a Layout

Click on the layout bar
Choose the Save As option:

Give the Layout a name that you’ll recognize, leave the default of “Available to Current User” and click the Save button:

Note that the layout you’ve just saved is now reflected on the layout bar:
Click on the Layout bar again, choose to Open:

Scroll to the bottom of the Layout window; note that the layout that you just created is stored beneath a grouping band which reflects your login name:

6.4 Activity Filters
The intent of this section is to instruct all P6 users on how to create, modify and utilize filters in the P6 client to divide and categorize content in the schedule. P6 schedules, especially those with a large number of activities, can appear daunting. Utilizing filters can help users pinpoint and outline specific sections of the schedule. Users can filter on almost anything in the schedule, including but not limited to WBS elements, Activity Names & IDs, Start and Finish dates, Activity Codes and Calendars.
6.4.1 Creating Filters in the P6 Client

Open a project in the activity view and click the Filter icon from either the toolbar or the layout menu.

Click on the New button.

Give the new filter a Name.

Click once on the Parameter field.
Use the scroll bar at the right of the Parameter window to scroll through the list of data items/columns that can be used in filters.

Click once to select the data item that you wish to filter by (WBS in this example).

Click the Is Under field once, choose the appropriate operator for the filter you are building.

**Notes About Filter Operators:**

- **Is Not Equal To:** will display any records not equal to the value you enter
- **Equals:** will display only records which have the value you enter
- **Is Under:** will display any children of the hierarchical code value you enter
Click once on the Value field.

![Figure 148: Click on the Value Field](image1)

Use the scroll bar at the right of the Value window to scroll through the list of values which can be used in filters, highlight the appropriate value then click the green plus button on the right side of the dialog window.

![Figure 149: Select the Appropriate Value](image2)

Click OK to finish creating your filter.

![Figure 150: Click OK](image3)

Note that your new filter has now been saved in the User Defined section and selected, click the OK button to exit the Filters dialog window.
6.4.2 Utilizing Filters in the P6 Client

Open the Filters menu by clicking on the Filter icon on the toolbar.

Select the filter that you wish to apply to the current layout and check it in the Select box.
Click OK to apply the filter to the schedule.

**Advisory:** The All Activities box in the top right will have a check mark in it if no filters are currently applied to the schedule. Once a filter is selected from this menu, the check mark will disappear, indicating that one or more filters are being utilized in the schedule.

**Advisory:** The Show activities that match fields indicate the following:
- **All selected filters:** Selecting this option will filter on only activities that fulfill ALL of the requirements of every filter(s) currently applied.
- **Any selected filter:** Selecting this option will filter on activities that meet the criteria of any requirement of a currently selected filter(s).

Only tasks that meet specified criteria in the filter are now displayed in the schedule.

### 6.5 Making Global Changes

The Global Change Tool in P6 allows for users to make global, schedule-wide changes in the project with a one-time action on the part of the user. This is particularly useful for users working with very large schedules, as changing line items one-by-one can be tedious and time consuming.

In this chapter, the user will be guided through the steps required to make a global change to add multiple missing activity codes for Contractor-responsible activities. The schedule contains several Contractor activities that have not been identified as such using the Responsible Party activity code. By implementing a Global Change, this code value will be assigned to all activities at once.
To access the Global Change Tool, go to Tools and click on Global Change.

The Global Change menu will open. If Global Changes have been created in the past, they will appear in the chart, along with who the change has been made available to and the user that created the change. Global Changes can be made available to all users on the network, only the user who created the change, or they can be issued to another individual user on the network.
Click on New to initiate the creation of a new global change.

The Modify Global Change Menu will open. Global Changes can be made to activities, resources and expenses that are in the schedule. The user must select which of these categories the change is to apply toward by selecting it under the Select Subject Area.

For this example, we will be applying a global change to the activities in the schedule. The Global Change can be renamed in the top right.

It is recommended that the name contain a short description of both the intention and result of the change. In this instance, we are applying a global change that is identifying calendar assignments in the schedule, focusing on activities that are assigned to the Contractor’s calendar. The expected result is that all of these activities will be changed and coded as a Prime Contractor-related activity;
hence the name “Where Cal = Con, Resp Party = C.PCON”, which represents “Where the Calendar equals a Contractor calendar, the Responsible Party activity code will be changed to the Prime Contractor code value”.

The intent of the next three groupings of fields represent an “If, Then, Else” statement, with the top portion being the “If” and the bottom represent the “Then”. In the top (If) grouping, we are setting the target parameters, or what the global change will be searching for initially. In this instance, we want the change to first identify activities that are assigned to our Contractor’s calendar “D269997 – Contractor’s 5-Day / 8-Hour w/ Holidays”.

The structure of this statement is arranged in such a way that the change will be looking for instances “Where” if the “Calendar” “equals” “D269997 – Contractor’s 5-Day / 8-Hour w/ Holidays”. This was created by selecting the relevant options in each dropdown menu’s selection options.

The second grouping of editable fields pertains to the “Then” portion of the statement, or what the users intended actions will result in.

For this example, the intention is to have activities assigned to the Contractor’s calendar have their RESPONSIBLE PARTY activity code changed to the code value for the Prime Contractor (C.PCON). As such, this statement will read as “then” “RESPONSIBLE PARTY” “equals” “C.PCON”.

The third editable grouping of fields pertains to the “Else” statement. Else statements specify the changes to make to project data when the If conditions are not met. In order to define an Else statement, there must be at least one If statement. While the Else statement is not essential in the creating a successful global change, it can prove useful if there is a change that needs to be made that does not meet the requirements of the If Statement.

In this case if the If statement is not met, meaning that the Calendar is not a Contractor calendar and is instead a State calendar, the Responsible Party code value will be changed to represent the NYSDOT (G.DOT), indicating the activity is a State-responsible activity. This statement will read as “Else” “RESPONSIBLE PARTY” “equals” “G.DOT”.
Advisory: The Operator field is used for mathematical equations to change numeric data such as quantities, costs and durations. These arithmetic functions can be used to calculate new values. Click the Operator column to list the various operator symbols (+, -, /, *). Arithmetic operators can link two data items, a data item and a number, or two numbers. Operators are only available in the Then and Else statements to calculate new values and are not used in If statements.

With the Global Change configured properly, click OK to exit to the previous screen.

Figure 162: Click OK

The newly created Global Change will appear in the list of available changes. By default the change will only be made available to the user who created it; however, this can be changed and shared with other users.

Figure 163: User Defined Global Change

With the Global Change selected, click on Apply Change.

Advisory: The user may receive a warning message indicating that the change contains parameters that cannot be canceled. Click Yes to proceed or No to ensure the Global Change is configured properly.

Figure 164: Global Change Warning

The Global Change Report will be generated. This log outlines the Global Change that will be applied, the project that the change is going to be made in, the date the change is being made and a list of activities affected by the change.

As shown in the example log in Figure 165, the user can see the changes that will be made by comparing the Old Value against the proposed New Value. The log has identified that there are
activities in this schedule that are assigned to a Contractor calendar that do not have the Responsible Party code value assigned to them and has stated what the new code value will be once the change has been applied (shown in the read box below).

![Global Change Report](image)

Figure 165:

In the bottom right corner of the report, the user can select whether or not they wish to **Save** the report to a file, **Cancel** the proposed changes or **Commit Changes**. Click **Commit Changes** to apply the Global Change to the schedule. P6 will prompt the user if they wish to save the report to a file. If yes, select **Yes**.

⚠ **Advisory:** If users are making sizeable changes it is strongly encouraged that the Global Change Report be saved to a file to reference in the future if necessary.
The Global Change will proceed and run through the schedule, making all of the changes outlined in the report. As shown below, the Contractor responsible activities that were missing the appropriate code values have now been changed successfully.

6.6 Scheduling a Project

This section provides instructions on how to calculate a schedule in the P6 Client. The act of “scheduling” the project consists of moving the project’s Data Date forward in time to an updated, current date. Users will then input new Actual Dates to account for past progress and the software will calculate the remaining schedule based on current schedule logic and activity durations.

⚠️ Advisory: It is important to always remember to schedule, or “F9”, the project prior to submitting the schedule for State review. Ensuring the project is current and up-to-date with a recent Data Date makes for a schedule that is very useful for forecasting upcoming work.

6.6.1 Calculating a Schedule in the P6 Client

From the P6 Client project view, find and open the project to be scheduled. (To open the project, select and right click.)

⚠️ Advisory: In order to ensure that durations are calculated properly, the User should enable the time settings when adjusting the Data Date to ensure the project is being scheduled to the end of the work day. In this example, the end of the work day is 5:00 PM.
From the main ribbon bar select Edit User Preferences. Click on the “Dates” tab and select the option to display the Time as “12 hour (1:30 PM)” and “Show minutes”. Click on “Close”.

To access the scheduling dialog box, either select the schedule icon from the icon ribbon bar at the top of P6 or press the shortcut F9 button. The “Schedule” dialog box will appear.

In the “Schedule” dialog box click the “Options” button.

In the “Schedule Options” window, “General” tab, ensure that the configurations match those in Figure 169.
Once the options have been selected and are correct, click “Close.”

To schedule the project, the “Data Date” needs to be adjusted. The data date is the date the project will be progressed through or the date that the update information is as of.

**Advisory:** Regarding Data Dates; for a Baseline Schedule, the Data Date shall be the Award Date of the project. For monthly updates, the Data Date shall be a date agreed upon by the Engineer-in-Charge (EIC) and the Contractor. Typically this is the 1st or 15th day of the month.

Once the correct data date and time are entered in the “Current Data Date” field, click the “Schedule” button to schedule the project.

Once the project has been scheduled, the Data Date line, represented as a vertical blue bar, will advance along the Gantt chart to the date assigned as the Current Data Date. Activities to the left (in the past) of the data date will reflect actual performance and activities to the right (in the future) of the data date will reflect the forecast estimate.
Claim Digger is a function of P6 that allows the user to compare projects to one another. In the NYSDOT System, Claim Digger is primarily used to compare a current schedule against a baseline schedule, whether it is the Approved Project Baseline or a previous update submission. Once configured, Claim Digger will generate a report containing several sections, where changes made, but not limited to, the following items will be made visible:

- Durations
- Logic
- WBS
- Added / Deleted Activities
- Float Values
- Activity Criticality
- Activity Constraints
- WBS Elements
- Resource Assignments

### 6.7.1 Running Claim Digger
To launch Claim Digger, select Tools>Claim Digger.
Claim Digger will start and present the following menu.

By clicking on the ellipsis in the **Select original project or baseline**, the user will be able to choose which of the assigned baseline schedules to use to compare against the currently opened project.

Choose the desired project to use as a comparison by selecting the **Baselines** option and click **OK**
The **Select original project or baseline** field will now be populated with the project selected in the previous step. Click on **Compare** to run the Claim Digger application.

The user can choose to have the file exported as an HTML File or CSV File. While the CSV file is easier to manipulate in an Excel environment, the HTML file exports in a cleaner, better organized layout.
The application will open up the **Project Differences Report** in the users default internet browser. This report will identify any discrepancies between the opened project and the project identified as the original for comparison.

⚠️ **Advisory:** Claim Digger analyzes durations in the form of hours. In the example below, “Pour/Strip Sidewalks N. Side” does not have a New Original Duration of 32.0 days. Since this activity is assigned to a calendar with 8-hour work days, the New Original Duration for this activity is actually 4.0 days (32-hours / 8-hours per day).

The final section of the report will highlight sections where no changes have occurred.

### 6.8 Assigning & Maintaining Baselines

The intent of this chapter is to instruct users on how to maintain and assign baseline schedules in the P6 Client. While working in the State’s system, Users will find it necessary to compare a previous schedule submission to a current schedule. For the example shown in this scenario, the Contractor is comparing their Monthly Update #4 to the Project’s Approved Final Baseline.

⚠️ **Advisory:** For security reasons, to avoid Contractor’s accidentally deleting archived, read-only schedule submissions in the state’s work area, maintaining the Baseline must be performed by an Admin upon the request of the Contractor.

#### 6.8.1 Maintaining a Baseline Schedule

Identify which file is the current working file in the **Contractor’s Work Area** node. This is the file that the Contractor’s Project Scheduler will copy from to create each month’s progress update. Typically, this working file will be the most recent schedule update created by the Contractor, or the Project ID that ends with “CON”. **Always confirm which file is the working file prior to creating and assigning a Baseline Schedule in the Contractor's Work Area.**

For this example, the Contractor’s current working file is D262361-1SU4.
The Final As Planned At Award Baseline Schedule (D26####-1FB-#) will be assigned as the Project Baseline to the Contractor’s working file.

In the Final As Planned At Award Baseline Schedule node, right-click on the accepted Baseline schedule (D262361-1FB-3) and select Copy.

Right-click on the Contractor's Work Area node, and select Paste
After selecting **Paste**, when the **Copy Project Options** window pops up, all boxes underneath **Optionally Include** should be checked except for **Baselines**, then select **OK**.

In each of the following windows for **Copy WBS Options** and **Copy Activity Options**, all boxes under **Optionally Include** should be checked, then select **OK**.
A copy of the Baseline schedule will be created in the Contractor’s Work Area (D262361-1FB-4).

For the schedule that was just created in the Contractor’s Work Area, change the Project Name of the created project to include the Project ID and the words “PROJECT BASELINE”. The Project Name is changed to “D26####-1FB-PROJECT BASELINE”. The Project Baseline file is now created in the Contractor’s Work Area.

In the Contractor’s Work Area, click on the Contractor’s working schedule identified in Step 1, right click and select Open Project.

Click Project, and then select Maintain Baselines.
Select +Add.

Select “Convert another project to a new baseline of the current project”, and then select OK.

Locate the Baseline project created in Part I, D26#####-1FB-PROJECT_BASELINE, single left-click on this Project, and then select the green plus symbol to assign the project as a Baseline.

The file D26#####-1FB-PROJECT_BASELINE is now embedded within the working file and is maintained and listed as a Baseline to this project. Select Close.
6.8.2 Assigning a Baseline to a Schedule

Click Project, and then select Assign Baselines.

Underneath Project Baseline, click the dropdown arrow, and select the Baseline that was brought into this project, D26####-1FB-PROJECT BASELINE, and select OK.
The accepted Project Baseline is now embedded and assigned as the Project Baseline to the Contractor’s working schedule.

6.9 Project Calendars
In accordance with the Section 639 Scheduling Specification, Contractors are required to assign all Contractor-responsible activities to Project Calendars. Template schedules provided to Contractors include a default, standard 5-day, 8-hour Project Calendar that includes all NYSDOT holidays. This calendar is included and intended to be assigned to all Contractor activities that will be worked on a standard 40 hour work week and are not affected by seasonal, permit or other restrictions.

⚠️ Advisory: The only Contractor activities permitted to be assigned to Global Calendars are Milestones, Level of Effort bars or activities pertaining to concrete curing.

6.9.1 Creating and Modifying Project Calendars
In many cases, Contractors will need to create additional calendars in the schedule to account for different types of work on the project. Depending on the scope of work, Contractors will need to create calendars that include periods of non-working time to account for winter shutdowns, periods of non-work that are imposed by permitting restrictions, as well as standard NYSDOT holidays. The following instruction is intended to demonstrate how a user will create a Project Calendar with seasonal restrictions that can be assigned to asphalt activities that cannot be performed in winter months.

Access the Calendars by clicking Enterprise > Calendars.

In the Calendars window, click the button for Project. Click Add+. A window will pop up asking to Select Calendar to Copy From, which provides choices of Global Calendars. Use the calendar State Business Days, 5 Day Work Week w/State Holidays, Field. This will ensure that your new calendar has a base template that already includes all NYSDOT holidays. Click the green (+) icon.

The default name for the new calendar will be New Calendar. Rename this new calendar with the D# and a short description, e.g., D269997 – Asphalt Paving.
Highlighted on this new calendar, in the **Calendars** window, click **Modify**, which will open up a window to modify work and non-work days. The calendar will open to the calendar view shown here.

Scroll through the months to restricted periods for this specific calendar and mark restricted days as non-work days. Multiple days can be selected at once by clicking the weekday header (Mon, Tue, Wed, etc.) and the click Nonwork. This will “gray out” these days as non-work days.

The non-work periods should be detailed in the Contractor’s Narrative.
Additionally, dispensation may be approved on a project, in which case the Contractor will need to create calendars with workweeks that are different than the standard 5-day, 8-hour norm. In these cases, additional modifications are required to ensure that the scheduled is calculated and presented properly. Examples include 6-day schedules, weekend schedules and/or 10-hour days. To modify the standard work days within a work week, after clicking Modify, click the button for **Detailed work hours/day**, and click **Workweek**.

![Figure 198: Modifying Work Hours](image)

Under **Day of the Week**, click on the day to change the Work / Nonwork times. Modify the hours within that day to represent the planned work hours. In the example below, Saturday is modified to work 8 hours, similar to Monday through Friday. Click the **Work** button to make Saturday a standard work day for this calendar. Click **OK** to exit this window.

![Figure 199: Selecting the Days for Modified Work Hours](image)

Click **Time Periods** to open the **Hours per Time Period** window. Modify the **Hours/Day** and **Hours/Week** to represent any changes made above. In Figure 200, **Hours/Week** is changed from 40 to 48 to reflect adding Saturday at an 8-hour work day.
If a 5-day, 10-hour calendar was created, **Hours/Day** would be changed to “10” and **Hours/Week** would be changed to “50”.

### 6.9.2 State Observed Holidays

The following days in Figure 201 are recognized as State Holidays. State recognized public holidays are not work days and as such, in all Global Calendars maintained by NYSDOT, all holidays listed below are designated as non-working days.

<table>
<thead>
<tr>
<th>New York State Holidays</th>
<th>January 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Years Day</td>
<td>January 1</td>
</tr>
<tr>
<td>Martin Luther King Day</td>
<td>3rd Monday in January</td>
</tr>
<tr>
<td>President’s Day</td>
<td>3rd Monday in January</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>Last Monday in May</td>
</tr>
<tr>
<td>Independence Day</td>
<td>July 4th</td>
</tr>
<tr>
<td>Labor Day</td>
<td>1st Monday in September</td>
</tr>
<tr>
<td>Columbus Day</td>
<td>2nd Monday in October</td>
</tr>
<tr>
<td>Veteran’s Day</td>
<td>November 11th</td>
</tr>
<tr>
<td>Thanksgiving Day</td>
<td>4th Thursday in November</td>
</tr>
<tr>
<td>Christmas Day</td>
<td>December 25th</td>
</tr>
</tbody>
</table>

If the holiday occurs on a Saturday, it will be observed the Friday before. If the holiday occurs on a Sunday, it will be observed the Monday after.

⚠️ **Advisory:** While State work will not progress on these days, it is understood that Contractors can and do perform work on these days when approved. If Contractors are to work on these days, this information should be communicated in the Schedule Narrative and designated on the Contractor’s calendar.

### 6.9.3 Seasonal Weather

Mark all seasonally restricted days as “Nonwork” days, from the start of the project through one year beyond the Contract Completion Date. This will ensure that if activities slip beyond the Contract Completion Date, seasonal restrictions will still be applied to activities. Once the seasonal calendar is created, return to the Activity view and reassign any activities affected by this restriction to the specific calendar. This will prevent these activities from being scheduled during these non-work times.

It is recommended that weather days should be included in the Contractor’s production rates when populating activity Original Durations and should not be blocked out as sporadic non-work days throughout calendars. Blocking out sporadic non-work days for weather creates multiple issues including but not limited to:
Short-term look-ahead schedules will not allow work to be scheduled on these blocked out days. Activities with Actual Start / Finish dates on these days will not show correct Actual Durations. Sporadic, non-work days do not represent the actual weather days and will result in an inaccurate As-Built schedule.

6.9.4 **Permit Restrictions**

Along with identifying holidays and seasonal shutdowns in calendars as non-working days, restrictions attributed to permit requirements must be designated as non-working days in calendars in the schedule.

Calendars shall give special consideration to sensitive areas such as road closures and parklands and shall indicate any time frames when work is restricted as outlined in permits issued by regulatory agencies.

For example, if a permit indicates that work in streams cannot progress from September through May, the project should have a calendar that has September through May depicted as non-work time. This calendar would then be assigned to any activity that would be affected by these stream restrictions in order to logically prevent those activities from progressing during the non-work period.

6.10 **Saving a Copy of Your Progress Schedule to Your Local Computer**

The intent of this section is to instruct all P6 users on how to export files, print .PDFs or save other files using either the P6 Client or the Citrix-based system.

6.10.1 **Saving & Printing PDFs on the Citrix System**

When exporting files, printing to PDF, or saving other files from the Citrix system, the user should choose the “T” (“temporary”) drive as the location. The T-drive is on the Citrix server and allows for much quicker writing speeds than if the user tries writing directly to their personal computer’s C-drive.

**Advisory:** When writing files to the T-drive, it is strongly recommended to include the contract D# so files can be easily located.

Within P6, select the option to Print and select the PDF writer as the desired printer.

![Figure 202: Selecting a PDF Printer](image)

When asked to **Save As**, click the **Save in** dropdown to change the selection to the T-drive. Click on **Save** to save the file.
Note: When printing PDF schedule files while not on Citrix, the user may select their C:-drive from the Save in dropdown to save the files directly to their local computers.

Within Citrix, the user will have access to the Managed File Transfer utility application shown in Figure 204.

This application allows the user to quickly copy files from the Citrix T:-drive onto their personal computer's C:-drive. Open the File Transfer Application, locate the file in the T:-drive folder location where it has been saved in the previous step and copy/paste within the file transfer window to the personal computer's C:-drive.

6.10.2 Exporting Schedule Files

If the user wants a copy of the schedule file outside of the Citrix P6 system, they have the ability to export any P6 file in various formats from the system. To export, in the Menu bar, click File > Export. The Export Format window will appear.
Using this window, the user will select the appropriate export format: a Primavera compatible XER or XML file, a Microsoft Excel File (XLS) or a format compatible for use with Microsoft Project. The most widely used format is the Primavera PM – (XER).

Depending on the User’s selection, the software version will need to be selected. For example, when exporting as a Primavera PM compatible XER file, the user will have to select the software version of P6 they are exporting to from the dropdown list.

Click on Next to proceed to the Export Type menu.

Here the user can select if they want to export the entire project, resources only, or roles only. For this example, export all Project Data and click on Next.

The Projects to Export window will appear and will identify which open projects are available to export. If only one project is open, it will be the only project that is marked as the project to export. If multiple projects are open, the user will need to identify by clicking in the check boxes to identify which projects are to be exported.
Click **Next** to proceed.

Next, the User will need to re-name the file and designate an export location on the computer. If using P6 on the Citrix system, the user will need to export the file to the T drive and use the File Transfer Application referenced earlier to move the file to their local machine. If working in the Client, any location can be selected as an export location. Click **Finish**.

P6 will proceed with the export and the user will be notified when the process has completed. The file will be saved to the location identified in the previous step.
Advisory: For security purposes, project schedule files cannot be imported into the NYSDOT system.

6.11 Printing Schedules & Schedule Reports
The intent of this section is to instruct all P6 users on how print Schedules and Layouts in P6. The steps to print from either the Projects view or Activity view are the same. The most important element when printing any view from P6 is to ensure that the Page Setup is configured properly to guarantee all of the desired information is formatted correctly and will display appropriately on the printed pages.

6.11.1 Printing Schedules & Adjusting Page Setup
The first step is to ensure the Page Setup is formatted correctly to ensure all desired information is visible on the printed pages. In this example, the intent is to show the full project schedule with the pertinent columns as well as the Gantt chart on each page.

Advisory: Improper configuration of the Page Setup can result in instances where information is missing or presented in such a way that it becomes ineffective when viewing and analyzing. Click on File > Print Preview.

The preview page will open and will show the User exactly how the schedule will print with the currently applied settings.

Along the toolbar at the top left of the screen, select the Page Setup icon.
Advisory: While many of the following settings and adjustments are subjective based on the preferences of each user, several of these common setup adjustments are strongly recommended.

At any time while making these adjustments, the user may click on the Apply button at the right of the Page Setup screen to apply any changes made.

The Print Preview will adjust in real time based on changes made so the user will be able to view their modifications instantly.

The Page Setup window will open. This window contains multiple tabs and each tab has several subsections where adjustments to the page setup can be made.

Under the Page tab, it is important to ensure the Orientation is set to Landscape.
Adjust the options under the Scaling dialog box to ensure that the print area size is set to an acceptable level. In most cases, selecting the “Fit timescale to: 1 page(s) wide” will ensure that the Gantt chart will stretch only to 1 page wide and will not break onto another page.

![Figure 216: Print Scaling](image)

Change the **Paper Size**. If printing a layout or schedule with many columns shown, selecting a paper size of 11x17 as your paper choice is optimal and will provide a better view of all columns.

![Figure 217: Paper Size Selection](image)

Click on the **Options** tab on the **Page Setup** menu. Here, the user can adjust the **Timescale Start and Finish**.

![Figure 218: Options Tab](image)

Timescale Starts and Finishes will vary depending on the type of information the user wishes to portray. For example, if the user wishes to print a critical path layout using a current schedule, the Timescale Start can be configured to read as DD-1M, which equates to the Data Date minus 1 month of time.

![Figure 219: Establishing the Timescale](image)

If the Data Date of the schedule is July 1st, the timescale will start 1 month prior to that date. Additionally, the Timescale Finish could be set to PF+3M, which represents the Project Finish plus 3 months. So if a project was finishing in September, the timescale would finish in January.
To print a full schedule, the suggested Timescale Start is PS-1M (Project Start minus 1 month) and the Timescale Finish is PF+3M (Project Finish plus 3 months).

Lastly, certain print features can be toggled on or off depending on user preferences. The **Activity Table** can be toggled off in order to print just the Gantt Chart. **Columns** and **Grid Lines** can be toggled on or off. The **Gantt Chart** can be toggled off in order to show just the **Activity Table**.

6.11.2 Printing Schedule Reports

Global Layouts 01 through 22 are available to all users. With every High Level Review, the “Schedule Report” is attached, which is comprised of the aforementioned layouts. This report contains layouts for critical path, 30 day look-aheads, slipping activities, scheduled winter work and other various layouts useful to both the NYSDOT project staff and the Contractor to assist with analyzing and interpreting the schedule.

**Advisory:** These Global Layouts have already been appropriately configured to print accurately based on the type of layout and the information portrayed. The user does not need to reconfigure and of the settings referenced earlier in this section.

**Advisory:** Many of these layouts make reference to earlier schedule updates in order to track variances in dates and/or durations. In order to make this comparison, the current schedule file needs a copy of an earlier update inserted and set as a Baseline schedule to the current file.

For security reasons and to avoid the accidental deletion of current or past schedules in the database, the Baseline schedule assignment must be performed by an Administrator.

To open these layouts, go to the Activity View and click **View > Layout > Open Layout**. Select the desired Global Layout and click on **Open**.

![Print Feature Selection](image1)

![Select a Layout](image2)
Click **Print** and select the desired print option (PDF, local printer, etc.) and select **OK** to print.

![Select a Printer](image)

Figure 222: Select a Printer

Repeat this process for each global layout (01 through 20) or only for the layouts desired. If printed to PDF, these file can then be consolidated into one, single PDF workbook for easier viewing and analyzing.

![PDF Workbook](image)

Figure 223: PDF Workbook

### 6.12 Plotting Progress Schedules & Network Activity Diagrams

The Gantt chart can be printed to any size paper, but this section will focus on printing a larger size schedule and Gantt chart to a plotter. Section 6.11 shows how to print directly to a printer, but in some instances, it is beneficial to have a larger print-out of the schedule and Gantt chart, e.g. hanging the Baseline schedule on the wall of the construction office at the start of the job. In these cases, a plotter must be utilized to produce larger outputs.
Also included in this section are steps to print out Activity Network Diagrams. These are useful when reviewing schedules, especially Baselines, since they portray a linear, pictorial view of the logic tying the activities to one another in the schedule and make it simpler to analyze the accuracy of the logic ties.

6.12.1 Plotting Progress Schedules

⚠ **Advisory:** It is recommended that when plotting a schedule, the user first prints the desired schedule and saves the file in .PDF format. For steps on how to print a progress schedule as a .PDF file, please see Section 6.11 of this manual.

⚠ **Advisory:** Depending upon the plotter being used, there may be more print settings / options available for the user to configure. The following chapter outlines how to plot using the most basic settings; however, users are encouraged to experiment with plot settings in order to fine tune the output.

Once the file has been printed & saved as a PDF File, click on **File -> Print** to open the Print menu and select the applicable plotter. In this case, the plotter is the HP800 series device highlighted.

![Figure 224: Plotter Selection](image)

With the plotter selected, click on the **Properties** tab on the right.

![Figure 225: Select the Properties of the Plotter](image)

Under the Properties tab, click on the **Paper/Quality** tab. Here the user may choose the desired plot size under the **Paper Options** category.
Advisory: Paper size: Depending upon your plotter, you may have a standard size of Arch E (36”x48”). This is the largest standard single sheet size available. But you can add a custom sheet size. It is recommended that the maximum width is set to 36.0” (feel free to experiment with this setting and to select a paper size that is most appropriate for the desired use).

Click on the **Finishing** tab.

Under **Orientation**, select **Landscape**.

Advisory: Depending on the print size, you may decide to set this to portrait (feel free to experiment with this setting).

Click **OK** to close the Properties menu and then click **OK** to plot the progress schedule.

6.12.2 Plotting Activity Network Diagrams
Activity Network Diagrams outline the sequence of activities by showing activities as terminal elements along with their associated relationships. Network diagrams are extremely useful when users are interested in analyzing and validating the relationships between activities (represented by the lines with arrows) to ensure they are logically sound.
Individual activities are represented by yellow rectangles (shown below). Each box contains pertinent information related to that activity:

Activity ID
- Activity Name
- Planned Start
- Planned Finish
- Total Float
- Original Duration
- Remaining Duration

To plot an Activity Network Diagram:
With the project open, click the Activity Network icon.

The Activity Network Diagram will open on the right side, while the user is presented with the WBS hierarchy on the left.
Advisory: The user may toggle between the various levels of the WBS structure to alter the contents of the Activity Network. In Figure 232, the top-most level of the WBS is selected and as a result, the Activity Network contains all of the activities in the schedule. Selecting the Level 2 WBS element, PRE-CONSTRUCTION”, will only populate the Activity Network with the activities that are underneath the WBS element for pre-construction.

Select the desired level of WBS detail for your network diagram

Click on File>Print Preview. Once the Print Preview screen opens, click on the Page Setup icon on the top ribbon bar.

Advisory: As noted in earlier sections, modifying the Page Setup while in the Print Preview view allows the user to see the changes that are being made to the printed pages as they are made. When changes are made, click Apply to see how the modifications will affect the plotted pages.
In the Page Setup menu, under the Page tab, ensure the Orientation is set to Landscape, that the Adjust to: setting is set to 100% normal size and that the Paper size is set to the desired plot size. In this case, we are using the standard Arch D size of 24x36.

⚠️ Advisory: Depending on how many activities the user has in their schedule, minor adjustments will need to be made to the Scaling settings in order for the boxes to appear legibly on the plot. Users are encouraged to experiment with these settings to ensure the information is be plotted in a way that is appropriate for the selected project.

With the Page Setup configured, click OK.

Click on the Print icon and select the plotter specific to your network/office as described earlier in this chapter.

Click on the Properties icon and adjust the properties (Paper Size, Orientation, Quality, etc.) as described earlier in this chapter.
Advisory: When adjusting the Paper Size in the plotter properties, ensure that the sizing matches what was selected in the Page Setup menu in P6.

Click **OK** once properties are configured. Click **OK** to plot the network diagram.
7. CONTRACT CHANGES, TIME EXTENSIONS & DELAYS

7.1 Delays and Evaluation of Delays
7.2 Time Impact Analysis
7.3 Change Order Review Process
8. EVALUATION OF TIME-RELATED DELAY DISPUTES
9. INTERNAL SCHEDULING (NON-CONTRACTOR OWNED)

9.1 Creating the Project Schedule
9.1.1 Responsibilities of the Project Manager
9.1.2 Project Delivery Method Codes
9.2 Views
9.2.1 Creating and Customizing Views
9.3 Automated Feeds for P6 PPM & P6 CPM to Eliminate Manual Duplicate Data Entry
9.4 Baselines
9.4.1 Creating a Primary Baseline in P6
9.4.2 Creating an Initial Project Baseline in P6
9.4.3 Saving Historical Project Baselines
9.5 Dashboards, Portfolios, Portfolio Views
9.5.1 Displaying and Customizing Dashboards in P6
9.5.2 Creating and Customizing Portfolio Views
9.5.3 Creating Portfolios and Applying Portfolios to Dashboards
9.6 Reports
9.6.1 Running Reports in P6
9.6.2 Printing a Large Scale Gantt Chart
9.6.3 P6 -BI Publisher Reports- Phase 2 Released (Release 1)
9.6.4 P6 BI Publisher Reports - Phase 2 Released (Release 2)
9.6.5 P6 Reports Data Dictionary
9.7 Primavera P6 - Master Activity Library
9.8 Designer's and Area Construction Supervisors' Preliminary Schedule for Construction
9.8.1 Guidance for Selecting the Appropriate Project Type Based Upon Project Scope & Complexity
9.8.2 General Information
9.8.2.1 Schedule Development for ADP Submission
9.8.2.2 Schedule Development for PS&E Submission
9.8.2.3 Schedule Available at Advertisement
9.8.3 Setting Up the Project Shell
9.8.4 Developing the WBS
9.8.5 Developing Project Calendars
9.8.6 Entering Activities
9.8.7 Important Project Specific Factors
9.8.7.1 Utility Company Work
9.8.7.2 Permit Restrictions
9.8.7.3 Time Related Contract Provisions
9.8.8  Establishing and Amending Contract Completion Date & Other Milestone Dates
9.8.9  Project Specific CPM Special Notes
9.8.10 Designers Schedule Narrative
9.8.11 Estimating Pay Item Cost for CPM Scheduling
9.9  Transition of PM Responsibilities
10. PROGRESS SCHEDULE TEMPLATES

10.1 Design Progress Schedule Templates
10.2 Construction Progress Schedule Templates
10.3 Contractor Procedures for Using CPM Progress Schedule Templates
11. USING PRIMAVERA P6 WEBPM APPLICATION

11.1 Project Portfolios
11.2 Summarizing the Project
12. THE PROGRESS SCHEDULE AS A PROJECT MANAGEMENT TOOL WHILE BUILDING THE PROJECT
Appendix A - CPM Schedule Quick Reference Guide
I. Requirements of a Good Quality Schedule Include:
   • all deliverables to complete the project
   • all procurement activities
   • all submittal review & approval activities
   • all 3rd party activities
   • complies with contract requirements (milestones, constraints, etc)
   • organized in a user friendly format specific to contract (Key Plan)
   • maintained to ensure integrity & reliability of reports & information
   • a narrative that aligns and explains in detail the schedule issues

II. Work Breakdown Structure (WBS):
   • WBS is consistent with Key Plan and encompasses all project work
   • Decomposes deliverables from highest level to lowest activity level, organized, logical
   • Facilitates sorting and filtering to isolate activities & support good reporting

III. Activity Coding:
   • DOT Global Codes defined and assigned appropriately
     o Responsible Party (prime, subs, DOT, 3rd parties) (only 1 resp. party per work activity)
     o Stage (or Phase depending on contract)
     o Area (or specific locations or features of work, within WBS)
     o Time Related Clauses (A+B, I/D, BV – Driver’s 1st, defined constraint, etc.)
     o Type of Work (Brg, Hwy, Conc. Pvt, San, Wat, Drain, Landsc, Exc, Elec, Asph, etc.)
     o Added Work (OOC or scope added work activities)
     o Delay (Inserted alleged delay activities…ex. Utility relocation delay activities)
   • Project Codes
     o “other” (be creative, if it facilitates: sorting, filtering, measuring, reporting, do it)

IV. Activity ID #:
   • DOT mandated activities with IDs are included in schedule
   • Can use simple numeric with skip increment to permit inserted activities when necessary
   • Can use alpha numeric system with intelligent design (BrgA#.San#, ex)

V. Activity Descriptions:
   • Clear and uniquely defined descriptions
   • Verb, Object, Stage, Location/Area (include stationing limits when appropriate)
   • Redundant with Activity Codes to extent necessary

VI. Durations:
   • 15 day maximum duration specification requirement
• Submittal- review/approval durations, other contract mandatory durations- specification requirements
• Durations for common work types are realistic
• Durations for unique work are discussed including resource assumptions
• Understand production rates necessary to support activity duration assignments
• Updates, compare actual durations vs. planned. Adjust future activity durations for integrity
• Updates, are many durations being reduced/increased across work activities, why?

VII. Calendars:
• What calendars are used in the schedule? (Global, Project)
• 40 hour calendar properly assigned to work activities?
• OT calendar properly assigned to work activities?
• State work day calendar assigned to State responsible activities?
• Concur with restricted calendar periods (holidays, weekends, traffic constraints, weather)
• Specialty calendars properly assigned (paving, landscape, excavation, winter concrete, etc)
• Have activity calendar assignments changed with update, why? Impact to Critical Path?

VIII. Constraints/Milestones:
• Use P6 constraint layout to find/report on all schedule constraints with each update
• Constraints affect schedule calculations. Prohibit use unless absolutely beneficial or permitted.
• If permitted ensure modeled into schedule properly. (must finish, on or before finish, etc.)
• Confirm the schedule identifies all contract milestones & completion date accurately.
• Confirm that all contractual work to achieve milestone completion is accurately modeled

IX. Logic/Relationship Type:
• Logic is critical to schedule integrity. Impacts critical & Longest Path
• Baseline logic approval requires detailed review
• Update logic review and approval is critical to integrity, run Claim Digger Report each update
• Confirm all Mandatory logic exists
• Delete Discretionary logic, impacts schedule calculation….won’t prohibit discretionary execution
• Recommend plotting logic diagram by work location to simplify detailed review:
• Horizontal Rev. per location = all missing work, mandatory logic present
• Vertical rev. logic lines across locations = find discretionary & delete
• Does the schedule work flow make sense ?
• Are the relationship types correct (S to S, S to F, F to F, etc)
• Updates that change (+,-) activities should also change logic, concur with changes

X. P6 Schedule/Leveling Report & Claim Digger Report:
• Provide significant information used to evaluate schedule quality and changes
• Understand the Schedule/Leveling report output
  o Schedule/Leveling Settings & Results
  o Data date conforms to update period
  o Statistics
    • # Activities
    • Not Started
    • In Progress
    • Completed
    • # Relationships
    • # Constrained Activities
  o Errors/Warnings
    • # Activities without predecessors
    • # Activities without successors
    • # of out of sequence activities
    • Activities with Actual Date = DD
    • Milestone activities with invalid relationships
    • Finish Milestone & Predecessors have different calendars
  o Exceptions
    • List of Critical Activities
    • Activities not on a Float Path
• Claim Digger Report Output
  o Compares detailed parameters of two schedules
  o Simplifies reviews, identifies schedule changes that should be considered
  o Intuitive report by data item (new activities, deleted activities, duration changes, logic changes, etc.)

XI. Baseline Schedule Acceptance:
• Does the high level overview make sense?
• Does the BL schedule conform to the good practice of items I. thru IX. above?
• Review the Critical Path activities and WBS pass thru..make sense?
• Responsible parties involved in the CP understand their role/deliverable duties and deadlines?
• Do near CP activities or longest paths 2, 3, 4 appear logical?
• One primary flaw of BL schedules is they don’t model 100% of contract work unless comprehensive
• Must find all missing work within each Area/Location prior to BL acceptance
• Print/Distribute Reports to communicate project information to all involved stakeholders.

XII. Monthly Schedule Updates:
• On schedule? Falling behind? CP changes? Near CP changes?
• Print/Distribute Reports to communicate project information to all involved stakeholders.
  o Critical Path Activities
  o Near CP Activities is Float sufficient to plan and execute future work without delay?
  o Activities by Responsible Party (ES/TF and 60 day Look Ahead)
  o Activities by WBS/Stage/Location/Responsible (ES/TF and 60 day Look Ahead)
  o Reports that align with CI staff needs to keep them informed of planned work
  o Actual Durations > Planned Durations (impact on schedule integrity)
  o ES activities not begun that should have started. Document why, who’s responsible
  o In general, generate reports to support what NYSDOT is responsible for and must address & what the contractor is responsible for and is failing to address
  o Alleged delay activities
  o Other, as determined necessary by EIC/ACE/RCE/RD

• Keep tabular and report data regarding who is responsible for CP delays (# days/update period)

• Narrative review and response by EIC as appropriate to document DOT’s position/concerns.
  o Does the narrative allege delays resulting from events within the update period?
  o Does the narrative provide written notice of Changed Conditions?
  o Does the narrative place blame on a party?
  o Does the narrative request some action by a stakeholder or the DOT?
  o Other issues within narrative that mandate a written reply by the EIC?

XIII. Possible Delay Responses:
• Primary considerations to address a delay impact:
  o Look for easy schedule changes to mitigate the delay
  o Start by reviewing Critical and near-critical paths
  o Is there preferential/discretionary logic that can be adjusted?
  o Look for activities that are impacted by restricted seasons?
  o Look for activities that are impacted by weather seasons?
  o Look at negative float activities
  o You can look at float paths
  o You can look at near-critical paths
  o Can a contractual constraint/requirement be altered?

• Secondary considerations to address a delay impact:
  o Look at stage changes or more complicated logic changes to mitigate the delay
  o Start by reviewing Critical and near-critical paths
  o Are there opportunities to do work concurrently?
  o Minimal supervision costs?
  o Can we add a crew or equipment heading?
  o Some supervision costs?
  o Some mobilization costs?
  o Can we adjust staging?
  o Some cost for barrier movement?

• Tertiary considerations to address delay impacts:
  o Look at targeted acceleration to mitigate the delay
  o Start by reviewing Critical and near-critical paths
  o What critical path work should be accelerated?
  o What items require the smallest crews and equipment uses but can be accelerated?
• Compile list of activities that can be accelerated
• Tabulate any additional labor, material and equipment costs
• Define what and when the benefit will be achieved and the mitigation can end.

Adjust milestone and completion dates if economical and best way to mitigate

XIV. Section 100 References to Schedule: (January 8, 2015)

• Section of Interest:
  o 104-02 Changes, Contingencies, Extra Work & Deductions….
  o 104-03 Differing Site Conditions
  o 104-05 Suspension of Work Directed by the Engineer
  o 104-06 Notice & Recordkeeping
  o 104-10 Value Engineering Change Proposal (VECP)
  o 105-14 Disputed Work and Dispute Resolution
  o 108-01 Progress Schedule
  o 108-02 Completion Date
  o 108-03 Failure to Complete Work on Time
  o 108-04 Delay Provisions
  o 109-05D Time Related Dispute Compensation

• Delay Categories:
  o Excusable: (beyond the contractor’s control) when a delay is classified as excusable by contract definition, it is essential that it also be classified as Compensable or Non-Compensable.
    ▪ If Compensable: Contractor should be informed of the Department’s determination, in writing, and if compensable then the appropriate provisions of Section 100 should be complied with to ensure Notice/Recordkeeping/DOT Directed Mitigation, etc. are defined timely.
    ▪ If Non-Compensable: Contractor should be informed of the Department’s determination, in writing.
    ▪ Also, excusable delays may also result in an adjustment of contract time without any additional compensation. This determination should also be made as soon as possible and conveyed to the contractor in writing.
    ▪ If Uncertain: This can be conveyed. As soon as the information necessary to make a determination are known or ascertained, the determination should be conveyed by the Department to the contractor in writing.
  o Non-Excusable: (within the contractor’s control) when a delay is classified as non-excusable by contract definition, it is also essential that this be conveyed to the contractor in writing, timely.
    ▪ Non-Compensable: Non-Excusable Delays can only be Non-Compensable.
Appendix B - EIC Review of Schedule Update Template
EIC Review of Schedule Update [Enter Update #] [Enter Contract #] - [Enter Project Name]

Prepared By EIC/PM [Enter name of EIC]
Contractor / ACS / Other CC [Enter name of Contractor, ACS, CPM Scheduling Section, and other recipients]

1. Acceptance / Rejection

This Schedule Update as submitted by the Contractor is Accepted.
The Contractor shall address the NYSDOT CPM Scheduling Section Comments.
The Contractor shall address the following comments that were discussed at the schedule meeting on 01-Jan-99.

Comments

1.1. [List Comments from Schedule Meeting that need to be addressed.]

2. Response to Contractor’s Narrative / Comment Resolution / Issues & Delays

(Contractor’s Narrative)
(Layout 01_Milestones, Constraints & Level of Efforts)

Comment on the Milestones, Constraints & Level of Efforts, including but not limited to:
• Are all contract completion dates / intermediate contract dates / durations correct?
• Have any contract completion dates / intermediate contract dates / durations slipped / improved and the Narrative does not properly communicate the reasons why?

Enter responses to any comments made in the Contractor’s Narrative, including but not limited to:
• Does the Narrative acknowledge any agreements on reasons for improvement / slippage between Contractor and NYSDOT?
• Does the Narrative acknowledge any agreements on mitigation efforts for slipping work?

Issues / Delays
• Verify dates of issues / delays are accurate in both the Narrative and schedule.
• Where necessary, respond to each current issue / delay in the Contractor’s Narrative.
• Has the Contractor identified how each issue / delay impacts or may potentially impact the schedule, noting important dates to resolve issue / delay?
• Are there other issues / delays not included in the schedule and/or Contractor’s Narrative that should be included?
• Does schedule include all issues / delays discussed at progress meetings?

Comments

2.1. [Comments here.]

3. Critical (Longest) Path

(Contractor’s Narrative)
(Layout 02_Critical (Longest) Path)
(Layout 03_Critical (Longest) Path by WBS)

Describe elements of the Critical (Longest) Path, including but limited to:
• Has the Contractor communicated any changes to the Critical Path from last update?
• Are upcoming activities on the Critical Path scheduled realistically?
• Are there any upcoming dates on the Critical Path that the Contractor is in danger of missing and impacting the completion date?
• Are the scheduled durations accurate based on past performance?
• Do links among different locations / stages / phases on the Critical Path make sense?
• If the schedule is behind, are there opportunities on the Critical Path to gain time?

Comments

3.1. [Comments here.]

4. Actual Dates

(Layout 07_Actuals in Last 5 Weeks)

Comment on the Actual Start and Actual Finish dates input into the schedule, including but not limited to:
### 5. 30-Day Look-Ahead

(Loop 08_30d Look-Ahead)
(Loop 09_30d Look-Ahead Near Critical)

Comment on the 30-day look-ahead layout, including but not limited to:
- Does the schedule plan properly represent the actual planned work?
- Is there work that should be in the 30-day look-ahead that is not showing up?
- Is there work showing up in the 30-day look-ahead that will not take place and should be scheduled out further?
- Is there work available to the Contractor that can currently start, but has not started?

<table>
<thead>
<tr>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1. [Comments here.]</td>
</tr>
</tbody>
</table>

### 6. NYSDOT-Responsible Activities

(Layout 12_NYSDOT Resp Party)

Comment on the NYSDOT-responsible party layout, including but not limited to:
- Are all NYSDOT-responsible activities represented in the schedule?
- Are NYSDOT-responsible activity Original Durations sufficient?
- Are Actual Start / Actual Finish dates for NYSDOT-responsible activities input correctly?

<table>
<thead>
<tr>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1. [Comments here.]</td>
</tr>
</tbody>
</table>

### 7. Additional Review Comments / Recommendations

Describe any additional comments and/or recommendations.

<table>
<thead>
<tr>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1. [Comments here.]</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1. [Comments here.]</td>
</tr>
</tbody>
</table>
Appendix C – Detailed Review Templates

1  Group A Baseline
Review of Baseline Schedule [Enter Update #]

[Enter Contract #] - [Enter Project Name]

Prepared By
[Enter name of Detailed Reviewer]

EIC
[Enter name of EIC]

ACS / Other CC
[Enter name of Area Construction Supervisor, CPM Scheduling Section, other recipients]

Recommendation
[Accepted as Noted / Rejected with Comments]

1. Progress Schedule Details

<table>
<thead>
<tr>
<th>Update Number</th>
<th>[Enter Update #]</th>
<th>Data Date</th>
<th>[Enter P6 Data Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of Review</td>
<td>01-Jan-99</td>
<td>Date Uploaded by CPM Scheduling Section</td>
<td>01-Jan-99</td>
</tr>
<tr>
<td>P6 Project ID</td>
<td>[Enter P6 Project ID]</td>
<td>P6 Project Name</td>
<td>[Enter P6 Project Name]</td>
</tr>
<tr>
<td>Previous Update</td>
<td>[Enter Previous Update Number that served as comparison for this Update]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Update Summary and Recommendation

Update Summary

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Complete after remainder of report is completed. Enter paragraph(s) to provide executive summary of this report. Describe summary of major issues remaining to come to an acceptable Baseline schedule that includes all contract work and meets the NYSDOT Item 639 CPM schedule specification requirements. If a portion of the report is useful to put up front in the Update Summary section, describe in this section with any tables / figures / etc.

2.1. [Comments here.]

Recommendation

We recommend that NYSDOT [Accept as Noted / Reject with Comments] this schedule update as noted in this report. Comments that the Contractor should address in the next submission are shown in red underlined text.

The Contractor shall address the NYSDOT CPM Scheduling Section Comments noted in Exhibit 1.

The Contractor should address the following comments that were discussed at the schedule meeting on 01-Jan-99.

2.2. [List Comments from Schedule Meeting that need to be addressed.]

3. Comment Resolution

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Address any comments made in the Contractor’s Narrative that need resolution. Address comments made in meetings, emails, etc. regarding the schedule. Reference any specific comment numbers so resolution can be easily tracked.

3.1. [Comments here.]
4. Additional Review Comments and Recommendations

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe any additional comments and/or recommendations in reviewing the current schedule submission for conformance to the NYSDOT Item 639 CPM schedule specification. Group and describe all additional errors / omissions / comments:

- Verification that all contract deliverables and milestones are included in the schedule.
- Verification of proper logic to dates of submittals, including appropriate review times.
- Verification of proper logic in sequencing of work and activity durations.
- Make sure any high risk items such as utility relocation, permits, ROW acquisitions are included in the baseline schedule and are included in Updates as they are identified.

4.1. [Comments here.]

5. Status of Major Milestones

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Major milestones include any intermediate contract milestones or Incentive/Disincentive Periods or Liquidated Damages. If none of the latter, possibly include the completion of major stages or phases.

IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFER TO ITEM 639 SPECIFICATION FOR DETAILS.

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

Substantial Completion ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

Anticipated Contract Completion ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the Contract date [Contract / Baseline Date].

Upcoming Major Milestones

<table>
<thead>
<tr>
<th>Date</th>
<th>Activity ID</th>
<th>Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
</tbody>
</table>
6. **Critical (Longest) Path**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe elements of the Critical (Longest) Path, including but limited to:

- Is the Critical Path the same, compared to the Previous Update? Describe any changes to the Critical Path.
- Are there any gaps in the Critical Path? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the Critical Path.
- What are important upcoming dates to target to maintain the Critical Path’s timely completion, or the dates that must be hit to bring the project back on schedule?
- Do links among different locations/stages/phases make sense?
- Insert a screen shot of the Critical Path, adding comments to the image that highlight the more important Critical Path details.
  
  - If CP is very long, may not be beneficial/legible to show entire CP as a screen shot. Up to reviewer to use judgment to truncate CP based on a key milestone or near-term milestone such as end of a stage, completion of a bridge stage, setting of bridge beams, etc. (Full Critical Path PDF to be included as Appendix.)
  
  - When CP has changed, may be useful to show activities that were on previous CP in a separate figure and explain what changed.
- If Critical Path is described in the “Longest Paths to Key Milestones” section - for an individual bridge - make note in this section.

6.1. [Comments here.]

7. **Near-Critical Paths**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Similar to the Critical Path, describe elements of the Near-Critical Paths, including but limited to:

- Besides the Critical Path, what are the next most critical groups of activities, focusing mainly on upcoming remaining work?
- Aside from the Critical Path, what are the upcoming activities and important dates that must be maintained to keep the project on schedule?
- Are the Near-Critical Paths the same, compared to the Previous Update? Describe any changes to the Near-Critical Paths.
- Insert a screen shot of Near-Critical Paths, adding comments to the image that highlight the more important Near-Critical Path details.

7.1. [Comments here.]

8. **Exhibits**

| Exhibit 1: High Level Review Email |
| Exhibit 2: Schedule Revision Details |
| Exhibit 3: Correspondence          |
| Exhibit 4: Critical Path (Global Layout “02_Longest (Critical) Path”) |
2  Group A Update
Review of Schedule Update [Enter Update #]  
[Enter Contract #] - [Enter Project Name]  

Prepared By [Enter name of Detailed Reviewer]  
EIC [Enter name of EIC]  
ACS / Other CC [Enter name of Area Construction Supervisor, CPM Scheduling Section, other recipients]  
Recommendation [Accepted as Noted / Rejected with Comments]  

1. Progress Schedule Details  

<table>
<thead>
<tr>
<th>Update Number</th>
<th>[Enter Update #]</th>
<th>Data Date</th>
<th>[Enter P6 Data Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Period</td>
<td>From 01-Jan-99</td>
<td>To 01-Jan-99</td>
<td>99 Continuous Calendar Days (CCD)</td>
</tr>
<tr>
<td>Date of Review</td>
<td>01-Jan-99</td>
<td>Date Uploaded by CPM Scheduling Section</td>
<td>01-Jan-99</td>
</tr>
<tr>
<td>Date Uploaded by Contractor</td>
<td>Date Submitted by Contractor 01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P6 Project ID</td>
<td>[Enter P6 Project ID]</td>
<td>P6 Project Name</td>
<td>[Enter P6 Project Name]</td>
</tr>
<tr>
<td>Previous Update</td>
<td>[Enter Previous Update Number that served as comparison for this Update]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Update Summary and Recommendation  

Update Summary  

"***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***"  
Complete after remainder of report is completed. Enter paragraph(s) to provide executive summary of this report. Describe status of project schedule and cause of anticipated contract completion and/or intermediate contractual milestone improvement / slippage, including but not limited to:  
- Schedule’s cause for the improvement / slippage  
- Contractor’s cause for the improvement / slippage in the Narrative  
- NYSDOT / Detailed Reviewer’s cause for the improvement / slippage not reflected in the schedule  
- Any agreements on improvement / slippage between Contractor and NYSDOT as agreed at schedule meetings  
- Any agreements on mitigation efforts for slipping work  

If anticipated contract completion and intermediate contractual milestones remain unchanged and are on time, summarize the critical / near-critical progress completed in the update period to maintain the current schedule, as well as what critical / near-critical progress needs to be made over the next update period to maintain the current timely completion.  
If a portion of the report is useful to put up front in the Update Summary section, describe in this section with any tables / figures / etc.  

8.1. [Comments here.]  

Recommendation  

We recommend that NYSDOT [Accept as Noted / Reject with Comments] this schedule update as noted in this report. Comments that the Contractor should address in the next submission are shown in red underlined text.  
The Contractor shall address the NYSDOT CPM Scheduling Section Comments noted in Exhibit 1.  
The Contractor should address the following comments that were discussed at the schedule meeting on 01-Jan-99.  

8.2. [List Comments from Schedule Meeting that need to be addressed.]
3. Status of Major Milestones

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Major milestones include any intermediate contract milestones or Incentive/Disincentive Periods or Liquidated Damages. If none of the latter, possibly include the completion of major stages or phases. IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  o Reason for [Improvement / Slippage]: [Type brief explanation or "see below"].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  o Reason for [Improvement / Slippage]: [Type brief explanation or "see below"].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  o Reason for [Improvement / Slippage]: [Type brief explanation or "see below"].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  o Reason for [Improvement / Slippage]: [Type brief explanation or "see below"].

- Substantial Completion ([Activity ID]) – [Current Update Date]
  o [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  o Reason for [Improvement / Slippage]: [Type brief explanation or "see below"].

- Anticipated Contract Completion ([Activity ID]) – [Current Update Date]
  o [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the Contract date [Contract / Baseline Date].
  o Reason for [Improvement / Slippage]: [Type brief explanation or "see below"].

Upcoming Major Milestones

<table>
<thead>
<tr>
<th>Date</th>
<th>[Activity ID]</th>
<th>Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
</tbody>
</table>
4. Issues / Delays

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Address each issue / delay on the project that is or may potentially impact the schedule:

- Track each issue / delay by assigning numbers, if the Contractor has not already done so. If Contractor has not, encourage Contractor to assign numbers to allow for consistent tracking.
- Respond to each current issue / delay in the Contractor’s Narrative.
- Identify how each issue / delay is affecting or may affect the Critical Path or another contractual milestone. If it is not causing an impact, explain.
- Identify how the issue / delay impacts or may potentially impact the schedule, noting important dates to resolve issue / delay.
- Review with NYSDOT to determine if there are other issues / delays not included in the schedule and/or Contractor’s Narrative that should be included.
- Does schedule include all issues / delays discussed at progress meetings?
- Verify dates and issues / delays are accurate.
- Comment, addressing each current issue / delay.
- Even if issue / delay is not modeled in schedule, still identify activities that are affected and show / discuss float.
- Insert screen shots of Narrative / schedule where applicable.

8.3. [Comments here.]

5. Critical (Longest) Path

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe elements of the Critical (Longest) Path, including but limited to:

- Is the Critical Path the same, compared to the Previous Update? Describe any changes to the Critical Path.
- Are there any gaps in the Critical Path? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the Critical Path. Have these activities improved / slipped since the Previous Update?
- What are important upcoming dates to target to maintain the Critical Path’s timely completion, or the dates that must be hit to bring the project back on schedule?
- Are the scheduled durations accurate based on past performance?
- Do links among different locations / stages / phases make sense?
- If the schedule is behind, are there opportunities on the Critical Path to gain time?
- Insert a screen shot of the Critical Path, adding comments to the image that highlight the more important Critical Path details.

8.4. [Comments here.]

6. Near-Critical Paths

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Similar to the Critical Path, describe elements of the Near-Critical Paths, including but limited to:

- Besides the Critical Path, what are the next most critical groups of activities, focusing mainly on upcoming remaining work?
- Are there groups of activities that are slipping and may potential take over the Critical Path due to slippage?
- What work is available to the Contractor to start but has not started?
- Aside from the Critical Path, what are the upcoming activities and important dates that must be maintained to keep the project on schedule or prevent it from slipping further behind?
- Are the Near-Critical Paths the same, compared to the Previous Update? Describe any changes to the Near-Critical Paths.
- Have Near-Critical activities improved / slipped since the Previous Update?
- Insert a screen shot of Near-Critical Paths, adding comments to the image that highlight the more important Near-Critical Path details.

8.5. [Comments here.]
7. Summary of Anticipated Contract Completion Movement

(**DELETE PRIOR TO SUBMITTING TO CONTRACTOR**)

If contract completion or another contract milestone is 10% or more behind schedule, the Engineer may require the Contractor to submit a recovery schedule. Reference Item 639 Specification for details.

The table below summarizes the movement of Anticipated Contract Completion from the start of the project.

<table>
<thead>
<tr>
<th>Schedule Update</th>
<th>Data Date</th>
<th>Scheduled Contract Completion Date</th>
<th>Var. from Previous (CCD)*</th>
<th>Var. from Contract (CCD)*</th>
<th>Negative Float</th>
<th>Resp. Party</th>
<th>Apparent Cause of Gain / Delay to Negative Float (Including Driving Critical Path Activity)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract</td>
<td>n/a</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>Baseline</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>Update #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Positive Variance indicates that the milestone is ahead of schedule or that the schedule has gained time.

8. Schedule Revisions

(**DELETE PRIOR TO SUBMITTING TO CONTRACTOR**)

If sections below are very long due to large tables, reference large tables in attached Exhibits and include here only most important content. Acknowledge if revisions were addressed in previous correspondence, meetings, or reviews, as well as if these changes were previously approved by the EIC.

Activities Added

Using Claim Digger and other means to identify and describe all activities added to the schedule when compared to the Previous Update.

- Are these additions acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- Show screen shots of added activities and how these activities tie into the logic of the schedule.
- How do these changes impact the schedule?
- State if the added activities have affected the Critical Path or other contract milestones.

8.6. [Comments here.]

Activities Deleted

Using Claim Digger and other means to identify and describe all activities deleted from the schedule when compared to the Previous Update.

- Are these deletions acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?
- State if the deleted activities have affected the Critical Path or other contract milestones.

8.7. [Comments here.]
Logic Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all logic changes in the schedule when compared to the Previous Update:
- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.8. [Comments here.]

Original Duration Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Original Duration changes in the schedule when compared to the Previous Update. Present Original Duration changes in Table format:
- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.9. [Comments here.]

Activity Name Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Activity Name changes in the schedule when compared to the Previous Update:
- Are these changes acceptable?
- Only very small changes are acceptable; the scope of an activity must remain consistent from Baseline through As-Built;
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.10. [Comments here.]

Calendar Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Calendar changes in the schedule, and also Calendar assignment changes, when compared to the Previous Update:
- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

[Comments here.]

9. Comment Resolution

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Address any comments made in the Contractor’s Narrative that need resolution. Address comments made in meetings, emails, etc. regarding the schedule. Reference any specific comment numbers so resolution can be easily tracked.

9.1. [Comments here.]
10. **Additional Review Comments and Recommendations**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe any additional comments and/or recommendations in reviewing the current schedule submission for **conformance to the NYSDOT Item 639 CPM schedule specification**. Group and describe all additional errors / omissions / comments:

- Verification that all contract deliverables and milestones are included in the schedule.
- Verification of proper logic to dates of submittals, including appropriate review times.
- Verification of proper logic in sequencing of work and activity durations.
- Make sure any high risk items such as utility relocation, permits, ROW acquisitions are included in the baseline schedule and are included in Updates as they are identified.

10.1. [Comments here.]
11. Activity Status

Percent Complete

<table>
<thead>
<tr>
<th>% Complete</th>
<th>Task Dependent Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>0% (0 of 0)</td>
<td>COMPLETED as of the current Data Date.</td>
</tr>
<tr>
<td>0% (0 of 0)</td>
<td>IN PROGRESS as of the current Data Date.</td>
</tr>
<tr>
<td>0% (0 of 0)</td>
<td>REMAINING as of the current Data Date.</td>
</tr>
</tbody>
</table>

Chart Description
Below is a chart showing current cumulative project percent complete in comparison with the Baseline Early Finish and Late Finish dates. This chart tracks number of task dependent activities completed. Generally, the actual cumulative percent complete should trend somewhere between the Baseline Early and Baseline Late curves. The “finish” dates reported in P6 schedules represent the Baseline Early Finish curve, or the earliest activities can complete based on current activity durations and logic. The latest all activities can finish and the project still complete on time is the Baseline Late Finish curve, based on current activity durations and logic.

How to Read It
On-time project completions mostly trend between the Baseline Early and Baseline Late curves. If Actual curve is to right of Late curve, there should be negative float in the schedule based on the original plan; if no negative float, Contractor has condensed schedule and plans to have more resources than originally planned in order to complete on time.

Describe any comments regarding the figure above:
- Is Actual curve trending somewhere between Early and Late curves, and work is progressing as planned?
- Is Actual curve trending towards Late curve? Are planned activities getting pushed off each month? Is Contractor not completing work (activities) as planned? If trending towards / beyond Late curve and not producing as planned, is there plan for how Contractor is going to change to bring project back on schedule (more resources)? If Actual is to right of Late curve, there should be negative float in the schedule based on the original plan; if no negative float, Contractor has condensed schedule and plans to have more resources than originally planned in order to complete on time.
- Is Actual curve trending towards Early curve? Is work (activities) being complete on or ahead of schedule?
- Is there a major discrepancy in project % paid to date versus current % of activities complete?

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
• If there is a Time Extension on a contract milestone/duration, the “Baseline” curves should be revised to the schedule submission at the time of the Time Extension, showing the revised plan for completing contract milestones by the revised dates.

11.1. [Comments here.]

Float Density

**Chart Description**
Float Density represents what percentage of remaining activities have a comfortable amount of float versus very little float. The below chart and table track Float Density over the last six updates, based on number of remaining task activities (non-milestone, non-level of effort). Use this analysis in conjunction with any movement of intermediate and / or overall milestones / durations.

**How to Read It**
The higher percentage / more activities in the lower categories indicate a higher percentage / more activities becoming near-critical / critical. More green = more activities with float. A trend towards more yellow / orange / red = a higher percentage of critical / near-critical activities and higher risk of late contract completion.

11.2. [Comments here.]
Actual Date Discrepancies

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Confirm Actual Start / Actual Finish dates in the current schedule update with the NYSDOT project team and identify any discrepancies that need resolution.

11.3. [Comments here.]

12. Exhibits

<table>
<thead>
<tr>
<th>Exhibit 1:</th>
<th>High Level Review Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exhibit 2:</td>
<td>Schedule Revision Details</td>
</tr>
<tr>
<td>Exhibit 3:</td>
<td>Correspondence</td>
</tr>
<tr>
<td>Exhibit 4:</td>
<td>Critical Path (Global Layout “02_Longest (Critical) Path”)</td>
</tr>
</tbody>
</table>
3 Group B Baseline
Review of Baseline Schedule [Enter Update #]  
[Enter Contract #] - [Enter Project Name]

Prepared By: [Enter name of Detailed Reviewer]  
EIC: [Enter name of EIC]  
ACS / Other CC: [Enter name of Area Construction Supervisor, CPM Scheduling Section, other recipients]  
Recommendation: [Accepted as Noted / Rejected with Comments]

1. Progress Schedule Details

<table>
<thead>
<tr>
<th>Update Number</th>
<th>[Enter Update #]</th>
<th>Date</th>
<th>[Enter P6 Data Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of Review</td>
<td>01-Jan-99</td>
<td>Date Uploaded by CPM Scheduling Section</td>
<td>01-Jan-99</td>
</tr>
<tr>
<td>P6 Project ID</td>
<td>[Enter P6 Project ID]</td>
<td>P6 Project Name</td>
<td>[Enter P6 Project Name]</td>
</tr>
<tr>
<td>Previous Update</td>
<td>[Enter Previous Update Number that served as comparison for this Update]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Update Summary and Recommendation

Update Summary

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Complete after remainder of report is completed. Enter paragraph(s) to provide executive summary of this report.
Describe summary of major issues remaining to come to an acceptable Baseline schedule that includes all contract work and meets the NYSDOT Item 639 CPM schedule specification requirements.
If a portion of the report is useful to put up front in the Update Summary section, describe in this section with any tables / figures / etc.

2.1. [Comments here.]

Recommendation

We recommend that NYSDOT [Accept as Noted / Reject with Comments] this schedule update as noted in this report.
Comments that the Contractor should address in the next submission are shown in red underlined text.
The Contractor shall address the NYSDOT CPM Scheduling Section Comments noted in Exhibit 1.
The Contractor should address the following comments that were discussed at the schedule meeting on 01-Jan-99.

2.2. [List Comments from Schedule Meeting that need to be addressed.]

3. Comment Resolution

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Address any comments made in the Contractor’s Narrative that need resolution. Address comments made in meetings, emails, etc. regarding the schedule. Reference any specific comment numbers so resolution can be easily tracked.

3.1. [Comments here.]
4. Additional Review Comments and Recommendations

(*DELETED PRIOR TO SUBMITTING TO CONTRACTOR*)

Describe any additional comments and/or recommendations in reviewing the current schedule submission for conformance to the NYSDOT Item 639 CPM schedule specification. Group and describe all additional errors / omissions / comments:

- Verification that all contract deliverables and milestones are included in the schedule.
- Verification of proper logic to dates of submittals, including appropriate review times.
- Verification of proper logic in sequencing of work and activity durations.
- Make sure any high risk items such as utility relocation, permits, ROW acquisitions are included in the baseline schedule and are included in Updates as they are identified.

4.1. [Comments here.]

5. Status of Major Milestones

(*DELETED PRIOR TO SUBMITTING TO CONTRACTOR*)

Major milestones include any intermediate contract milestones or Incentive/Disincentive Periods or Liquidated Damages. If none of the latter, possibly include the completion of major stages or phases.

IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Substantial Completion] ([Activity ID]) – [Current Update Date]
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Anticipated Contract Completion] ([Activity ID]) – [Current Update Date]
  o [Number of CCD] CCD [Ahead / Behind] in comparison to the Contract date [Contract / Baseline Date].

Upcoming Major Milestones

<table>
<thead>
<tr>
<th>Date</th>
<th>Activity ID</th>
<th>Name of upcoming major milestone</th>
<th>Description of work/dates required to achieve this date</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
<td></td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
<td></td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
<td></td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
<td></td>
</tr>
</tbody>
</table>
6. **Critical (Longest) Path**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe elements of the Critical (Longest) Path, including but limited to:

- Is the Critical Path the same, compared to the Previous Update? Describe any changes to the Critical Path.
- Are there any gaps in the Critical Path? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the Critical Path.
- What are important upcoming dates to target to maintain the Critical Path’s timely completion, or the dates that must be hit to bring the project back on schedule?
- Do links among different locations / stages / phases make sense?
- Insert a screen shot of the Critical Path, adding comments to the image that highlight the more important Critical Path details.
  - If CP is very long, may not be beneficial / legible to show entire CP as a screen shot. Up to reviewer to use judgment to truncate CP based on a key milestone or near-term milestone such as end of a stage, completion of a bridge stage, setting of bridge beams, etc. (Full Critical Path PDF to be included as Appendix.)
  - When CP has changed, may be useful to show activities that were on previous CP in a separate figure and explain what changed.
- If Critical Path is described in the “Longest Paths to Key Milestones” section - for an individual bridge - make note in this section.

6.1. [Comments here.]

7. **Status of Other Major Milestones**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Use this section if the project has intermediate contract milestones that are not sequential for one continuous Critical Path. If there are Incentive/Disincentive Periods or Liquidates Damages that are based on individual bridges, stages or phases completing by a specific date, track the critical and potentially near-critical paths to completing each individual bridge / stage / phase / milestone. This will report on the most critical activities to achieving each instance. For Design-Build projects, reference Form SCD for I/D / LD dates.

Describe elements of the float paths for intermediate milestones, including but limited to:

- Are the float paths to completing each major contractual intermediate milestone the same, compared to the Previous Update? Describe any changes to the float paths.
- Are there any gaps in any of the intermediate float paths? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the each intermediate float path.
- What are important upcoming dates to target to maintain each intermediate milestone’s timely completion, or the dates that must be hit?
- Do links among different locations / stages / phases make sense?
- Insert screen shots of intermediate float paths, adding comments to highlight the more important details.

**IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.**

[Enter Name of Intermediate Contract Milestone]

7.1. [Comments here.]

Longest Path to Completion of [Enter Name of Milestone]

[Insert Image(s) of Longest Path for this Milestone]

[Enter Name of Intermediate Contract Milestone]

7.2. [Comments here.]

Longest Path to Completion of [Enter Name of Milestone]

[Insert Image(s) of Longest Path for this Milestone]

8. **Exhibits**

| Exhibit 1: High Level Review Email |
| Exhibit 2: Schedule Revision Details |
| Exhibit 3: Correspondence |
| Exhibit 4: Critical Path (Global Layout “02_Longest (Critical) Path”) |
Group B Update
Review of Schedule Update [Enter Update #]
[Enter Contract #] - [Enter Project Name]

Prepared By [Enter name of Detailed Reviewer]
EIC [Enter name of EIC]
ACS / Other CC [Enter name of Area Construction Supervisor, CPM Scheduling Section, other recipients]
Recommendation [Accepted as Noted / Rejected with Comments]

1. Progress Schedule Details

<table>
<thead>
<tr>
<th>Update Number</th>
<th>[Enter Update #]</th>
<th>Data Date</th>
<th>[Enter P6 Data Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Period</td>
<td>From 01-Jan-99 To 01-Jan-99</td>
<td>99 Continuous Calendar Days (CCD)</td>
<td></td>
</tr>
<tr>
<td>Date of Review</td>
<td>01-Jan-99</td>
<td>Date Uploaded by CPM Scheduling Section 01-Jan-99</td>
<td>Date Submitted by Contractor 01-Jan-99</td>
</tr>
<tr>
<td>P6 Project ID</td>
<td>[Enter P6 Project ID]</td>
<td>P6 Project Name</td>
<td>[Enter P6 Project Name]</td>
</tr>
<tr>
<td>Previous Update</td>
<td>[Enter Previous Update Number that served as comparison for this Update]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Update Summary and Recommendation

Update Summary

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Complete after remainder of report is completed. Enter paragraph(s) to provide executive summary of this report. Describe status of project schedule and cause of anticipated contract completion and/or intermediate contractual milestone improvement / slippage, including but not limited to:

- Schedule’s cause for the improvement / slippage
- Contractor’s cause for the improvement / slippage in the Narrative
- NYSDOT / Detailed Reviewer’s cause for the improvement / slippage not reflected in the schedule
- Any agreements on improvement / slippage between Contractor and NYSDOT as agreed at schedule meetings
- Any agreements on mitigation efforts for slipping work

If anticipated contract completion and intermediate contractual milestones remain unchanged and are on time, summarize the critical / near-critical progress completed in the update period to maintain the current schedule, as well as what critical / near-critical progress needs to be made over the next update period to maintain the current timely completion.

If a portion of the report is useful to put up front in the Update Summary section, describe in this section with any tables / figures / etc.

2.1. [Comments here.]

Recommendation

We recommend that NYSDOT [Accept as Noted / Reject with Comments] this schedule update as noted in this report.

Comments that the Contractor should address in the next submission are shown in red underlined text.

The Contractor shall address the NYSDOT CPM Scheduling Section Comments noted in Exhibit 1.

The Contractor should address the following comments that were discussed at the schedule meeting on 01-Jan-99.

2.2. [List Comments from Schedule Meeting that need to be addressed.]
3. Status of Major Milestones

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Major milestones include any intermediate contract milestones or Incentive/Disincentive Periods or Liquidated Damages. If none of the latter, possibly include the completion of major stages or phases.

IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- Substantial Completion ([Activity ID]) – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- Anticipated Contract Completion ([Activity ID]) – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the Contract date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

Upcoming Major Milestones

Below are upcoming major milestones or the completion of I/D / LD Durations, including important dates.

<table>
<thead>
<tr>
<th>Date</th>
<th>Activity ID</th>
<th>Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4. Issues / Delays

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Address each issue / delay on the project that is or may potentially impact the schedule.

- Track each issue / delay by assigning numbers, if the Contractor has not already done so. If Contractor has not, encourage Contractor to assign numbers to allow for consistent tracking.
- Respond to each current issue / delay in the Contractor’s Narrative.
- Identify how each issue / delay is affecting or may affect the Critical Path or another contractual milestone. If it is not causing an impact, explain.
- Identify how the issue / delay impacts or may potentially impact the schedule, noting important dates to resolve issue / delay.
- Review with NYSDOT to determine if there are other issues / delays not included in the schedule and/or Contractor’s Narrative that should be included.
- Does schedule include all issues / delays discussed at progress meetings?
- Verify dates and issues / delays are accurate.
- Comment, addressing each current issue / delay.
- Even if issue / delay is not modeled in schedule, still identify activities that are affected and show / discuss float.
- Insert screen shots of Narrative / schedule where applicable.

4.1. [Comments here.]

5. Critical (Longest) Path

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe elements of the Critical (Longest) Path, including but limited to:

- Is the Critical Path the same, compared to the Previous Update? Describe any changes to the Critical Path.
- Are there any gaps in the Critical Path? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the Critical Path. Have these activities improved / slipped since the Previous Update?
- What are important upcoming dates to target to maintain the Critical Path’s timely completion, or the dates that must be hit to bring the project back on schedule?
- Are the scheduled durations accurate based on past performance?
- Do links among different locations / stages / phases make sense?
- If the schedule is behind, are there opportunities on the Critical Path to gain time?
- Insert a screen shot of the Critical Path, adding comments to the image that highlight the more important Critical Path details.
  - If CP is very long, may not be beneficial / legible to show entire CP as a screen shot. Up to reviewer to use judgment to truncate CP based on a key milestone or near-term milestone such as end of a stage, completion of a bridge stage, setting of bridge beams, etc. (Full Critical Path PDF to be included as Appendix.)
  - CP figure should show target bars to previous update and variance to previous so that reader can see movement.
  - When CP has changed, may be useful to show activities that were on previous CP in a separate figure and explain what changed.
- If Critical Path is described in the "Longest Paths to Key Milestones" section - for an individual bridge - make note in this section.

5.1. [Comments here.]
6. Summary of Anticipated Contract Completion Movement

(*****DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.)

The table below summarizes the movement of Anticipated Contract Completion from the start of the project.

<table>
<thead>
<tr>
<th>Schedule Update</th>
<th>Data Date</th>
<th>Scheduled Contract Completion Date</th>
<th>Var. from Previous (CCD)*</th>
<th>Var. from Contract (CCD)*</th>
<th>Negative Float Resp. Party</th>
<th>Apparent Cause of Gain / Delay to Negative Float (Including Driving Critical Path Activity)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract</td>
<td>n/a</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Baseline</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Positive Variance indicates that the milestone is ahead of schedule or that the schedule has gained time.

7. Status of Other Major Milestones

(*****DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Use this section if the project has intermediate contract milestones that are not sequential for one continuous Critical Path. If there are Incentive/Disincentive Periods or Liquidates Damages that are based on individual bridges, stages or phases completing by a specific date, track the critical and potentially near-critical paths to completing each individual bridge / stage / phase / milestone. This will report on the most critical activities to achieving each instance. For Design-Build projects, reference Form SCD for I/D / LD dates.

Describe elements of the float paths for intermediate milestones, including but limited to:
- Are the float paths to completing each major contractual intermediate milestone the same, compared to the Previous Update? Describe any changes to the float paths.
- Comment on any contract milestone movement.
- Are there any gaps in any of the intermediate float paths? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the each intermediate float path. Have these activities improved / slipped since the Previous Update?
- What are important upcoming dates to target to maintain each intermediate milestone’s timely completion, or the dates that must be hit to bring the milestones back on schedule?
- Are the scheduled durations accurate based on past performance?
- Do links among different locations / stages / phases make sense?
- If the schedule is behind, are their opportunities on the intermediate float path to gain time?
- Insert screen shots of intermediate float paths, adding comments to highlight the more important details.

IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.)

[Enter Name of Intermediate Contract Milestone]

7.1. [Comments here.]

Longest Path to Completion of [Enter Name of Milestone]
[Insert Image(s) of Longest Path for this Milestone]
[Enter Name of Milestone] — Summary of Contract Duration Movement

<table>
<thead>
<tr>
<th>Schedule Update</th>
<th>Finish Date</th>
<th>Var. from Previous (CCD)*</th>
<th>Var. from Contract (CCD)*</th>
<th>Negative Float Resp. Party</th>
<th>Apparent Cause of Gain / Delay to Negative Float (Including Driving Critical Path Activity)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Contractor</td>
<td>NYSDOT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>This Period (CCD)</td>
</tr>
<tr>
<td>Contract</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Baseline</td>
<td></td>
<td>n/a</td>
<td></td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Update #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Positive Variance indicates that the milestone is ahead of schedule or that the schedule has gained time.

[Enter Name of Intermediate Contract Milestone]

7.2. [Comments here.]

Longest Path to Completion of [Enter Name of Milestone] [Insert Image(s) of Longest Path for this Milestone]

[Enter Name of Milestone] — Summary of Contract Duration Movement

<table>
<thead>
<tr>
<th>Schedule Update</th>
<th>Finish Date</th>
<th>Var. from Previous (CCD)*</th>
<th>Var. from Contract (CCD)*</th>
<th>Negative Float Resp. Party</th>
<th>Apparent Cause of Gain / Delay to Negative Float (Including Driving Critical Path Activity)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Contractor</td>
<td>NYSDOT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>This Period (CCD)</td>
</tr>
<tr>
<td>Contract</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Baseline</td>
<td></td>
<td>n/a</td>
<td></td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Update #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Positive Variance indicates that the milestone is ahead of schedule or that the schedule has gained time.

8. Schedule Revisions

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

If sections below are very long due to large tables, reference large tables in attached Exhibits and include here only most important content. Acknowledge if revisions were addressed in previous correspondence, meetings, or reviews, as well as if these changes were previously approved by the EIC.

Activities Added

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Using Claim Digger and other means to identify and describe all activities added to the schedule when compared to the Previous Update:

- Are these additions acceptable?
- Were they previously discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- Show screen shots of added activities and how these activities tie into the logic of the schedule.
- How do these changes impact the schedule?
- State if the added activities have affected the Critical Path or other contract milestones.

8.1. [Comments here.]
Activities Deleted

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all activities deleted from the schedule when compared to the Previous Update.

- Are these deletions acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?
- State if the deleted activities have affected the Critical Path or other contract milestones.

8.2. [Comments here.]

Logic Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all logic changes in the schedule when compared to the Previous Update.

- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.3. [Comments here.]

Original Duration Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Original Duration changes in the schedule when compared to the Previous Update. Present Original Duration changes in Table format.

- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.4. [Comments here.]

Activity Name Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Activity Name changes in the schedule when compared to the Previous Update.

- Are these changes acceptable?
- Only very small changes are acceptable; the scope of an activity must remain consistent from Baseline through As-Built!
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.5. [Comments here.]

Calendar Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Calendar changes in the schedule, and also Calendar assignment changes, when compared to the Previous Update.

- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

[Comments here.]
9. **Comment Resolution**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Address any comments made in the Contractor’s Narrative that need resolution. Address comments made in meetings, emails, etc. regarding the schedule. Reference any specific comment numbers so resolution can be easily tracked.

9.1. [Comments here.]

10. **Additional Review Comments and Recommendations**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Describe any additional comments and/or recommendations in reviewing the current schedule submission for **conformance to the NYSDOT Item 639 CPM schedule specification**. Group and describe all additional errors / omissions / comments:

- Verification that all contract deliverables and milestones are included in the schedule.
- Verification of proper logic to dates of submittals, including appropriate review times.
- Verification of proper logic in sequencing of work and activity durations.
- Make sure any high risk items such as utility relocation, permits, ROW acquisitions are included in the baseline schedule and are included in Updates as they are identified.

10.1. [Comments here.]
11. **Activity Status**

**Percent Complete**

<table>
<thead>
<tr>
<th>Percent Complete</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0% (0 of 0)</td>
<td>Task Dependent Activities are <strong>COMPLETED</strong> as of the current Data Date.</td>
</tr>
<tr>
<td>0% (0 of 0)</td>
<td>Task Dependent Activities are <strong>IN PROGRESS</strong> as of the current Data Date.</td>
</tr>
<tr>
<td>0% (0 of 0)</td>
<td>Task Dependent Activities are <strong>REMAINING</strong> as of the current Data Date.</td>
</tr>
</tbody>
</table>

**Chart Description**

Below is a chart showing current cumulative project percent complete in comparison with the Baseline Early Finish and Late Finish dates. This chart tracks number of task dependent activities completed. Generally, the actual cumulative percent complete should trend somewhere between the Baseline Early and Baseline Late curves. The “finish” dates reported in P6 schedules represent the Baseline Early Finish curve, or the earliest activities can complete based on current activity durations and logic. The latest all activities can finish and the project still complete on time is the Baseline Late Finish curve, based on current activity durations and logic.

**How to Read It**

On-time project completions mostly trend between the Baseline Early and Baseline Late curves. If Actual curve is to right of Late curve, there should be negative float in the schedule based on the original plan; if no negative float, Contractor has condensed schedule and plans to have more resources than originally planned in order to complete on time.

**Cumulative Percent Complete - Baseline vs. Actual vs. Remaining**

Replace with “FIGURE – Percent Complete” from Detailed Review Template Figures

---

**DELETE PRIOR TO SUBMITTING TO CONTRACTOR**

Describe any comments regarding the figure above:

- Is Actual curve trending somewhere between Early and Late curves, and work is progressing as planned?
- Is Actual curve trending towards Late curve? Are planned activities getting pushed off each month? Is Contractor not completing work (activities) as planned? If trending towards / beyond Late curve and not producing as planned, is there a plan for how Contractor is going to change to bring project back on schedule (more resources)? If Actual is to right of Late curve, there should be negative float in the schedule based on the original plan; if no negative float, Contractor has condensed schedule and plans to have more resources than originally planned in order to complete on time;
- Is Actual curve trending towards Early curve? Is work (activities) being complete on or ahead of schedule?
- Is there a major discrepancy in project % paid to date versus current % of activities complete?
If there is a Time Extension on a contract milestone/duration, the "Baseline" curves should be revised to the schedule submission at the time of the Time Extension, showing the revised plan for completing contract milestones by the revised dates.

11.1. [Comments here.]

### Float Density

**Chart Description**

Float Density represents what percentage of remaining activities have a comfortable amount of float versus very little float. The below chart and table track Float Density over the last six updates, based on number of remaining task activities (non-milestone, non-level of effort). Use this analysis in conjunction with any movement of intermediate and / or overall milestones / durations.

**How to Read It**

The higher percentage / more activities in the lower categories indicate a higher percentage / more activities becoming near-critical / critical. More green = more activities with float. A trend towards more yellow / orange / red = a higher percentage of critical / near-critical activities and higher risk of late contract completion.

<table>
<thead>
<tr>
<th>Total Number of Remaining Task Activities</th>
<th>1SU07</th>
<th>1SU08</th>
<th>1SU09</th>
<th>1SU10</th>
<th>1SU11</th>
<th>1SU12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Float &gt; 40d</td>
<td>270</td>
<td>262</td>
<td>260</td>
<td>260</td>
<td>212</td>
<td>139</td>
</tr>
<tr>
<td>Total Float 20-40d</td>
<td>61</td>
<td>29</td>
<td>12</td>
<td>33</td>
<td>19</td>
<td>37</td>
</tr>
<tr>
<td>Total Float 0-20d</td>
<td>55</td>
<td>69</td>
<td>53</td>
<td>33</td>
<td>26</td>
<td>34</td>
</tr>
<tr>
<td>Total Float 0d or less</td>
<td>25</td>
<td>27</td>
<td>32</td>
<td>43</td>
<td>41</td>
<td>59</td>
</tr>
<tr>
<td>Total Remaining</td>
<td>391</td>
<td>362</td>
<td>342</td>
<td>334</td>
<td>292</td>
<td>268</td>
</tr>
</tbody>
</table>

11.2. [Comments here.]
Actual Date Discrepancies

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Confirm Actual Start / Actual Finish dates in the current schedule update with the NYSDOT project team and identify any discrepancies that need resolution.

11.3. [Comments here.]

12. **Exhibits**

<table>
<thead>
<tr>
<th>Exhibit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High Level Review Email</td>
</tr>
<tr>
<td>2</td>
<td>Schedule Revision Details</td>
</tr>
<tr>
<td>3</td>
<td>Correspondence</td>
</tr>
<tr>
<td>4</td>
<td>Critical Path (Global Layout “02_Longest (Critical) Path”)</td>
</tr>
</tbody>
</table>
4 Group C Baseline
Review of Baseline Schedule [Enter Update #]
[Enter Contract #] - [Enter Project Name]

Prepared By [Enter name of Detailed Reviewer]
EIC [Enter name of EIC]
ACS / Other CC [Enter name of Area Construction Supervisor, CPM Scheduling Section, other recipients]
Recommendation [Accepted as Noted / Rejected with Comments]

1. Progress Schedule Details

<table>
<thead>
<tr>
<th>Update Number</th>
<th>[Enter Update #]</th>
<th>Data Date</th>
<th>[Enter P6 Data Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of Review</td>
<td>01-Jan-99</td>
<td>Date Uploaded by CPM Scheduling Section</td>
<td>01-Jan-99</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date Submitted by Contractor</td>
<td>01-Jan-99</td>
</tr>
</tbody>
</table>

P6 Project ID [Enter P6 Project ID]
P6 Project Name [Enter P6 Project Name]
Previous Update [Enter Previous Update Number that served as comparison for this Update]

2. Update Summary and Recommendation

Update Summary

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Complete after remainder of report is completed. Enter paragraph(s) to provide executive summary of this report. Describe summary of major issues remaining to come to an acceptable Baseline schedule that includes all contract work and meets the NYSDOT Item 639 CPM schedule specification requirements. If a portion of the report is useful to put up front in the Update Summary section, describe in this section with any tables / figures / etc.

2.1. [Comments here.]

Recommendation

We recommend that NYSDOT [Accept as Noted / Reject with Comments] this schedule update as noted in this report. Comments that the Contractor should address in the next submission are shown in red underlined text.

The Contractor shall address the NYSDOT CPM Scheduling Section Comments noted in Exhibit 1.

The Contractor should address the following comments that were discussed at the schedule meeting on 01-Jan-99.

2.2. [List Comments from Schedule Meeting that need to be addressed.]

3. Comment Resolution

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Address any comments made in the Contractor’s Narrative that need resolution. Address comments made in meetings, emails, etc. regarding the schedule. Reference any specific comment numbers so resolution can be easily tracked.

3.1. [Comments here.]
4. Additional Review Comments and Recommendations

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe any additional comments and/or recommendations in reviewing the current schedule submission for conformance to the NYSDOT Item 639 CPM schedule specification. Group and describe all additional errors / omissions / comments:

- Verification that all contract deliverables and milestones are included in the schedule.
- Verification of proper logic to dates of submittals, including appropriate review times.
- Verification of proper logic in sequencing of work and activity durations.
- Make sure any high risk items such as utility relocation, permits, ROW acquisitions are included in the baseline schedule and are included in Updates as they are identified.

4.1. [Comments here.]

5. Status of Major Milestones

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Major milestones include any intermediate contract milestones or Incentive/Disincentive Periods or Liquidated Damages. If none of the latter, possibly include the completion of major stages or phases.

IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- [Name of MS or I/D / LD Duration Period] ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- Substantial Completion ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].

- Anticipated Contract Completion ([Activity ID]) – [Current Update Date]
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the Contract date [Contract / Baseline Date].

Upcoming Major Milestones

Below are upcoming major milestones or the completion of I/D / LD Durations, including important dates.

<table>
<thead>
<tr>
<th>Date</th>
<th>[Activity ID]</th>
<th>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
</tbody>
</table>
6. **Critical (Longest) Path**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Describe elements of the Critical (Longest) Path, including but limited to:

- Is the Critical Path the same, compared to the Previous Update? Describe any changes to the Critical Path.
- Are there any gaps in the Critical Path? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the Critical Path.
- What are important upcoming dates to target to maintain the Critical Path’s timely completion, or the dates that must be hit to bring the project back on schedule?
- Do links among different locations / stages / phases make sense?
- Insert a screen shot of the Critical Path, adding comments to the image that highlight the more important Critical Path details.
  - If CP is very long, may not be beneficial / legible to show entire CP as a screen shot. Up to reviewer to use judgment to truncate CP based on a key milestone or near-term milestone such as end of a stage, completion of a bridge stage, setting of bridge beams, etc. (Full Critical Path PDF to be included as Appendix.)
  - When CP has changed, may be useful to show activities that were on previous CP in a separate figure and explain what changed.
- If Critical Path is described in the “Longest Paths to Key Milestones” section - for an individual bridge - make note in this section.

6.1. [Comments here.]

7. **Status of Individual Bridges / I/D / LD Periods**

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Use this section if the project has intermediate contract durations that are not sequential for one continuous Critical Path. If there are Incentive/Disincentive Periods or Liquidates Damages that are based on individual bridges, stages or phases completing within a specific duration, track the critical and potentially near-critical paths to completing each individual bridge / stage / phase / milestone. This will report on the most critical activities to achieving each instance. For Design-Build projects, reference Form SCD for I/D / LD durations.

Describe elements of the float paths for intermediate milestones, including but limited to:

- Are the float paths to completing each major contractual intermediate milestone the same, compared to the Previous Update? Describe any changes to the float paths.
- Are there any gaps in any of the intermediate float paths? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the each intermediate float path.
- What are important upcoming dates to target to maintain each intermediate milestone’s timely completion, or the dates that must be hit?
- Do links among different locations / stages / phases make sense?
- Insert screen shots of intermediate float paths, adding comments to highlight the more important details.

**IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.**

[Enter Name/Number of Bridge / Duration Period]

7.1. [Comments here.]

Longest Path to Completion of [Enter Name/Number of Bridge / Duration Period]

[Insert Image(s) of Longest Path for this Bridge / Duration Period]

[Enter Name/Number of Bridge / Duration Period]

7.2. [Comments here.]

Longest Path to Completion of [Enter Name/Number of Bridge / Duration Period]

[Insert Image(s) of Longest Path for this Bridge / Duration Period]

8. **Exhibits**

| Exhibit 1: High Level Review Email |
| Exhibit 2: Schedule Revision Details |
| Exhibit 3: Correspondence |
| Exhibit 4: Critical Path (Global Layout “02_Longest (Critical) Path”) |
5 Group C Update
Review of Schedule Update [Enter Update #]
[Enter Contract #] - [Enter Project Name]

Prepared By [Enter name of Detailed Reviewer]
EIC [Enter name of EIC]
ACS / Other CC [Enter name of Area Construction Supervisor, CPM Scheduling Section, other recipients]

Recommendation [Accepted as Noted / Rejected with Comments]

1. Progress Schedule Details

<table>
<thead>
<tr>
<th>Update Number</th>
<th>[Enter Update #]</th>
<th>Data Date</th>
<th>[Enter P6 Data Date]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Period</td>
<td>From 01-Jan-99</td>
<td>To 01-Jan-99</td>
<td></td>
</tr>
<tr>
<td>Date of Review</td>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Uploaded by CPM Scheduling Section</td>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Submitted by Contractor</td>
<td>01-Jan-99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P6 Project ID</td>
<td>[Enter P6 Project ID]</td>
<td>P6 Project Name</td>
<td>[Enter P6 Project Name]</td>
</tr>
<tr>
<td>Previous Update</td>
<td>[Enter Previous Update Number that served as comparison for this Update]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Update Summary and Recommendation

Update Summary

/** DELETE PRIOR TO SUBMITTING TO CONTRACTOR **/
Complete after remainder of report is completed. Enter paragraph(s) to provide executive summary of this report. Describe status of project schedule and cause of anticipated contract completion and/or intermediate contractual milestone improvement / slippage, including but not limited to:
- Schedule’s cause for the improvement / slippage
- Contractor’s cause for the improvement / slippage in the Narrative
- NYSDOT / Detailed Reviewer’s cause for the improvement / slippage not reflected in the schedule
- Any agreements on improvement / slippage between Contractor and NYSDOT as agreed at schedule meetings
- Any agreements on mitigation efforts for slipping work

If anticipated contract completion and intermediate contractual milestones remain unchanged and are on time, summarize the critical / near-critical progress completed in the update period to maintain the current schedule, as well as what critical / near-critical progress needs to be made over the next update period to maintain the current timely completion.
If a portion of the report is useful to put up front in the Update Summary section, describe in this section with any tables / figures / etc.

2.1. [Comments here.]

Recommendation

We recommend that NYSDOT [Accept as Noted / Reject with Comments] this schedule update as noted in this report.

Comments that the Contractor should address in the next submission are shown in red underlined text.
The Contractor shall address the NYSDOT CPM Scheduling Section Comments noted in Exhibit 1.
The Contractor should address the following comments that were discussed at the schedule meeting on 01-Jan-99.

2.2. [List Comments from Schedule Meeting that need to be addressed.]
3. Status of Major Milestones

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***

Major milestones include any intermediate contract milestones or Incentive/Disincentive Periods or Liquidated Damages. If none of the latter, possibly include the completion of major stages or phases.

**IF CONTRACT COMPLETION OR ANOTHER CONTRACT MILESTONE IS 10% OR MORE BEHIND SCHEDULE, THE ENGINEER MAY REQUIRE THE CONTRACTOR TO SUBMIT A RECOVERY SCHEDULE. REFERENCE ITEM 639 SPECIFICATION FOR DETAILS.**

- **[Name of MS or I/D / LD Duration Period] ([Activity ID])** – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- **[Name of MS or I/D / LD Duration Period] ([Activity ID])** – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- **Substantial Completion ([Activity ID])** – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the [Contract / Baseline] date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

- **Anticipated Contract Completion ([Activity ID])** – [Current Update Date]
  - [Improved / Slipped] by [Number of CCD] CCD in the update period; was [Previous Update Date].
  - [Number of CCD] CCD [Ahead / Behind] in comparison to the Contract date [Contract / Baseline Date].
  - Reason for [Improvement / Slippage]: [Type brief explanation or “see below”].

Upcoming Major Milestones

<table>
<thead>
<tr>
<th>Date</th>
<th>[Activity ID]</th>
<th>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
<tr>
<td>01-Jan-99</td>
<td>[Activity ID]</td>
<td>[Name of upcoming major milestone / duration and brief description of work/dates required to achieve this date.]</td>
</tr>
</tbody>
</table>
4. Issues / Delays

Address each issue / delay on the project that is or may potentially impact the schedule.

- Track each issue / delay by assigning numbers, if the Contractor has not already done so. If Contractor has not, encourage Contractor to assign numbers to allow for consistent tracking.
- Respond to each current issue / delay in the Contractor’s Narrative.
- Identify how each issue / delay is affecting or may affect the Critical Path or another contractual milestone. If it is not causing an impact, explain.
- Identify how the issue / delay impacts or may potentially impact the schedule, noting important dates to resolve issue / delay.
- Review with NYSDOT to determine if there are other issues / delays not included in the schedule and/or Contractor’s Narrative that should be included.
- Does schedule include all issues / delays discussed at progress meetings?
- Verify dates and issues / delays are accurate.
- Comment, addressing each current issue / delay.
- Even if issue / delay is not modeled in schedule, still identify activities that are affected and show / discuss float.
- Insert screen shots of Narrative / schedule where applicable.

4.1. [Comments here.]

5. Critical (Longest) Path

Address elements of the Critical (Longest) Path, including but limited to:

- Is the Critical Path the same, compared to the Previous Update? Describe any changes to the Critical Path.
- Are there any gaps in the Critical Path? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the Critical Path. Have these activities improved / slipped since the Previous Update?
- What are important upcoming dates to target to maintain the Critical Path’s timely completion, or the dates that must be hit to bring the project back on schedule?
- Are the scheduled durations accurate based on past performance?
- Do links among different locations / stages / phases make sense?
- If the schedule is behind, are there opportunities on the Critical Path to gain time?
- Insert a screen shot of the Critical Path, adding comments to the image that highlight the more important Critical Path details.
  - If CP is very long, may not be beneficial / legible to show entire CP as a screen shot. Up to reviewer to use judgment to truncate CP based on a key milestone or near-term milestone such as end of a stage, completion of a bridge stage, setting of bridge beams, etc. (Full Critical Path PDF to be included as Appendix.)
  - CP figure should show target bars to previous update and variance to previous so that reader can see movement.
  - When CP has changed, may be useful to show activities that were on previous CP in a separate figure and explain what changed.
- If Critical Path is described in the “Longest Paths to Key Milestones” section - for an individual bridge - make note in this section.

5.1. [Comments here.]
6. Summary of Anticipated Contract Completion Movement

(**DELETE PRIOR TO SUBMITTING TO CONTRACTOR**)

If contract completion or another contract milestone is 10% or more behind schedule, the engineer may require the contractor to submit a recovery schedule. Reference Item 639 Specification for Details.

The table below summarizes the movement of anticipated contract completion from the start of the project.

<table>
<thead>
<tr>
<th>Schedule Update</th>
<th>Data Date</th>
<th>Scheduled Contract Completion Date</th>
<th>Var. from Previous (CCD)*</th>
<th>Var. from Contract (CCD)*</th>
<th>Negative Float Resp. Party</th>
<th>Apparent Cause of Gain / Delay to Negative Float (Including Driving Critical Path Activity)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract</td>
<td>n/a</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Baseline</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Positive Variance indicates that the milestone is ahead of schedule or that the schedule has gained time.

7. Status of Individual Bridges / I/D / LD Periods

(**DELETE PRIOR TO SUBMITTING TO CONTRACTOR**)

Use this section if the project has intermediate contract durations that are not sequential for one continuous Critical Path. If there are Incentive/Disincentive Periods or Liquidates Damages that are based on individual bridges, stages or phases completing within a specific duration, track the critical and potentially near-critical paths to completing each individual bridge / stage / phase / milestone. This will report on the most critical activities to achieving each instance. For Design-Build projects, reference Form SCD for I/D / LD durations.

Describe elements of the float paths for intermediate milestones, including but limited to:

- Are the float paths to completing each major contractual intermediate milestone the same, compared to the Previous Update? Describe any changes to the float paths.
- Comment on any contract duration movement.
- Are there any gaps in any of the intermediate float paths? If so, explain why these are acceptable or not acceptable.
- Describe upcoming activities on the each intermediate float path. Have these activities improved / slipped since the Previous Update?
- What are important upcoming dates to target to maintain each intermediate milestone’s timely completion, or the dates that must be hit to bring the milestones back on schedule?
- Are the scheduled durations accurate based on past performance?
- Do links among different locations / stages / phases make sense?
- If the schedule is behind, are their opportunities on the intermediate float path to gain time?
- Insert screen shots of intermediate float paths, adding comments to highlight the more important details.

If contract completion or another contract milestone is 10% or more behind schedule, the engineer may require the contractor to submit a recovery schedule. Reference Item 639 Specification for Details.

[Enter Name/Number of Bridge / Duration Period]

7.1. [Comments here.]

Longest Path to Completion of [Enter Name/Number of Bridge / Duration Period]
[Insert Image(s) of Longest Path for this Bridge / Duration Period]
### [Enter Name/Number of Bridge / Duration Period] – Summary of Contract Duration Movement

<table>
<thead>
<tr>
<th>Schedule Update</th>
<th>Start Date</th>
<th>Finish Date</th>
<th>Dur. (CCD)</th>
<th>Var. from Previous (CCD)*</th>
<th>Var. from Contract (CCD)*</th>
<th>Negative Float Resp. Party</th>
<th>Apparent Cause of Gain / Delay to Negative Float (Including Driving Critical Path Activity)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract</td>
<td>01-Jan-99</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>NYSODOT</td>
<td></td>
</tr>
<tr>
<td>Baseline</td>
<td>01-Jan-99</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td></td>
<td></td>
<td>NYSODOT</td>
<td></td>
</tr>
<tr>
<td>Update #1</td>
<td>01-Jan-99</td>
<td>01-Jan-99</td>
<td>n/a</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update #5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Positive Variance indicates that the duration is ahead of schedule or that the schedule has gained time.

### 7.2. [Comments here.]

[Enter Name/Number of Bridge / Duration Period] – Summary of Contract Duration Movement

- Longest Path to Completion of [Enter Name/Number of Bridge / Duration Period]
- [Insert Image(s) of Longest Path for this Bridge / Duration Period]

*Positive Variance indicates that the duration is ahead of schedule or that the schedule has gained time.*
8. Schedule Revisions

(***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
If sections below are very long due to large tables, reference large tables in attached Exhibits and include here only most important content. Acknowledge if revisions were addressed in previous correspondence, meetings, or reviews, as well as if these changes were previously approved by the EIC.)

Activities Added

(***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all activities added to the schedule when compared to the Previous Update:
- Are these additions acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- Show screen shots of added activities and how these activities tie into the logic of the schedule.
- How do these changes impact the schedule?
- State if the added activities have affected the Critical Path or other contract milestones.)

8.1. [Comments here.]

Activities Deleted

(***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all activities deleted from the schedule when compared to the Previous Update:
- Are these deletions acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?
- State if the deleted activities have affected the Critical Path or other contract milestones.)

8.2. [Comments here.]

Logic Changes

(***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all logic changes in the schedule when compared to the Previous Update:
- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?)

8.3. [Comments here.]

Original Duration Changes

(***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Original Duration changes in the schedule when compared to the Previous Update. Present Original Duration changes in Table format:
- Are these changes acceptable?
- Were they previous discussed / approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?)

8.4. [Comments here.]
Activity Name Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Activity Name changes in the schedule when compared to the Previous Update.

- Are these changes acceptable?
- Only very small changes are acceptable; the scope of an activity must remain consistent from Baseline through As-Built.
- Were they previous discussed/approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

8.5. [Comments here.]

Calendar Changes

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Using Claim Digger and other means to identify and describe all Calendar changes in the schedule, and also Calendar assignment changes, when compared to the Previous Update.

- Are these changes acceptable?
- Were they previous discussed/approved by the EIC?
- Did the Contractor detail all changes in the Narrative, including the reason(s) for and impact(s) of such changes?
- How do these changes impact the schedule?

[Comments here.]

9. Comment Resolution

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Address any comments made in the Contractor’s Narrative that need resolution. Address comments made in meetings, emails, etc. regarding the schedule. Reference any specific comment numbers so resolution can be easily tracked.

9.1. [Comments here.]

10. Additional Review Comments and Recommendations

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Describe any additional comments and/or recommendations in reviewing the current schedule submission for conformance to the NYSDOT Item 639 CPM schedule specification. Group and describe all additional errors/omissions/comments.

- Verification that all contract deliverables and milestones are included in the schedule.
- Verification of proper logic to dates of submittals, including appropriate review times.
- Verification of proper logic in sequencing of work and activity durations.
- Make sure any high risk items such as utility relocation, permits, ROW acquisitions are included in the baseline schedule and are included in Updates as they are identified.

10.1. [Comments here.]
## 11. Activity Status

### Percent Complete

<table>
<thead>
<tr>
<th>%</th>
<th>Task Dependent Activities are</th>
<th>of</th>
<th>as of the current Data Date.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>COMPLETED</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>IN PROGRESS</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>REMAINING</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### Chart Description

Below is a chart showing current cumulative project percent complete in comparison with the Baseline Early Finish and Late Finish dates. This chart tracks number of task dependent activities completed. Generally, the actual cumulative percent complete should trend somewhere between the Baseline Early and Baseline Late curves. The “finish” dates reported in P6 schedules represent the Baseline Early Finish curve, or the earliest activities can complete based on current activity durations and logic. The latest all activities can finish and the project still complete on time is the Baseline Late Finish curve, based on current activity durations and logic.

### How to Read It

On-time project completions mostly trend between the Baseline Early and Baseline Late curves. If Actual curve is to right of Late curve, there should be negative float in the schedule based on the original plan; if no negative float, Contractor has condensed schedule and plans to have more resources than originally planned in order to complete on time.

---

**Describe any comments regarding the figure above:**

- Is Actual curve trending somewhere between Early and Late curves, and work is progressing as planned?
- Is Actual curve trending towards Late curve? Are planned activities getting pushed off each month? Is Contractor not completing work (activities) as planned? If trending towards / beyond Late curve and not producing as planned, is there a plan for how Contractor is going to change to bring project back on schedule (more resources)? If Actual is to right of Late curve, there should be negative float in the schedule based on the original plan; if no negative float, Contractor has condensed schedule and plans to have more resources than originally planned in order to complete on time.
- Is Actual curve trending towards Early curve? Is work (activities) being complete on or ahead of schedule?
- Is there a major discrepancy in project % paid to date versus current % of activities complete?
If there is a Time Extension on a contract milestone/duration, the "Baseline" curves should be revised to the schedule submission at the time of the Time Extension, showing the revised plan for completing contract milestones by the revised dates.

11.1. [Comments here.]

**Float Density**

**Chart Description**
Float Density represents what percentage of remaining activities have a comfortable amount of float versus very little float. The below chart and table track Float Density over the last six updates, based on number of remaining task activities (non-milestone, non-level of effort). Use this analysis in conjunction with any movement of intermediate and / or overall milestones / durations.

**How to Read It**
The higher percentage / more activities in the lower categories indicate a higher percentage / more activities becoming near-critical / critical. More green = more activities with float. A trend towards more yellow / orange / red = a higher percentage of critical / near-critical activities and higher risk of late contract completion.

***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***
Describe any comments regarding the figure above:
- Is the percentage of activities within each category staying relatively consistent? If so, work is generally being completed as planned.
- Is the percentage of activities in the yellow / orange / red categories increasing? This indicates work is not being completed as planned. The higher percentage of critical / near-critical work (activities), the more likely these dates cannot be achieved and project completion can slip later.
- Has the percentage of activities in the yellow / orange / red categories steadily increased, yet the planned contract completion has remained the same? If so, work is stacking up and logic is being revised to keep the project on schedule, even though work has been slipping and becoming more critical.

11.2. [Comments here.]
Actual Date Discrepancies

(***DELETE PRIOR TO SUBMITTING TO CONTRACTOR***)
Confirm Actual Start / Actual Finish dates in the current schedule update with the NYSDOT project team and identify any discrepancies that need resolution.

11.3. [Comments here.]

12. Exhibits

| Exhibit 1: High Level Review Email |
| Exhibit 2: Schedule Revision Details |
| Exhibit 3: Correspondence |
| Exhibit 4: Critical Path (Global Layout “02_Longest (Critical) Path”) |
Appendix D - Example Narrative and Attachments
Appendix E - Sample Schedule Plots
Appendix F - Frequently Asked Questions & Answers
Appendix G – Construction Support Unit

Contacts
This section describes work assignments for individuals in the Construction Support Section who perform P6 related tasks. When communicating with the section on P6 related issues it is best to send an email to CPMSchedulingSection@dot.ny.gov.

This Unit has additional responsibilities related to Design-Build Oversight and Construction Document Management and assistance with Resource Reporting.

<table>
<thead>
<tr>
<th>Name</th>
<th>Role Description</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lowell Lingo, PE</td>
<td>Unit Supervisor with overall responsibility for the P6 CPM system management and oversight for Construction Phase.</td>
<td>(518) 457-0211</td>
<td><a href="mailto:Lowell.Lingo@dot.ny.gov">Lowell.Lingo@dot.ny.gov</a></td>
</tr>
<tr>
<td>Frank Arcuri</td>
<td>Performs detailed reviews upon request, QA of CPM Schedule Reviews by Detailed Schedulers and audits Design-Build Contract progress through the use of their schedules. He also serves as a backup for high level reviews and uploads.</td>
<td>(518) 457-2550</td>
<td><a href="mailto:Frank.Arcuri@dot.ny.gov">Frank.Arcuri@dot.ny.gov</a></td>
</tr>
<tr>
<td>Albert E. Karoly, PE</td>
<td>Performs project setup and overall security management for the P6 CPM system and coordinates the Help Desk functions for the Section.</td>
<td>(518) 457-3226</td>
<td><a href="mailto:Albert.Karoly@dot.ny.gov">Albert.Karoly@dot.ny.gov</a></td>
</tr>
<tr>
<td>Matt Anderson</td>
<td>Performs high level reviews and uploads of Contractor submitted CPM Schedules, takes the lead on systems testing and performs audits of schedule submissions.</td>
<td>(518) 457-6417</td>
<td><a href="mailto:Matt.Anderson@dot.ny.gov">Matt.Anderson@dot.ny.gov</a></td>
</tr>
</tbody>
</table>
Appendix H – Schedule Load “Cheat Sheet”
Schedule Load Cheat Sheet

1. Flag email and assign Category
2. Search email Inbox for D# to check for most current correspondence
3. Move attachments to new folder in P-Drive
   • Schedule Log, Narrative, Gantt Chart
4. Reply to All on email
   • To: EIC, Schedule Reviewer
   • CC: ACS, CPM Scheduling Section, Contractor
   • Copy/Paste template response into Email
   • Open last review on this project and check recipients / review previous comments
5. CPS: change Report Indicator to Null
6. CPS: Cut/Paste into PSU
7. CWA: find update file and open
8. Change User Preferences Time to 12 hour
9. CWA: change Loaded Date to nearest hour
10. CWA: verify file has update # in Project Name
11. CWA: confirm with Oracle BI on:
    • EIC, ACS, Schedule Reviewer, Contractor’s Project Scheduler, Letting Date, Award Date, Original Contract
    • Completion Date, Must Finish By Date
12. CWA: Check Settings tab & Summarize Project
13. CWA to CPS: Copy/Paste project into CPS
14. CPS: Open Project and change:
    • Review Status = Submitted for Review
    • Project Status = Inactive
    • Schedule Owner = State Archive
    • Report Indicator = Green (project with accepted BL) or Yellow (no accepted BL yet)
    • Responsible Manager = NYSDOT Archive (Read Only)
15. Make copy of previous update from PSU to CPS node, name “D#-_SU_-_LAST_UPDATE_BASELINE”
16. Maintain / Assign Last Update Baseline into Current Submission as Project Baseline
17. Activities: Open Schedule Load layout
18. Activities: F9 & check Schedule Options
19. Activities: Schedule Project and save Schedule Log into project update folder
20. Compare Schedule Log with Contractor’s Schedule Log
21. Calendars: Check D#, no improper Global used, time periods are correct, non-work correct
22. Global Filters: run through list of 20+ filters
23. Change User Preference to not show time
24. Open each Schedule Report Layout, .pdf, review, add comments to email
   • Type 1: Only layouts 01, 02, 08, 16 & 19
25. Combine all Schedule Report files into one .pdf and Save in project update folder
27. Schedule Report: Close, Save, Open file and check that each Bookmark has correct Layout # and correct Project
28. Drag/drop Schedule Report into Email
29. Send email
30. Remove attachments in Inbox, drag/drop email to project update folder
31. Clear email Category and check Flag as complete
Appendix I - Production Rate Guidance to Assist Designers

1  Table A – Roadway Items (English)

2  Table A.1 – Roadway Items (Metric)

3  Table B – Bridge Items (English)

4  Table B.1 – Bridge Items (Metric)

5  Table C – Bridge Items One Span (English)

6  Table C.1 – Bridge Items One Span (Metric)

7  Table D – Bridge Items Two Span (English)

8  Table D.1 – Bridge Items Two Span (Metric)